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About the Tutorial

Course on Computer Concepts is a basic tutorial on computer literacy. This tutorial enables
the learner to use computer for basic things like sending and receiving emails, browsing
internet, preparing databases, making presentations, etc. This course also helps to prepare
candidates for NIELIT CCC examination.

Audience

This tutorial is designed on Course on Computer Concepts (CCC) which covers the entire
updated syllabus prescribed by NIELIT. It comprises eight chapters on the fundamental
concepts of computer. Each chapter provides clear idea of computer concepts in detail with
the help of real time applications and screenshots. The language used in the entire tutorial
is quite simple and easy to understand. The tutorial starts with basic concepts of computer
and then explains about Microsoft Word, Excel and PowerPoint of MS office 2013 version.
In the fifth and sixth chapters, it covers knowledge about Internet usage in our day-to-
day life. The application of digital financial services is discussed in the last chapter which
describes the usage of internet facility in financial sectors. So anyone who wants to get
basic to intermediate level knowledge on the above topics are the targeted audience for
this tutorial.

Prerequisites

To be able to follow this tutorial, you do not need any prior knowledge on computers. It is
a basic course which starts from the fundamentals. One having basic knowledge and
understanding of English language can easily complete this tutorial.

Copyright & Disclaimer
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All the content and graphics published in this e-book are the property of Tutorials Point (I)
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of the publisher.
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possible, however, the contents may contain inaccuracies or errors. Tutorials Point (I) Pvt.
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1. Computer Concepts — Introduction to

Computer

In today's world, we use computers for all our tasks. Our day-to-day activities: paying
bills, buying groceries, using social media, seeking entertainment, working from home,
communicating with a friend, etc., can all be done using a computer. So it is important
not only to know how to use a computer, but also to understand the components of a
computer and what they do.

This topic explains all concepts related to computer in detail, from origin to end. The idea
of computer literacy is also discussed, which includes the definition and functions of a
computer. You learn about the components of a computer, the concept of hardware and
software, representation of data/information, the concept of data processing and
applications of IECT.

What is a Computer?

A computer is an electronic device that accepts data from the user, processes it, produces
results, displays them to the users, and stores the results for future usage.

Data is a collection of unorganized facts & figures and does not provide any further
information regarding patterns, context, etc. Hence data means "unstructured facts and
figures".

Information is a structured data i.e. organized meaningful and processed data. To
process the data and convert into information, a computer is used.

Functions of Computers

A computer performs the following functions:

Receiving Input
Data is fed into computer through various input devices like keyboard, mouse, digital pens,
etc. Input can also be fed through devices like CD-ROM, pen drive, scanner, etc.

Processing the information
Operations on the input data are carried out based on the instructions provided in the
programs.

Storing the information
After processing, the information gets stored in the primary or secondary storage area.

Producing output
The processed information and other details are communicated to the outside world
through output devices like monitor, printer, etc.

History of Computers

The history of the computer dates back to several years. There are five prominent
generations of computers. Each generation has witnessed several technological advances

1
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which change the functionality of the computers. This results in more compact, powerful,
robust systems which are less expensive. The brief history of computers is discussed
below:

First Generation (1940-1956)

The first generation computers had the following features and components:

Hardware
The hardware used in the first generation of computers was: Vacuum Tubes and Punch
Cards.

Features
Following are the features of first generation computers:

e It supported machine language.

e It had slow performance

e It occupied large size due to the use of vacuum tubes.
¢ It had a poor storage capacity.

e It consumed a lot of electricity and generated a lot of heat.

Memory
The memory was of 4000 bits.

Data Input
The input was only provided through hard-wired programs in the computer, mostly
through punched cards and paper tapes.

Examples
The examples of first generation computers are:
e ENIAC

e UNIVACTBM 701

Second Generation (1956-1963)

Several advancements in the first-gen computers led to the development of second
generation computers. Following are various changes in features and components of
second generation computers:

Hardware
The hardware used in the second generation of computers were:

e Transistors

e Magnetic Tapes

Features
It had features like:

e Batch operating system

e Faster and smaller in size
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e Reliable and energy efficient than the previous generation

e Less costly than the previous generation

Memory
The capacity of the memory was 32,000 bits.

Data Input
The input was provided through punched cards.

Examples
The examples of second generation computers are:

e Honeywell 400
e CDC 1604
e IBM 7030

Third Generation (1964-1971)

Following are the various components and features of the third generation computers:

Hardware
The hardware used in the third generation of computers were:

e Integrated Circuits made from semi-conductor materials

e Large capacity disks and magnetic tapes

Features
The features of the third generation computers are:

e Supports time-sharing 0OS
e Faster, smaller, more reliable and cheaper than the previous generations

e FEasy to access

Memory
The capacity of the memory was 128,000 bits.

Data Input
The input was provided through keyboards and monitors.

Examples
The examples of third generation computers are:
e IBM 360/370

e CDC 6600
e PDP 8/11

Fourth Generation (1972-2010)

Fourth generation computers have the following components and features:
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Hardware
The Hardware used in the fourth generation of computers were:

e ICs with Very Large Scale Integration (VLSI) technology
e Semiconductor memory

e Magnetic tapes and Floppy

Features
It supports features like:

e Multiprocessing & distributed OS

e Object-oriented high level programs supported

e Small & easy to use; hand-held computers have evolved

¢ No external cooling required & affordable

e This generation saw the development of networks and the internet

e It saw the development of new trends in GUIs and mouse

Memory
The capacity of the memory was 100 million bits.

Data Input
The input was provided through improved hand held devices, keyboard and mouse.

Examples

The examples of fourth generation computers are:
e Applell
e VAX 9000
e CRAY 1 (super computers)

Fifth Generation (2010-Present)

These are the modern and advanced computers. Significant changes in the components
and operations have made fifth generation computers handy and more reliable than the
previous generations.

Hardware
The Hardware used in the fifth generation of computers are:

o Integrated Circuits with VLSI and Nano technology
e Large capacity hard disk with RAID support

e Powerful servers, Internet, Cluster computing

Features
It supports features like:

e Powerful, cheap, reliable and easy to use.

&
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e Portable and faster due to use of parallel processors and Super Large Scale

Integrated Circuits.

e Rapid software development is possible.

Memory

The capacity of the memory is unlimited.

Data Input

The input is provided through CDROM, Optical Disk and other touch and voice sensitive

input devices.

Examples

The examples of fifth generation computers are:

e IBM
e Pentium
¢ PARAM

Characteristics of Computer System

The characteristics of the computer system are as follows:

Memory

Automation

Reliability

Speed

-

/" Characteristics \\-.

1
i

L1
b

of

Computer

o

Versatility

[}

Speed

Accuracy

Deligence

A computer works with much higher speed and accuracy compared to humans while
performing mathematical calculations. Computers can process millions (1,000,000) of
instructions per second. The time taken by computers for their operations is microseconds

and nanoseconds.

Accuracy

Computers perform calculations with 100% accuracy. Errors may occur due to data

inconsistency or inaccuracy.

Diligence
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A computer can perform millions of tasks or calculations with the same consistency and
accuracy. It doesn’t feel any fatigue or lack of concentration. Its memory also makes it
superior to that of human beings.

Versatility

Versatility refers to the capability of a computer to perform different kinds of works with
same accuracy and efficiency.

Reliability

A computer is reliable as it gives consistent result for similar set of data i.e., if we give
same set of input any number of times, we will get the same result.

Automation

Computer performs all the tasks automatically i.e. it performs tasks without manual
intervention.

Memory

A computer has built-in memory called primary memory where it stores data.
Secondary storage are removable devices such as CDs, pen drives, etc., which are also
used to store data.

Basic Applications of Computer

Computers play a role in every field of life. They are used in homes, business, educational
institutions, research organizations, medical field, government offices, entertainment, etc.

Home

Computers are used at homes for several purposes like online bill payment, watching
movies or shows at home, home tutoring, social media access, playing games, internet
access, etc. They provide communication through electronic mail. They help to avail work
from home facility for corporate employees. Computers help the student community to
avail online educational support.

Medical Field

Computers are used in hospitals to maintain a database of patients’ history, diagnosis, X-
rays, live monitoring of patients, etc. Surgeons nowadays use robotic surgical devices to
perform delicate operations, and conduct surgeries remotely. Virtual reality technologies
are also used for training purposes. It also helps to monitor the fetus inside the mother’s
womb.

Entertainment

Computers help to watch movies online, play games online; act as a virtual entertainer in
playing games, listening to music, etc. MIDI instruments greatly help people in the
entertainment industry in recording music with artificial instruments. Videos can be fed
from computers to full screen televisions. Photo editors are available with fabulous
features.
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Industry

Computers are used to perform several tasks in industries like managing inventory,
designing purpose, creating virtual sample products, interior designing, video
conferencing, etc. Online marketing has seen a great revolution in its ability to sell various
products to inaccessible corners like interior or rural areas. Stock markets have seen
phenomenal participation from different levels of people through the use of computers.

Education

Computers are used in education sector through online classes, online examinations,
referring e-books, online tutoring, etc. They help in increased use of audio-visual aids in
the education field.

Government

In government sectors, computers are used in data processing, maintaining a database of
citizens and supporting a paperless environment. The country’s defense organizations
have greatly benefitted from computers in their use for missile development, satellites,
rocket launches, etc.

Banking

In the banking sector, computers are used to store details of customers and conduct
transactions, such as withdrawal and deposit of money through ATMs. Banks have reduced
manual errors and expenses to a great extent through extensive use of computers.

Business

Nowadays, computers are totally integrated into business. The main objective of business
is transaction processing, which involves transactions with suppliers, employees or
customers. Computers can make these transactions easy and accurate. People can analyze
investments, sales, expenses, markets and other aspects of business using computers.

Training

Many organizations use computer-based training to train their employees, to save money
and improve performance. Video conferencing through computers allows saving of time
and travelling costs by being able to connect people in various locations.

Arts

Computers are extensively used in dance, photography, arts and culture. The fluid
movement of dance can be shown live via animation. Photos can be digitized using
computers.

Science and Engineering

Computers with high performance are used to stimulate dynamic process in Science and
Engineering. Supercomputers have numerous applications in area of Research and
Development (R&D). Topographic images can be created through computers. Scientists
use computers to plot and analyze data to have a better understanding of earthquakes.
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Components of Computer System

Computer systems consist of three components as shown in below image: Central
Processing Unit, Input devices and Output devices. Input devices provide data input
to processor, which processes data and generates useful information that’s displayed to
the user through output devices. This is stored in computer’s memory.

mininlininininln

Central Data.
Processing

Unit

Data

I/P Devices O/P Devices

Ooooogoon
Uooooodyg

gopoooooo

Data

Main / Internal Memory
DR R e e e e e

Central Processing Unit

The Central Processing Unit (CPU) is called “the brain of computer” as it controls operation
of all parts of computer. It consists of two components: Arithmetic Logic Unit (ALU), and
Control Unit.

CPU
ALU
X .
Control Unit

T ¥

Main Memory

Arithmetic Logic Unit (ALU)

Data entered into computer is sent to RAM, from where it is then sent to ALU, where rest
of data processing takes place. All types of processing, such as comparisons, decision-
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making and processing of non-numeric information takes place here and once again data
is moved to RAM.

Control Unit
As name indicates, this part of CPU extracts instructions, performs execution, maintains
and directs operations of entire system.

Functions of Control Unit
Control unit performs following functions:

e It controls all activities of computer

e Supervises flow of data within CPU

e Directs flow of data within CPU

e Transfers data to Arithmetic and Logic Unit
e Transfers results to memory

e Fetches results from memory to output devices

Memory Unit

This is unit in which data and instructions given to computer as well as results given by
computer are stored. Unit of memory is “Byte”.

1 Byte = 8 Bits

Input Devices — Keyboard and Mouse

Input devices help to get input or data from user. Some of input devices are:

Name Characteristics Image

The keyboard was  first
Kevboard peripheral device to be used | T
eyboar with computers. T T e

we Q W OE R T ¥ U' _O.

It helps to input text and | |
numbers into computer. — R L B E

R S

It consists of 104 keys and 12
functional keys.

A mouse is an input device
which is also called as pointing
device because it helps to point
Mouse data on screen.

It also helps to select, highlight
content and drag-drop controls.
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Other Input Devices

There are few other input devices which help to feed data to the computer. They are as follows:

Input Devices Characteristics Image

A trackball is also a pointing
device which will work like a

Trackballs mouse. It is mainly used for
gaming and entertainment
purpose.

A digital pen is another input
device which is mostly used with
Digital Pens tablets, PDAs, etc.

A digital pen is also called as a
Stylus which helps to write or
draw data over pad.

Scanners transform  printed
material and photographs into a
Scanners digital representation.

After scanning of printed
material, page is represented in
memory as an array of pixels.

Barcode reader helps to read
Barcode readers information which is printed as
bars in back of goods or items.

Barcode readers are most widely
used input devices which we can

see in most of products in our A
day to day life. @

10

w tutorialspoint



Computer Concepts

Voice Recognition
System

Voice recognition system
interprets or receives dictation
or spoken commands to
authorize user.

| RECOGNITION

B S ST

Touch screen

A touch screen is an input device
which uses sensors to sense
touch of users to get input data.

Output Devices

Output devices help to display output to user. Some of output devices are:

Output Devices

Characteristics

Image

Monitor

A monitor is most common type of
output device.

It is also called as “Visual Display Unit”.

The inputs given by keyboard or any
other input devices will get displayed
on monitor.

Cathode Ray Tube (CRT) and Flat panel
display monitors are commonly used
monitors.

Printers

Printers are most common type of
output devices which are used to take
a hard copy of any digital document.

The two types of printers are impact
and non-impact printers.

Non-impact printers such as laser and
inkjet printers are less noisy, more
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reliable and faster and also offer high
quality compared to impact printers.

Sound Systems

Sound systems are output devices
which are used to get multimedia
content such as voice, music, etc., as
output. Some of examples of sound
systems are speakers, headphones,
and microphones.

Computer Memory

Computer memory refers to storage area where data is stored. It is of two types:

e Primary Memory

e Secondary Memory

Primary Memory

Primary memory is the main memory of computer present in motherboard. Primary
memory is of two types as shown in the image below.

Random Access Memory

RAM is referred as temporary memory, in which, information stored is lost once computer
is turned off. It is a volatile memory. Instructions written in this memory can be modified;
hence it is also known as programmable memory. The two types of RAM are Static RAM
(faster and costlier) and Dynamic RAM.

12
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Functions of RAM are as follows:

e It stores data till it gets processed.

e It stores instructions for data processing.

o It acts as a working space where data processing takes place and intermediate
results are stored.

e It stores processed data/results before it is sent to output devices.

Read Only Memory

ROM is referred as permanent memory, in which information stored is available even if
computer is turned off. Instructions stored in this memory can only be read and cannot be
modified. Mostly ROM has a start-up instruction which is executed every time when
computer is switched on. Types of ROM are PROM (Programmable Read Only Memory),
EPROM (Erasable PROM), EEPROM (Electrically Erasable PROM) and flash memory.

The below table jots down the major differences between RAM and ROM:

S. No RAM ROM

1 It is volatile memory. It is non-volatile memory.

2 The contents are temporary; data is | The contents are permanent; data is not
lost when electricity supply is lost. lost even when power is switched off.

3 Available in small storage capacity. | Available in high storage capacity.

4 Processing speed is high. Processing speed is low.

13
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5 User-defined programs can be | Generally, operating system supporting
stored. programs can be stored.
6 Cost is very high. Cost effective.
7 It is of two types, SRAM and DRAM. | It comes in different types such as
PROM, EPROM, EEPROM and flash
memory.

Secondary Memory

Sometimes when data to be processed is large, it cannot fit in primary memory as it is
limited, in such cases, we use supplement memory or secondary memory. Secondary
memory helps to store information permanently and is non-volatile. Examples of
secondary storage memory are compact disk, floppy disk, pen drive, external hard drive,
etc.

Concept of Hardware and Software

The concept of hardware and software is explained in detail below:

Hardware

The term hardware refers to mechanical device that makes up computer. Computer
hardware consists of interconnected electronic devices that we can use to control
computer’s operation, input and output. Examples of hardware are CPU, keyboard, mouse,
hard disk, etc.

NI D)

-
-
_—
—
_—
_—
—
—

—
-
-
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Motherbooard

Hardware Components

Computer hardware is a collection of several components working together. Some parts
are essential and others are added advantages. Computer hardware is made up of CPU
and peripherals as shown in image below.
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Keyboard Manitor
Mouse CRU Printer
—Iﬂj R;M nln'mw
Other I/P devices Speaker
| HOD CD
’ther IfF devices Memary | Other O/F devices
BIOS
Software

A set of instructions that drives computer to do stipulated tasks is called a program.
Software instructions are programmed in a computer language, translated into machine
language, and executed by computer. Software can be categorized into two types:

e System software

e Application software

System Software

System software operates directly on hardware devices of computer. It provides a platform
to run an application. It provides and supports user functionality. Examples of system
software include operating systems such as Windows, Linux, Unix, etc.

Application Software

An application software is designed for benefit of users to perform one or more tasks.
Examples of application software include Microsoft Word, Excel, PowerPoint, Oracle, etc.

15
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) Office
13 (3 [8 [

Excel OneNote

Qutlook

Word PowerPoint

Differences between Software and Hardware are sorted out below:

S. No Software Hardware

1 It is a collection of programs to bring | It includes physical components of
computer hardware system into | computer system.
operation.

2 It includes numbers, alphabets, | It consists of electronic components like
alphanumeric symbols, identifiers, | ICs, diodes, registers, crystals, boards,
keywords, etc. insulators, etc.

3 Software products evolve by adding | Hardware design is based on
new features to existing programs to | architectural decisions to make it work
support hardware. over a range of environmental conditions

and time.

4 It will vary as per computer and its | It is mostly constructed for all types of
built-in functions and programming | computer systems.
language.

5 It is designed and developed by | The hardware can understand only low-
experienced programmers in high- | level language or machine language.
level language.

6 It is represented in any high-level | The hardware works only on binary codes
language such as BASIC, COBOL, C, | 1's and O’s.

C++, JAVA, etc.

Memory
10001010} (Location 0)
00110100] (Location 1)
Data to Memory 01110111} (Location 2)
*110100100) (Lacarion 3)
C P U Data from Memory | 11010010] (Location 4)
10000110 {Location 5)
01001111} (Location 6)
Program 10100000] (Location 7)
counter 00000010] iLocation B)
Address for 10100010] (Location 9)
read";gftwriliﬂ@ 00010100] (Location 10)

ata

%)
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7 The software is categorized as | The hardware consists of input devices,
operating system, utilities, language | output devices, memory, etc.
processor, application software, etc.

Programming Languages

A program is a set of instructions that help computer to perform tasks. This set of
instructions is also called as scripts. Programs are executed by processor whereas scripts
are interpreted. The languages that are used to write a program or set of instructions are
called "Programming languages”. Programming languages are broadly categorized into
three types:

e Machine level language
e Assembly level language
¢ High-level language

Machine Level Language

Machine language is lowest level of programming language. It handles binary data i.e. 0’s
and 1’s. It directly interacts with system. Machine language is difficult for human beings
to understand as it comprises combination of 0’s and 1's. There is software which translate
programs into machine level language. Examples include operating systems like Linux,
UNIX, Windows, etc. In this language, there is no need of compilers and interpreters for
conversion and hence the time consumption is less. However, it is not portable and non-
readable to humans.

0001111100001010101
0011100111001101010
0101010101010000000
1010101010101010101
1010100000111110000
1010101000111000101
1010101010010100100

Assembly Level Language

Assembly language is a middle-level language. It consists of a set of instructions in a
specific format called commands. It uses symbols to represent field of instructions. It is
very close to machine level language. The computer should have assembler to translate
assembly level program to machine level program. Examples include ADA, PASCAL, etc.
It is in human-readable format and takes lesser time to write a program and debug it.
However, it is a machine dependent language.

17
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Assembly Language Machine Code

SUB AX, BX 001010111000011
MOV Cx, AX 100010111001000
MOV DX, 0 10111010000000000000000

High-level Language

High-level language uses format or language that is most familiar to users. The
instructions in this language are called codes or scripts. The computer needs a compiler
and interpreter to convert high-level language program to machine level language.
Examples include C++, Python, Java, etc. It is easy to write a program using high level
language and is less time-consuming. Debugging is also easy and is a human-readable
language. Main disadvantages of this are that it takes lot of time for execution and occupies
more space when compared to Assembly- or Machine-level languages. Following is a
simple example for a high level language:

if age<18
{

printf(“You are not eligible to vote”);

else

{

printf(“You are eligible to vote”);

}

Representation of Data/iInformation

Computer does not understand human language. Any data, viz., letters, symbols, pictures,
audio, videos, etc., fed to computer should be converted to machine language first.
Computers represent data in the following three forms:

Number System

We are introduced to concept of numbers from a very early age. To a computer, everything
is a number, i.e., alphabets, pictures, sounds, etc., are numbers. Number system is
categorized into four types:

e Binary number system consists of only two values, either 0 or 1.
e Octal number system represents values in 8 digits.
e Decimal number system represents values in 10 digits.

¢ Hexadecimal humber system represents values in 16 digits.

Number System

System Base | Digits

18
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Binary 2 01

Octal 8 01234567

Decimal 10 0123456789
Hexadecimal 16 0123456789ABCDEF

Bits and Bytes

Bits - A bit is a smallest possible unit of data that a computer can recognize or use.
Computer usually uses bits in groups.

Bytes - group of eight bits is called a byte. Half a byte is called a nibble.

|—1 bit
0{1]0J1]0|1]1]0
% ~ J
1 byte = 8 bits
The following table shows conversion of Bits and Bytes:
Byte Value Bit Value
1 Byte 8 Bits
1024 Bytes 1 Kilobyte
1024 Kilobytes 1 Megabyte
1024 Megabytes 1 Gigabyte
1024 Gigabytes 1 Terabyte
1024 Terabytes 1 Petabyte
1024 Petabytes 1 Exabyte
1024 Exabytes 1 Zettabyte
1024 Zettabytes 1 Yottabyte
1024 Yottabytes 1 Brontobyte
1024 Brontobytes 1 Geopbytes

Text Code

Text code is format used commonly to represent alphabets, punctuation marks and other
symbols. Four most popular text code systems are:

e EBCDIC

19
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e ASCII

e Extended ASCII

e Unicode
EBCDIC

Extended Binary Coded Decimal Interchange Code is an 8-bit code that defines 256
symbols. Given below is the EBCDIC Tabular column

Special EBCDIC |Alphabetic |EBCDIC
characters A 11000001
< 01001011 B 11000010
( 01001100 C 11000011
+ 01001101 D 11000100
/ 01001110 E 11000101
& 01010000 F 11000110
: 01111011 G 11000111
# 01111011 H 11001000
@ 01111100 I 11001001
s 01111101 J 11010001
= 01111110 K 11010010
" 01111111 L 11010011
; 01101011 M 11010100
% 01101100 N 11010101
- 01101101 0 11010110
> 01101110 P 11010111
' 1

ASCII
American Standard Code for Information Interchange is an 8-bit code that specifies
character values from 0 to 127.
ASCII Tabular column
ASCII Code Decimal Character
Value
0000 0000 0 Null prompt
0000 0001 1 Start of heading
0000 0010 2 Start of text
0000 0011 3 End of text
0000 0100 4 End of transmit
0000 0101 5 Enquiry
0000 0110 6 Acknowledge
0000 0111 7 Audible bell
0000 1000 8 Backspace
0000 1001 9 Horizontal tab
0000 1010 10 Line Feed
20
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Extended ASCII

Extended American Standard Code for Information Interchange is an 8-bit code that
specifies character values from 128 to 255.

Extended ASCII Tabular column

Char (Code | |Char (Code | |Char |(Code | |Char

161 . e 163 [[ o
el i 7
177 e
185 e | 0

7
. e A | 194 A | 195 A

f

<

wag | | L0 =

Unicode

Unicode Worldwide Character Standard uses 4 to 32 bits to represent letters, numbers and
symbol.

Unicode Tabular Column

Char UTF-16 UTF-8

A 0041 41

C 0063 63

& OOF6 C3 86

[:] AESG F4 BA 8C

¢ D834 DD1E FOSD 84 SE
Data processing

Data processing is a process of converting raw facts or data into a meaningful information.

Data |::> Process |:>

Stages of Data Processing

Data processing consists of following 6 stages:
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Collection

Collection of data refers to gathering of data. The data gathered should be defined and
accurate.

Preparation

Preparation is a process of constructing a dataset of data from different sources for future
use in processing step of cycle.

Input

Input refers to supply of data for processing. It can be fed into computer through any of
input devices like keyboard, scanner, mouse, etc.

Processing

The process refers to concept of an actual execution of instructions. In this stage, raw
facts or data is converted to meaningful information.

Output and Interpretation

In this process, output will be displayed to user in form of text, audio, video, etc.
Interpretation of output provides meaningful information to user.

Storage

In this process, we can store data, instruction and information in permanent memory for
future reference.

Applications of IECT

IECT stands for Information Electronics and Communication Technology. The applications
of IECT are as follows:

e E-governance

22
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e Multimedia and Entertainment

E-governance

Electronic governance is application of Information Electronics and Communication
Technology in running an effective governance system for people. Communication refers
to sharing of information between parties like common people, government, business, etc.
Almost every government sector has changed to IECT like rail reservation system, gas
subsidy disbursal, etc.

- Employment Services
- Vehicle Registration
. Driver's License

_ Passport/Visa

. Agriculture

.Land Record
. School admission . Property Registration
_Scholarships _Marriage Certificates
. e-Learning i : Ta_x?s _
. Examination Results Youth . Utility Services

. Municipality Services

Student

. Pensions
- Birth Certificate f 3 N S::I;ha'z‘.c:re
-Health Care & : Death Certificate
1N M
Old age

Child

Multimedia and Entertainment

Multimedia refers to combination of text, audio, video, graphics, animation, etc. It is one
of applications of IECT. Multimedia is used to improve quality of presentation by
incorporating information sharing, usage of graphics and animation, motion capture, etc.
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Summary

In this chapter, we discussed different components of a computer, and familiarized
ourselves with concept of hardware and software, representation of data/information,
concept of data processing, and applications of IECT.
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2. Computer Concepts — Introduction to GUI

based Operating System

Personal computer has advanced a lot in a short period of time, and much of the
advancement is due to ongoing progresses in operating systems. Evolution of operating
systems had made PCs easier to use and understand, flexible and reliable. This chapter is
the study of primary operating systems currently used in personal computers and network

servers, and their basic features.

This topic presents a broad survey of concepts and terminologies related to operating
systems like: Basics of operating system, user interface, basic settings of operating

system, file & directory management, and types of files.

Basics of Operating System

Operating System
Operating system is a software that controls system’s hardware and interacts with user

and application software.

In short, an operating system is computer’s chief control program.
Functions of Operating System

The operating system performs the following functions:

e It offers a user interface.

e Loads program into computer’'s memory.

e Coordinates how program works with hardware and other software.
¢ Manages how information is stored and retrieved from the disk.

e Saves contents of file on to disk.

e Reads contents of file from disk to memory.

e Sends document to the printer and activates the printer.

e Provides resources that copy or move data from one document to another, or from
one program to another.

e Allocates RAM among the running programs.

e Recognizes keystrokes or mouse clicks and displayes characters or graphics on the

screen.
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Types of Operating System

There are four types of operating systems:

e Real-time operating system
e Single-User/Single-Tasking operating system
e Single-User/Multitasking operating system

e Multi-User/Multitasking operating system

Real-time operating system
Real-time operating system is designed to run real-time applications. It can be both single-
and multi-tasking. Examples include Abbasi, AMX RTOS, etc.

Advantages

o It works very fast.
e It is time saving, as it need not be loaded from memory.

e Since it is very small, it occupies less space in memory.

Single-User/Single-Tasking OS

An operating system that allows a single user to perform only one task at a time is called
a Single-User Single-Tasking Operating System. Functions like printing a document,
downloading images, etc., can be performed only one at a time. Examples include MS-
DOS, Palm OS, etc.
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Advantages
e This operating system occupies less space in memory.
Disadvantages
e It can perform only a single task at a time.
Single-User/Multitasking OS
An operating system that allows a single user to perform more than one task at a time is

called Single-User Multitasking Operating System. Examples include Microsoft Windows
and Macintosh 0OS.

©) New Tab - Google Chrome

WH CCC 2. Introduction to GUI Based Operating System - Word

+

New desktop

3:56AM
< yos

F-ll O Type here to search
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Advantages
e Itis time saving as it performs multiple tasks at a time yielding high productivity.
Disadvantages

e This operating system is highly complex and occupies more space.

Multiuser/Multitasking OS

It is an operating system that permits several users to utilize the programs that are
concurrently running on a single network server. The single network server is termed as
“Terminal server”. “Terminal client” is a software that supports user sessions. Examples
include UNIX, MVS, etc.

bt -0 Client
I"'I"I'!“ Device management

= |
. N=
E:g?r:eihrﬁqn;: — ' &=| FOI Client
— I = Asset-Management

S—

@ FDI Client

- Portable
| FE—

FDI Device Package P ' / ~ -
; 9 Field level

Advantages

e It is highly productive as it performs multiple tasks at a time.
¢ Itis time saving as we don't have to make changes in many desktops, instead can

make changes only to the server.
Disadvantages

e If the connection to the server is broken, user cannot perform any task on the client

as it is connected to that server.
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Basics of Popular Operating Systems (Windows, LINUX)

We shall discuss about the basic of Operating Systems in this section:

Windows Operating System

Windows operating system is developed by Microsoft Corporation. It provides Graphical
User Interface (GUI), multitasking capability to users. It also provides virtual memory
management and several peripheral devices. According to statistics, about 90% of

computers have migrated to Windows operating system.

er
Alarms & Clock
B Android studio

B

B sioodshed Dev-cer

C
E Calculator
r

a

Y © ffype here to search

Versions of Windows Operating System

Windows Server | Code Launch Kernel | CPU Min Min
Version Name Date Version | Speed Disk Memory
Windows for | Sparta Oct-92 3.1 25 MHz | 10.5MB | 3 MB

Workgroups 3.1

Windows for | Snowball | Nov-93 3.11 25MHz | 10,5 MB | 3 MB
Workgroups 3.1

Windows for NT 3.1 | NT OS/2 | Aug-93 NT 3.10 | 25 MHz | 90 MB 16 MB

Advanced Server
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Windows for NT 3.5 | Daytona | Sep-94 NT 3.5 25 MHz | 90 MB 16 MB
Server

Windows for NT | Daytona | Jun-95 NT 3.51 | 25 MHz | 90 MB 16 MB
3.51 Server

Windows for NT 4 | Cairo Jul-96 NT 4.0 33 MHz | 150 MB 32 MB
Server

Windows 2000 | Janus Feb-00 NT 5.0 133 1000 MB | 128 MB
Server MHz

Windows Server | Whistler | Apr-03 NT 5.2 400 1500 MB | 512 MB
2003 MHz

Windows Server | R2 Mar-06 NT 5.2 400 1500 MB | 512 MB
2003 R2 MHz

Windows Server | Longhor | Feb-08 NT 6.0 1000MH | 20,000M | 512 MB
2008 n z B

Windows Server | Server 7 | Oct-09 NT 6.1 1400MH | 32,000M | 512 MB
2008 R2 z B

Windows Server | Server 8 | Sep-12 NT 6.2 1400MH | 32,000M | 512 MB
2012 z B

Windows Server | Blue Oct-13 NT 6.3 1400MH | 32,000M | 512 MB
2012 R2 z B

Windows Server | Redston | Sep-16 NT 10.0 | 1400MH | 32,000M | 512 MB
2016 e z B

Linux Operating System

Linux is a multitasking operating system that supports various users and numerous tasks.
It is open source, i.e., code for Linux is available for free of cost. Linux can run on any
computer and support almost any type of application. Linux uses command-line interface.
It also supports windows based GUI environment, called “shells”. The most popular Linux
vendors are Red Hat and Novell. Some of the Linux versions include Ubuntu, Fedora, Linux

Mint, etc.
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User Interface

While working with a computer, we use a set of items on screen called “user interface”. In

simple terms, it acts as an interface between user and software application or program. It
accepts inputs from input devices like keyboard, mouse and displays output to computer

monitor.

Acrobat.com TeamViewer

13

- e 359 AM
. O Type here to search L& * 42372018 >

Task Bar

e Task bar appears at bottom of the Windows desktop.
e It is used to launch and manage programs.

e It also shows icons of currently running programs.
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Task bar

Components of task bar
A task bar consists of following three components:

e Start menu
e Quick launch bar

o Notification area

Start Menu

Start menu contains shortcuts for launching programs and opening folders on computer.
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Start menu

Quick Launch Bar

It is a special section at left end of task bar where we can add icons to quickly start
programs.

Quick launch bar
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Notification Area

Notification area displays icons for system and program features. It also displays system

volume and a clock.

Notification area

Icons

A small pictogram displayed on the desktop is called an “icon”. It represents links to the
resources on PC or network. Icons actually are tiny graphical symbols that represent
programs, files, folders, printers, documents, etc. Icons are also called as “shortcuts”.
Using mouse pointer, we can click the icon and then corresponding resource will be

launched.

Start Menu

Start menu consists of shortcuts for launching programs and folders. It also consists a list

of most recently used documents and provides ‘search’ option and supports ‘help’ feature.
Launching Start Menu

e Start menu can be set in motion by clicking (H Win) windows button on a keyboard.
e It can also be launched by pressing CTRL+ESC on a keyboard.

e By clicking on the visual Start button, it can be launched.
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Visual start button

Running an Application

The operating system offers an interface between programs and user, as well as programs

and other computer resources such as memory, printer and other programs.
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0 -
perating System
Microsoft Windows, Mac 05 ¥,
Libssritu ete

Hardware
Processor, Keyboard,
Mouwse, Hardware etc

Fig 2.13

Process
e Step 1: Application sends request to operating system.
e Step 2: On encountering the request from an application, operating system sends

a response to requested service.

Operating System Simple Setting

We will learn different settings in Operating System:

Changing System Date and Time
We can set system date and time in three ways given below:

Step 1: One way is to just click the clock on task bar and perform Step 4 and Step 5.
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Go to clock

Step 2: Another alternate way is to go to the "Control Panel” from Start menu and select

“Clock, Language and Region”, and select "Date and Time” and perform Step 4 and

Step 5.

2 D @€
Ml et manch

_.,a Cnm_u»ol?md
Cesttzg age

Appe
£ xamMPP Control Panel
Search suggestions

O control Panel

In search bar. Enter control panel
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Select control panel

] YAMPP Control Panel

& Setings
Search suggestions

D control panel

o
X

[0 Controt Paned

* Bl » Conteol Paned

Adjust your computer's settings

Programs

Select change date, time or number formats option

Step 3: In the window displayed, select "Change date and time”
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R L

¥ Regon
Fomats Locaton  Admewsratiee

Format: Englsh (United States)

Match Windows deplay langusge (recommended)

Laogusge prefuenie

Date and time formats

Short date: Mdlyyyy v
Long date dddd, MMM d, yyyy v
Short time: e 1t -
Long time: hemoncss tt v
Fustdey of week:  Sunday v
Eamples

Shont date: 4232018

Long date Meaday, Agnl 23, 2018

Sheort tine: 427 AM

Long bime: 420% A

Hatory

® GaER

User Accounts
@ Change acceunt type

Appearance and Personalization

Clock, Language. and Region
Add a language

Change mput methods

Change date, time, or number formats

Ease of Access
Let Windows suggest settings
gt used dplyy

Computer Concepts

Search Centrel Panel r

Step 4: Set corresponding date and time, and finally press "OK"” button.

Change the date

—

¥ Customize Fomat

Wumbers  Cumency  Time te

Example

Shart dete: [ a/z2mg

Lang dste Mesday, Apnl 13, 2018
Dt formats

Shart dete: Mdippry

Long date: T add. MMM & gy
What the notations

mean:
d, dd = day; ddd, dddd = day of weeky b = monthy v = year

Catendar
Whan o two-dagit year i enteced, interpest i ot & yoar betwren:
1530 and | 209 2

Firstday of weeic  Sunday

numnber, curnency, time, and drte.

=]
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Click Resef bo restoee The gysiem defaull seitmgs for [

Cancel | Bpply

¥ Hidtory

® Ga&R

w &

Vo By Cabegody =

User Accounts
W Change socount type

Appearance and Personalization

Clock, Language, and Region
Aidd 8 lauage

Change inpt mathody

Change date, Hime, OF Paamibesr inrmats

Ease of Access
Lat Windows suggest wettingt
Optavaze visudl displary

Saurch Cortnzl Parl -]
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¥ Customize Format x
|

Musters Curercy Tme Date

Example ¢ stegery ¥

Short date 432014

User Accounts
Leng dute Menday, Apnil 23, 2018 S& b el
-
Date formats E‘ Appearance and Personalization
Short dete M dlyyyy - —_—
Clow ANGLUAC

s, and Region
Leng date dddd. MMMM d, yyyy ! b )

What the notataons mesn:
d dd = duy; ddd dddd = day of week; M = month; y = year

Calendar

When 2 two- gt yeav 15 entered, wterpret it 25 2 yeir between

and | 2009

Firstdoy of week:  Sunday

Click Reset to restore the system default settings for
numbers, custency, time, and date.

oK , || Cancet
. - A

Press ok

Changing Display Properties

Display properties include Desktop Background, Text, Window Color, Sounds,

Screensaver, etc. To change these display properties, we have to perform the following
steps.

Step 1: Right click on desktop and select "Personalize” from displaying options.
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Right click on desktop and select personalize

Step 2: From the displayed window, select desired action, like changing the
background/themes/resolution, and press “"Save Changes” button.

Change display settings from here

Settings S o x
%@ Home Background
Personalizatior —
| Bd  Background L 2 ST
G =
&) Colors =
28 Lock screen
Background
Th
= emes | Picture
Start
Choose your picture
=3 Taskbar

e SR

Browse

Choose a fit
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Settings - o X

@ Home Background
! |

ersonalizatior

I &d Background

Colors

C3 Lock screen
Background

Z Th )
< emes Picture

88 Start
Choose your picture

o | Qa. "
Browse
I 1

Choose a fit

Choose background picture from here

Step 3: Alternate way is to go to the “Control Panel” from Start menu and select
“"Appearance and Personalization” and select display you want from the listed options

and save changes.

2 0 @
Bt ratch

‘._3 Control Paned

Desiscp wop
Apps
& XAMPP Control Panel
B Setungs
Search suggessons

D control Panel

jol

control Paned

In search bar. Enter control panel
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Select control panel

Bent manch

mg Controf Panel

€G3 20

Apps

) XAMPP Control Pamel

B Setings
Search suggestons

£ control pavel

O cantrol panel

®)
X

£ Control Panel

t B3+ Cortrol Panel » S

Adjust your computer's settings

Select appearance and personalization
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& Apgesrance and Personslaation s [u] x
“- « 4 &> Comtrol Paned » Agpesarance and Personalaaticn v & P
Control Panel Home Navigation
System and Securtty -“ - :
Network and Intemet @ Fase of Access Center
Mardware and Sound prccommodate ko on sskeys | Tumn Migh Contrast on of off
Programs [ [ile Explorer Options
User Ace ipecéy ungle- or double-clck to open Show Fidden fles and fciden
o Agpeatance and Fonts
Perwonalization A [Previen, delete. o show and hide foss Chamge Font Settings
Clock, Language. and Region
Fave of Access
. .
Go to taskbar and navigation
Choose any of the personalization option
Settings - ] X
& Home Taskbar

Personalization

Ed Background
A3
Colors

Lock screen

Themes

2 & 4 &

Start

I = Taskbar

Lock the taskbar

@ o

Automatically hide the taskbar in desktop mode
@ oft

Automatically hide the taskbar in tablet mode
@ on

Use small taskbar buttons

@D oft

Use Peek to preview the desktop when you move your mouse to
the Show desktop button at the end of the taskbar

@ of

Replace Command Prompt with Windows PowerShell in the
menu when | right-click the start button or press Windows key
+X

@ on

Show badges on taskbar buttons
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To Add or Remove a Windows Component
In order to add or remove Windows component, follow the below steps:

Step 1: Type “add or remove programs” in the search box and select "Add or Remove

Programs” under control panel and follow Step 3 and Step 4.

Dot atch

Add o remave progeams

setmng
IZ Apps & features
Search yuggeitams

add of remove programs

Enter add or remove programs in the search bar

Step 2: Alternate way is to select "Control Panel” from start menu and select "Uninstall

a Program” from “Program” and follow Step 3 and Step 4.
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2 0 @9

Bt tratch

'.,3 Cootrol Paned

Desinop wop
Apps
& XaMPP Control Panel

B Settngs
Search suggestions

2 controf Panel

£ control Paned

In search bar. Enter control panel

Select control panel

'.r] Controd Panel
o
Destrop 2
Agps
] YAMPP Control Pamel

& Setvings
Search suggestons

O control parel

AEBEYLEARMNINDG

@J . tutorialspoint



Computer Concepts

R Control Panel - o X

+ B Control Paned » v B e

Adjust your computer's settings Viewby: Categoey *

System and Security

Review your computer’s statut

Seve backup copees of your fdes with Fée History
Backup and Restore (Wndows 7)

User Accounts
@ Chenge account type

Appearance and Personalization
Network and Internet

View network statut and tashs

Choose homegroup and shanng optons

Hardware and Sound

View devices and ponteny

Add s devce

Adjust commmonly used mobity settags

Clock, Language, and Region
Add 2 anguage

Change input metheds

Change date, teme, or number formats

Ease of Access
Let Windows wuggest settings
Optimize vsuel doplay

® GaR

Programs

.:'-::\:lez.glé'

& 4 4 8

Step 3: Click "Turn Windows features on or off” on left side of programs and features

window.

Select turn windows features on or off option

@ Preframs and Featuees - o x
« o ﬂ + Control Panel » Programs » Programs and Festures v O Search Prograss and Features O
Coqtrol Panel Home P g
Uninstall or change a program
mul-duv“ﬂ To uminstall a program, sefect it froen the fist and then chck Usinstall, Change, or Repair,
j ) Orgarice + @ 'o-nduﬁ Uninstall = @
Publsher Instalied On  Sae Version o
A Acrobat.com Adobe Systems Incorporated 1/28/2018 239kE 1037
O Adobe AR Adobe Systemns Inc, 252008 10499
B Adobe Flash Player 21 FPAPI Adobe Systems incorporated vz20 194M8 2100242
B icobe Reader § Adobe Systems Incorporeted w5017 2W3M8 500
= Radreid Studie Google Inc. 472008 10
(W Connect 4162018
[~ [ Elcodihed Scftmare 1292008 ST
B 0-Unk Connection Manager 0-Link 4162011
B Deiby Audio X2 Windews 451 SOK Dolby Laboratcens, bnc. 172912012 934ME 07.585
D DowerPack Notéier OriverPack Solution 12302018 20
@ Geogle Chrema Googhe Inc. W26/2017 M8 6503325121
W Geeenshor 1222 Greensat g2 246M8 12812
0 Intel ® Hardware Accelerated Execution Manager Intel Corperation 4aN72008 6K 621
@ 108 Usinstailes 10bit 172018 s3aMe T20M
(s fova § Update 161 (54-be) Oracle Corparation 4172008 EME 80165012
| s harve SE Development Kit 2 Update 141 (64-but) Oracle Conpecation 4172008 M9MB 20160012
1] Microsoft Office Professional Pius 2013 Microzoft Corporation 172572008 S38ME  15.0.4560.1506 v
Currently mstalled programs Tetsl see 19268
@l 36 programm mitaled
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Step 4: From window displayed, add or remove the program you want, and click “"OK"”

button.

« T B » ComrolPanel » Programs » Programs and Festures

Control Panel Home »
Uninstall or chanoe a oroaram
3 Windows Festures

Te wsingtall & prograt

) X

7]

View instalied updates

&

Vindows festures on or

Turm Windows features on or off
Organze v (@ Powe

To busn a feature on, select &5 check boe To tum & feature off, Clear its
chack box. A flled box meses that only part of ature it tumed on.

NET Framework 3.5 (includes NET 2.0 40d 3.0) -

NET Framework 4.7 Advanced Senvices

Name
) Acrobat.com
O Adcbe AIR
B Adobe Flash Player 21

Active Directory Lightweght Directory Senvices
' Adcbe Reader 9

Contaren

Android Studeo

Data Center Bridgng
Device Leckdown
Guoarded Hont
Hypes-¥

Internet Explores 11
Intermet Information Services
Internet Information Senices Hostable Web Core

| pancy Commnooenty

23 DrverPac
@ Google Chrome

W Geeenshet 12312

B el ® Hardware Acce

d Uranstalier

Update 161 (64-bt)

24 Jovn SE Development Kit 8 Update 161 (64-bat
] Microsott Office Professional Plus 2013

Q!

Currently nstalled programs Tota sue 1.2 GE

Add or remove programs and select ok

Changing Mouse Properties

e Veruon A
BOKB 10377
52
64 K8
53AMB
v

Properties of the mouse can be changed by following steps below:

Step 1: Go to "Control Panel” from start menu.

ot
<jj Control Panel
eoop 00p
Apps
£ xAMPP Control Panel
B Setings
Search suggestons

O controf Panet

O controt Paned

In search bar. Enter control panel
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Select control panel

2 D @€

st match

._g Control Paned
Desioop ape

Apps

() XaMFEP Control Pamel

B Setings

Search suggestions

O control pacel

D control parel

Computer Concepts

Step 2: Select "Hardware and Sound” and select "Device and Printers” from the listed

options.

Select hardware and sound

G Contrel Panel

- ™ B8+ Control Panel

Adjust bour computer’s settings

£

-
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Select mouse under devices and printers

8 Heedware and Scund

« 2 T 89 » Comteol Paned » Hardware and Sound

Centrol Panel Home

<an Devices and Printers

Stem and Securty
Network and Intermnet

o Hardware and Sound

Clock, Language, and Region

Ease of Access

Computer Concepts

Step 3: Click on "Mouse” under Devices and Printers, and change any of the following

properties and “Apply” changes.

> Button - Changes primary and secondary button and double-click speed.

> Pointer - Changes image seen during specific window operation.

> Pointer Options - Changes precision of pointer, speed and visibility of long or

short pointer.

> Wheels - Changes horizontal and vertical scrolling.
> Hardware - Helps to view properties of mouse.

> Device Setting - Required only if we are using the laptop.

L]

e = "8 ¥ & Moute Preperties X |

Centrod Panel Homel BLBors  Porters Porter Optons  Havdware
< < Son corfgurston Device Manste

Syrtem and Securty L o 9

Netwerk and Inteenel L] Swach prmary and secondary butions

Select this chack box 1o make e tution on the

Mt the ane you use for pamary functions such }eo

a1 selecting and dragong -3

* Hardware and Soun

Programs

b

Docble-chck speed
Deniechok the fokder 10 test your seting 1the

3 3 lider doss Nt open o cose. by uang & sower
Clack, Language. anf ahe l’
Eave of Accens B e F
Soead  Siow 3] =
ChekLock [

7] Tiars a0 Oack Lock

Erabies you 8o highight or drag without haldng down the mouse
Sutton. To set, brefly press The mouse bution. To miease, chok the
nouse Button agan

I

Make the desired changes and select apply
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Adding and Removing Printers
To add or remove printers we have to execute following steps:

Step 1: Go to “"Control Panel” from start menu.

.,3 Control Panel

S0P WP

Agps

&) XAMFP Control Panel
B Setongs

Search suggestions

O control Panet

D control Paned

In search bar. Enter control panel

Select control panel

‘“B Control Fane!
Desinep app

Apps

£ XAMPP Control Pame!

B Setvngs

Search suggestons

D control pesel

£ controt parel

Step 2: Select "Hardware and Sound” and select "Device and Printers” from the listed

options.
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Select hardware and sound

E0 Contrel Panel - (u] X
- + & Control Panel » vl |en 2103 Panes P
Adjust our computer’s settings
System and Security User Accounts
'v"'u 'L« your compater's statuy @ Crunge account type
Save backup ¢
Backup and Restere (¥ .
Appearance and Personalization
Network and Internet —
View network status an ks : ; > X
Crecee homegreup and thanng opbxas Y Clack, Language, and Region
Add 8 language
Hardware and 5 A Change rgut metheds
View devices and prinder _ Change date, time, or number foematy
Adda device ‘ dware and Sound
Of termave prntens and othes Ease of Access
Adust ¢ ry— ¢
dust commonly .'N‘i ha hange gt e suggen settings
play COs astomatic el dsnlnn

- ’ waal ditpley
Prcqmm. power, update device
Usinstall & pregram more

#0) Hardware and Sound - (n] x
“ > T % » Conteol Panel + Hardware and Sound N Search Control Pane o

Controt Pane Home

System and Secusty
Network and Intesnet
Hasdware and Sound
Programs

Uter Accounts

Agpearance and
Pericnalization

Clock, Langusge. and Region

Eate of Access

)

4
Ei

Devices and Printers
Add adevice | Advanced i g Mewe ) Device Manager
Change Windows Te Go wtartup op b

AutoPlay

Change default settings for medie or devices  Play CD3 or other media sutoomaticelly

seunds  Manage sudio d

Power Options
Change battery &

Adjunt screen brightness

Change what the power buttons do Change when the computes sleeps

Choote 3 power plan
Windows Mobility Center

Adjuzt commonly used moblity settings

ed

eceive 2 file

156911031 before gaang 3 peesentaticn

Infrar

Realtek HD Audio Manager

Step 3: Now under “Devices and Printers”, we can add a printer using "Add a Printer”

tab at top of the window.
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Select the device. If you don‘t find your device, select this

Hetweoek and Inbemet

» Hasdware and Sound ]

Choose a dewig

or printer to add to this P

Step 4: To remove a printer, “"Right Click” by placing the cursor on printer you want to

remove, and select "“Remove Device” from popped up menu.

File and Directory Management

Here, we will learn the concepts of File and Directory Management:

File

File is nothing but a collection of information. The information can be of numbers,

characters, graphs, images, etc. Every file should be stored under a unique name for its

future reference. Every file should be saved along with an extension. Some of the

extensions and their description are given below:

Extension Description
.avi Microsoft videos for Windows movie
.dbf dbase II, III, IV data file
.doc(x) Microsoft word for windows

.gif Graphics Interchange Format
.htm Hypertext Markup Language
.html Hypertext Markup Language
.JjPg JPEG graphics file
.mpg MPEG video file
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.mid MIDI music file

.mov QuickTime movie

Representation

File should be represented in address bar along with path of the file, filename and

extension.

For example: C:\Windows\system32\Hello.html
In which C:\Windows\system32->path
Hello—>filename

.html->extension.

Directory Management
Directory is a place/area/location where a set of file(s) will be stored. It is a folder which
contains details about files, file size and time when they are created and last modified.

The different types of directories are discussed below:
Root Directory

Root Directory is created when we start formatting the disk and start putting files on it. In
this, we can create new directories called “sub-directories”. Root directory is the highest

level directory and is seen when booting a system.
Subdirectory
Subdirectory is a directory inside root directory, in turn, it can have another sub-directory

init.

File Management System

The file management system is a software which is used to create, delete, modify and

control access and save files.
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( Creating file ) Create a file give it
a name then save
( File deﬁning) it in such as document

Responsibilities of File Management System

The responsibilities of File Management System are as follows:
Operation

This provides user to work with or manipulate the files. Manipulation includes open, close,
save, copy, delete, move, rename, share, etc.

Security

By supporting authorization, it restricts unauthorized user to log into system and access
files. Username and password are required for authorization purpose. It supports file

encryption feature and asks for authorization to access those encrypted files.
Integrity

In support of integrity, file management system will keep track of data manipulations like
deletion, modification, addition of data, etc. If the data gets modified, deleted or added,

then those changes should be reflected in all the files.
Storage

This allocates memory for storing files, deallocates memory of deleted or unused files and

maintains backups.

Types of Files

Files in the operating system are of following types:

Ordinary files
Ordinary files help to store information like text, graphics, images, etc. These files are
used to store information fed by the user. Examples of ordinary files include a notepad,

paint, programming applications, etc.
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Directory files
Directory files are nothing but a place/area/location where details of files are stored. It
contains details about file names, ownership, file size and time when they are created and

last modified.

Device files
Device files are also called as special files. They are created by operating system which
act as a mediator between the operating system and hardware like printers, plotters, etc.,

and are stored under a sub-directory, “/dev”.

FIFO files
FIFO files act as an input/output channel between processes. As the name indicates, it

maintains order of request and response to files by user or any other device.

Summary

This topic had given a detailed description of operating system, user interface, changing

simple settings in the operating system, files & directory management and types of files.
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3. Computer Concepts — Elements of Word

Processing

Microsoft Word is a popular word processing software. It helps in arranging written text
in a proper format and giving it a systematic look. This formatted look facilitates easier
reading. It provides spell-check options, formatting functions like cut-copy-paste, and
spots grammatical errors on a real-time basis. It also helps in saving and storing
documents.

It's also used to add images, preview the complete text before printing it; organize the
data into lists and then summarize, compare and present the data graphically. It allows
the header and footer to display descriptive information, and to produce personalized
letters through mail. This software is used to create, format and edit any document. It
allows us to share the resources such as clip arts, drawing tools, etc. available to all office
programs,

In this chapter, you will learn about Concepts related to MS Word in detail. You will know
about Word Processing Basics, Opening and Closing the Document, Text Creation and
Manipulation, Formatting Text, and Table Manipulation.

Basics of Word Processing

Word processor is used to manipulate text documents. It is an application program that
creates web pages, letters, and reports.
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Word document

Y
w3 O - Document1 - Microsoft Word ? WM - O X
FILE HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW »
ol o o= _ = _ 0= || 0= o
Calibri (Bod 1 | =EiEs ==
D alibri (Body) 0= T B= = A‘-f‘ T ©
Past = 4 ey e = = Styles |Editing|  Gi
aste es inger
- ¥ ;E;'a.ry'ﬁ'Aa' T{ - ?
Clipboard Font P Paragraph | Styles Ginger Tools ~
L--z---|---1---|---2---|---3---|---4---|---5---|---6
~

PAGE1OF1 OWORDS [l B —— b+ 100%

Opening Word Processing Package

Word processing package is mostly used in offices on microcomputers. To open a new
document, click on “Start” button and go to “All Programs” and click on “Microsoft
Word".
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v
nr PowerPoint 213
/e Intemet Explorer

G Google Chrome

8 Calculator

7

m% Excel 2013

& VLCmeda player

@* Word 2013

Games

Computer

Control Panel

( l& Snipping Toel
Devices and Printers

TeamViewer 13
Default Programs

. P o
/ aint Help and Support

Sticky Notes

E Kindle

Moolla Firefox

-
~\ Windows Easy Transfer Reports

Q Inkscape

TSRt doan ¥

vi

n'_ PowerPoint 2013

,e Internet Explorer 3

Co‘ Google Chrome »

Pictures

8 Calcutator

~'= Music
n;J Excel 013 »

4 Games
M VLC media player y
s e :
Computer

m Word 2013 »

- Control Panel
’% Snipping Tool
TeamViewer13

Devces and Prnters
Defauk Programs ‘
& pent ’

Help and Support

O]

Stacky Notes 4

K o ,
.’ Mozilla Firefox ’

Py
Q\' Windows Easy Transfer Reports

0 Inkscape »
4

> AllPrograms

L

Go to All programs
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B8 Acobe Reader X1
{© Default Programs
@ Desktop Gadget Gallery
@ Google Chrome
@ Inkscape
@ Intemet Explorer
@ Mozills Firefox
(2 TeamViewer 13
&4 Windows DVD Maker
5l Windows Fax and Scan
€ Windows Media Center
£ Windows Media Player
& Windows Update
<A XPS Viewer
. Accessones
4 Amazon
o Classic PDF Editor
. Dropbex
ESET
File Viewer Plus
. Games
. Ginger
Grammary
Greenshot
LEd
. Mantenance
. MathType
Microsoft Office 2013
4 Plagiarism ChecWer X
Reimage Repair
| RTF Repair Kt

4 Bk

Computer Concepts

Pictures

Music

Games

Computer

Control Pane

Devices and Printers

Go to Microsoft Office 2013

Menu Bar

A menu bar is located below the title bar. A menu bar is an application window to furnish
application or window-specific menus. Menu bar has File Menu along with Home, Insert,
Design, Page Layout, References, Mailings, Review, And View.

File - It has options such as, Save, Save As, Open a New Document, Print, etc.

Home - It has icons to change Font Size, Style, Alignment, Borders, etc.

Insert - It has icons to insert Table, Shapes, Chart, Pictures, Screenshot, Header, Footer,

etc.

Design - It has icons to change Themes, Colors, Fonts, Effects, Page Borders, etc.

Page Layout - It has icons to set Margins, Orientation, Size, Breaks, Indent etc.

References - It has icons to Add Text, Update A Table, Insert Footnote, Index.

Mailings - It has icons to start Mail Merge, Add Labels, Envelopes, etc.

Review - It has icons for Spelling And Grammar Check, Thesaurus, Word Count,

Comments, Tracking, etc.

View - It has icons like: Zoom, Print Layout, Switch Windows, Split, etc.
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You may use a particular menu to give an instruction to the software. Place mouse over
menu option and click left mouse button to open drop-down menu. You can use left and

right arrows on your keyboard to move left and right across menu bar option. Up and
down arrow keys can be used to scroll drop-down menu.

Menu bar

2 = o i = l Drocment] - Word 2 m — [
HOME INSERT DESIGN PAGE LAY OUT REFEREMNCES PAAILINGS REVIEW VIEW I Segr anf
— - = A : - L= P
Calibr (Body) - |11 - AT AT Al — . AaBbhCcDr AaBbCoby b -
Fd_'«‘e w B X M - oabe M, x o - A~ - _ A — fl Mormal | T Mo Spac Heading 1 [o] ESaing
Clipboard 1w Famt Faragraph = Stybes = -~
R R PR L+ 3 i z - I T O A - & > -
O WADRDS 0= EMGLISH (UNITED STATES)

Using Help menu

Help menu - By clicking this button, you can get help for any information you need. Help

button is located at the top right corner of window. It looks like a question mark, “?”.
Shortcut key for help menu is F1.
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Help menu

T
[ I s Document1 - Microsoft Word t\ B - 0O X
)
HOME INSERT DESIGN PAGE LAYOUT REFEREMNCES MAILINGS REVIEW VIEW GING Microsoft Word Help (F1)

o Calibri (Body) [ -||iE-i=une = as b # ©
b ) — AaBbCcDd AaBbhCcDd : C
ph B I U-sbex, X A ==== 1=- AaBbCc [ et B
aste . - | p 1 Normal | T NoSpac... Heading1 [ L inger
- A-%-A-mra- A8 D0 400 .
Clipboard = Font [ Faragraph F Styles [ Ginger Tools|
L ::l DL SR B 2. 0 e e 0 3 [ I BRI SICEET R B I - A T

-

PAGE1OF1 oworDs [J2 £ = 100%

Using Icons below Menu Bar

The bar located below menu bar is the toolbar. Toolbar provides shortcuts to menu
commands. It has icons which represent commonly used functions.

= > to save a file.

=

=" - to print current file.

= - to check for page orientation before the document gets printed.

ABC

v/ > to check spelling, grammar and writing style.

& - to remove selected word or sentence from the document.

BE
ie to copiy selected word or sentence from the document.

=

== > to paste content from the clipboard.

REIREN to reverse the last command. Shortcut key for undo is “Ctrl + Z”
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19 to redo last command. Shortcut key for Redo is “Ctrl + Y”

"> to set borders to content.

—>to insert a single table or more tables as required into the document.

—>to change number of columns in the document.

A -
= - to change font color.

A

- to change font style.

Tool bar

-0 3P vA-E- - Document1 - Microsoft Word ? ® - 0O X
FILE HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW GINGER ACROBAT Sign in
= Calibri (Body} =|11 ~-| A A Aa- A ==l EEE . # ©
0 alibri (Body) A A [ g = AaBbCeDd AaBbCeDd AaBbCe -
Pavste e B I U-abex, ¥ B-%-A- P - Al g fMormal | 1NoSpac.. Heading1 |2 Ed'E'"g Ginger
Clipboard = Font [F) Paragraph i Styles Ginger Tools ~
L | T : A B T T T . .4 . CIR TR TR S e -

-

PAGE 1 OF 1 0 WORDS

+ 100%
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Opening and Closing Documents

Word automatically starts with a blank page. For opening a new file, click on "New”.

e To close a document, click "X” in the upper right corner of window.

Close document

¢ ABC = . n
BH S 0ORQF vE-=- - Doc1 - Microsoft Word ? B - O XD
HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW GINGER ACROB »

== X | |calibri (Body) 11 -||i= i == A‘ # ©
I S
LBy B T U-~aex, ¥ B ==== 1=~ - - :
Paste PR R Styles Editing  Ginger
- A-F-A-nr- AKX O 80T - -
Clipboard = Font 7 Paragraph i Styles & Ginger Tools ~
LZ 1 '1""‘"2"""'3"'""4"‘""5"""'6"'5'

PAGE1OF1 71OF71WORDS [I%

Opening the document
To open an already existing document, follow the below steps.
e Click on the “File > Open”.
From the window opened, select a file you want to open and double click on it or

just right-click and select “open”.
e Shortcut key is Ctrl + O.

64

w tutorialspoint



Go to FILE
[~ 15| e
HOME INSERT DESIGN
L - -
B Calibri (Body) (11 ~ A A

Paste B I U -a x, x°
Clipboard = Font
- - - - - -8 -

w | I

3
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Document! - Word T B = B X
PAGE LAYOUT REFEREMCES MAILINGS REVIEW VIEW Sign iry
sl aeliZrizetiny EE ) -
Ao~ | o T T AaBbCeDe | AaBbCeDe AaBbC A
= n !
o . A - "y - B q T Normal | TMNoSpac.. Heading 1 Editing
] Faragraph ] Styles ] S
| I B v § . | & 7 -
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Select Open

Computer Concepts

©

Info

New

Open S

Save

Save As

Save as Adobe
PDF

Print

Document1 - Microsoft Word

Info

»

Protect
Document ~

D
Check for
Issues ~

Protect Document

Control what types of changes people
can make to this document.

Inspect Document

Before publishing this file, be aware that
it contains:

Document properties and author's

7?7 — 0O X
Sign in
-

Properties -
Size
Pages
Words
Total Editing Timg
Title
Tags
Comments

name
Share Related Dates
- Last Modified
Export a Versions
a # There are no previous versions of Created
ose P .
S Maflage this file. Last Printed
Versions ~
Account Related People
Author
Options
-
»
Document1 - Microsoft Word ?7 — 0 X
Sign in
@ e D Recent Documents
1 Doc3
Save r Desktop
@ OneDrive —
Save As =/ n
—| Desktop
Save as Adobe
PDF Ellzl Computer Doc4
— Desktop
Print L Doc5
+ Add a Place Desktop Open [y
Share
Doc6 Open a copy
Export =| Desktop Copy pathlto clipboard
N o]
o Doc7 Pin to list
Deskiop Remove frpm list
Doc9 Clear unpifned Documents
Account —| Desktop
Options Doc10
Necktnn

Save and Save As

Right click and select Open

After finishing our work, we must save the document permanently, as it is useful for future

reference.
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e As RAM is a temporary storage memory, we must save our file on the hard disk.
e To save a document, go to "“File” menu and select “"Save” option

e Shortcut key is “Ctrl + S".

e Then the file gets saved under a default name.

Go to FILE

m =] O - Document! - Word T B - O X
HOME INSERT DESIGN PAGE LAYOUT REFEREMCES MAILINGS REVIEW VIEW Sign iny

L - T A - A E_ iz tioy EE M
1 Calibri (Body) ~|11 =~ A A Aa- H9 e AaBbCeDe AaBbCeDe AaBbC

Paste @ B I U -amx, ' A-¥-45- . A 1 Hormal | 1Mo Spac.. Heading | Edting

Clipboard = Font il Paragraph I Styles ] -~

EL PPN SEEEEEI BEEE R SEEE I B SRR B I 5 . [y, 7 -

PAGE1OF1 owORDS [J2 ENGUSH [UNITED STATES
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Select Save

Computer Concepts

Document1 - Microsoft Word ? — 0O X
@ Signin
Save As
New
Open f@a OneDrive EII;I CompUter
Save Recent Folders
Computer Desktop

Save As EII;I g

E:
":;EVFB as Adobe + Add a Place Important websites

E: » Important websites
Print Downloads

C: » Users » Freeware Sys » Downloads
Share

12th std
E)(port E:» NCERT » 12th std

Documents
Close
Account
Options Browse

»
68
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Select the location

Document] - Ward 7 - N xl
@ Sign iny

Save As

MNew .
-1 Computer
Ooen ﬁ OneDrive I;I p
Lhpen
Recent Folders
Save =
L] Computer L Desktop
v
Documents
sf=  Add a Place Downloads

C: = Users » admin = Downloads

Browse

Account

Oiptions
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B Save &s b4
“ v 4 Ga » ThisPC » Local Disk (C) » w & Search Local Disk (C B
Organize = Mew folder - (7]

B This PC C- Name - Date modified Type G

-3 3D Objects Drrvers 23-5ep-17 B3 PM e folder

B Oesktop Iritel 25-5ep-1 e folder

4| Documents EST.“T G t:rl-'l-"

nelviveTemp 22 e folder

[ load

¥ Downloads PerfLogs 20 e foldes

J Music Pregrarm Files 18 g foldes

= Pactures Program Files (x36) 0 & folder
. Videos ProgramData 15-Apr File folder -

4 Local Disk (C) » < = 7 >
File name: [ Docl| -
E 3
Save as types Word Document o
Authors: Windows User T.11:|-'.: Add a tag
] Save Thumbnail
 Hide Folders Toos Canca
Enter the file name
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n, Save As X
€« © A &> ThisPC » Local Disk (C3) » v & earch Local Disk o Sign iy
Organize v New folder EE v o
: A Name 2 Date modified Type A
v [ This PC g S
J 30 Objects Drivers
B Desitop Intel 25-Sep-17 8:37 PM
; MSOCache g-Nov-17 §:52 AM
3| Documents
OneDriveTemp 22-Apt-18 9:09 AM
¥ Downloads S s :
Perflogs 20-Feb-18 1216 PM  File folde
d Music Program Files 18-Apr-18 LOAPM  File folde
&= Pictures Program Files (x86) -Ape-18410PM  File folder
B Videos ProgramData 15-Ap 40 P :
v
y i LocalDisk (C) o ¢ R : >
File name: [ Doc "
Save as type:  Word Document v
Authors:  Windows User Tags: Addatag
D Save Thumbnail
~ Hide Folders Tools ~ Save S I Cancel
—x L“

Select save

Save As option is used to rename a file.

e If you want to save your document in another location with same or different name,
you can use “Save As” option.
e The shortcut key for Save As is “"F12".

e To use
v

AR NI NI

Save As option in a document, follow the below steps:

Go to File menu

Click Save As

Select the drive where you want to save the document.

Then type any Name in the File Name box at the bottom of dialog box.
Then click Save option.
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Go to FILE

m H g 'r-"::] = Document - Waord 7T E - 0 X
HOME INSERT DESIGN PAGE LAYOUT REFEREMCES MAILINGS REVIEW VIEW Sagn iry

) i - " Aa FIN = = = = H
5 Calibri (Body) ~|11 ~| A" & i P AaBbCeDe| AaBbCeDe AaBbhCe

Poste w|B T U-sex,x A-%-A- a . TNermal | 1 NoSpac... Hesding 1 Eddting

Clipboard & Font I Faragraph W Styles = -~

"I e T 3 . 0 & 1. . s % & & . . 3 . & o ' s . B . ) v B v oo o« NS 7. -

-

Select Save As

Computer Concepts

Save As

Open f@n OneDrive

Save

Ellzl Computer

Save As

Save as Adobe
PDE + Add a Place

Print
Share
Export

Close

Account

Options

Documentl - Microsoft Word ? -

O x
Sign in

F;l Computer

Recent Folders
Desktop
E:

Important websites
E: » Important websites

Downloads
C: » Users » Freeware Sys » Downloads

12th std
E: » NCERT » 12th std

Documents

Browse
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Select the location
Document] - Word ? = 0 %
Sign iny
‘T3 Computer
& OneDrive = P
Recent Folders
|=—__| Computer k Deskiop
Documents
+ Add a Place Downloads )
Ci = Users = admin = Downloads
Browse
B saveas = ]
. . - Sigr
& © 4 G » ThisPC » Local Disk (C5) » v | & ca c p g in{
Organize = Mew folder = [ 7]
8 This PC i Name Type -
- 3D Objects Dirrvers File folder
B Desktop Intel Fie folder
5 Documents MSOCache File folder
OnelviveTemp File folder
¥ ugw_nloads PerfLogs File fioldes
B Music Program Files Fibe foldes
= Pictures Prograrm Files (x36) 0 File foldes
Videos ProgramData 15- File folder
g L
i Local Disk (C) » ¢ =7 *
File names [ Doc| 5
- *
Save as types Word Document b
Authors:  Windows User Tags: Addatag
[ 5ave Thumbnail
A Hide Folders Tools = Cancel

Enter the file name
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@ save s o
= « 4 Ee » ThisPC » Local Disk(C5) » v i | D Sign "‘I
Organize = Mew lolder - ﬂ
i " Name ) Date rodified Ll
w O This PC lame Date rnodifies
B 3D Obgects Drivers 5.5 B:3
B Desktop Intel
3 MEOCache
5| Decuments

Gne[\.'w.'e‘remp

Dewnloads
4 Dow Perflogs 20-Feb-1812:16PM  File folde
'h hhusic Frogram Files 18-Apr-18 1:04 PM
= Pictures Program Files (x86) T-Bpr-18 4
I Videos ProgramData !
v
2 Local Disk () o <0077 3
Fllrgame:.Bl:lﬂ w
Save as type | Word Document W
Authors WINJOWSE Liser -"'i Aga atag
':":1 e T nail
» Hide Folders Tools = | Save L Cancel
=
|

Page Setup

Parameters defined by the user help in determining how a printed page will appear.
Those parameters include everything from size, margins, page orientation, and
quality of print. Page setup options are usually available in "Page Layout” menu.
Unless you open an existing document, Word always opens a blank document using
the present formatting defaults.

You can use these defaults or customize the setting for features such as Margins,
Paper Size, And Layout Through The Page Setup Option.

To change settings, click page setup menu.

Margins icon will be displayed in page setup window.

Click on any of the up or down arrows to increase the top, bottom, left or right
margins as per your requirement.

You can also set the position of header and footer.

To change the orientation of a page, choose either landscape or portrait.
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e By clicking the respective icons, you can also make paper source and layout

changes under layout, you can also set margins for headers and footers.

Page Setup menu
E H ':r-" = Decument - Word T EH - 0O %
HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW Sign in
. i -
L™y Owientation = %= Breaks - Indent I""" Spacing + Align~
S= 1 Size - I Line Numbers = | 4= |0 2|32 |opt
Margins E - - _
= == Columns = vt Hyphenation = = 0" - |5z |8 pt . Cily Selection Pane
Page Setup ] Paragraph | Arrange A,
Lo Boe v v 0 0 20 x g 3 R RS Ry,

PAGE1OF1 OWORDS [[# ENGLISH (UNITED STATES)

Print Preview

e This option is used to view the page or make adjustments before any document
gets printed.

e By using print preview, you can discover any errors that may exist in the document
or fix the layout before printing, which can save ink/toner and paper.

e For printing, you may specify the number of copies you want and the pages you
want.

e Shortcut key for printing is “Alt + F and Press W and then V” or Ctrl + P.

75

@J . tutorialspoint

EIMPLYEAEBEYLEARMING



Go to FILE

m = O - Document] - Word T B = B X
HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW Sign iry
Y - .. A = —tice B ¥ "
) g, |[ColriGod) -1 -[A A A3~ | 3P| gy T . AaBbCeDe AaBbCEDE
" — + .

P“:’“ v B I U -abex 2 f- w4 - *y K | T Normal | TMNoSpac.. Heading 1 Ed 1_“9
Clipboard & Font T Faragraph r} Styles ] -
T I . 1 . i . q X . | s a % o v ow ol . il s s B v ow | e B e o« R 7. a

Select Print

Computer Concepts

Info

»

Protect
Document =

Check for
lssues =

Manage
Versions =

Account

Decument1 - Word

Protect Document

Control what types of changes people
can make to this document.

Inspect Document
Before publishing this file, be aware
that it contains
Document properties and
author's name

Versions

There are no previous versions of
this file.

?T - 0O X
Sign in
-
Properties -
Size Not saved ye
Pages 1
Wards 0
Total Editing Time 4 Minutes

Title

Tags Ad
Comments Ad

Related Dates

Last Modified

Created oday, 7:11 PM
Last Printed

Related People

Author

Last Modified By Mot saved

Show All Properties
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Print preview

Document? - Microsoft Word T - 0 X

@ Signin
Print

New
Copies: |1

) -
Open H v
Save Print
Save As . o |~
Printer
i;;;f LA ; Send To OneNote 2013
% Ready
Print Printer Properties
Share Settings
Erreari r Print All Pages .
=/ The whole thing
Close Pages:
|—| Print One Sided
Account Only print on one side of th...

(S(=] Collated

S 123 123 123

Options

| -|  Portrait Orientation | [+ 1 |of1 35% = —1 + [

Printing of Documents

e To print a document, choose File = print.

e Here all the pages of a document will be selected by default.

e To print specific pages that are not in sequence, use comma (,) to separate page
numbers.

e To print a selected text inside the document, highlight the area in document that
you want to print and choose File - Print from menu bar.

e When print window opens, click on radio button to select printer and click ok.

e To print multiple pages on a page, choose the number of pages to print on one
page from the ‘Settings’ of print window. Then click ok.

e Shortcut key is “Alt + F &> Press W and then P”.
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Go to file

@ld (L Document] - Word T B - O X

HOME INSERT DESIGM PAGE LAYOUT REFEREMCES REVIEW WVIEW Sign iny
L] e =

o Body) <11~ A° .| 4 = 4= e ][ 88
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Info

Decument] - Ward

Inspect Dacument
Before publishing this file, be aware
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Document properties and
authar's name

Protect Document Properties -
_’ Contral what types of changes people Size
Protect can make to this decument, P
Document - ages
Words

Tatal Editing Tirme
Title
Tags

Comments

Related Dates

Last Modified
. t
— Versions reated
Q W . Last Printed
1 There are no previous versions of
Manage this file.
Account Versions - Related People

Author

Optians

Last Modified By

Show All Froperties

7 - 0O %
Sign in

-

Mot saved yet
1

0

4 Minutes

Add a title

Today, 7:11 PM

Window...
Add an author

Mot saved yet
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Document1 - Microsoft Word ? — 0O X
@ Sign in
Print
New
Copies: |1 .

et e
Open H
Save Print
Save As . Fp Y

Printer
z?)‘? TLETID ; Send To OneNote 2013
;’Ff) Ready

Print Printer Properties
Share Settings
Erien [ = Print All Pages -

| The whole thing
Close Pages:

|—'| Print One Sided

Account Only print on one side of th

. Collated
SIS Y123 123 123 M

| |  Portrait Orientation | [+ 1 |of1 359 ——4 + &

Computer Concepts

Click to print

Text Creation and Manipulation

There are several kinds of word documents, such as blank documents that starts
from scratch, templates, web pages, reports, etc.

A template is helpful in reusing format of a document.
Manipulation of text includes cut, copy, paste, or moving text to any location.

Document Creation

Click start > All programs > Microsoft Office > Click Microsoft Office 2013
- Word 2013. Word will open a blank document.

Another way to create a document is to choose File > New from the menu bar
and select the document type. Press Ctrl + N on the keyboard. This menu allows
you to open a blank document, a template or an existing document.

To enter text in blank document, just start typing. The blinking I-Beam (Cursor),
positioned at the top of window, will show exactly where your text begins. As you
type, word will automatically wrap text to the next line. If you have finished typing
on a line and would like to move to the next blank line, press enter.
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-
n' PowerPoint 2013
’e Intemet Explorer
G Google Chrome

H Calculator

7

n_!} Excel 2013

- VLC media player

Games

Computer

@} Word 2013
Control Panel

1& Snipping Tool
Devices and Printers
TeamViewer 13
Detault Programs
. Paimt =
% / o Help and Support

Sticky Notes

E Kindle
' Monlla Firefox

-
;‘b Windows Easy Transfer Reports

Q Inkscape

Click Start button

n'_ PowerPoint 2013

’e Internet Explorer 3

G Google Chrome ’

Calculator

i

E| Excel 013 »

VLC medsa player »

-
At
m Word 2013 »
\& Snipping Tool
TeamViewer13

Devices and Printers
Defaut Programs \
o / Pant I3

Help and Support

Computer

Control Panel

O]

Stacky Notes »

K o ,
.' Mozilla Firefox ’

-
~\. Windaws Easy Transfes Reports

0 Inkscape
.

Go to All programs
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BN Adobe Reader XI
© Default Programs
@ Desktop Gadget Gallery
@ Google Chrome
0 Inkscape
@ Intemet Explorer
@ Mozills Firefox
[ TeamViewer 13
&4 Windows DVD Maker
5l Windows Fax and Scan
€ Windows Media Center
0 Windows Media Player
& Windows Update
<A XPS Viewer

L Accessones

4. Amazon

v Classic PDF Editor

4. Dropbex

) ESET

File Viewer Plus

L Games

I Ginger

L Grammary

4 Greenshot

b LEd

L Maintenance

I MathType6

. Microsoft Offic

L. Plagiarisen ChecWir X
| Reimage Repair

J. RTF Repair kit

Computer Concepts

Documents

Pictures

Music

Games

Computer

Control Paned

s and Pra

Defauh Pr

Help and Su

Go to Microsoft Office 2013

Go to file

@lH O i = Document! - Word T B - O X
HOME INSERT DESIGM PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW Sagn iny

a.l m— - - € = F

) 1, | [Calir Bady) | A ] ASBBCEDC| AsBBCeDe A3BhC(
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Select new

Pocument] - Ward ? = 0 X
@ Signir

New

Mew

Open

Print
Share
Blank document Blog post
SO
Select blank document
Document] - Ward T = 0O X
Sign iny

New

Mew
Open
Save

Save s

Print Y

Blank dogument
Arcount Blank docurment Blog past

f._]ptl-:_mﬁ

82

) . tutorialspoint

EIMPLYEAEBEYLEARMING



Computer Concepts

Editing Text

e Modifying existing text in an old document or entering new text in an existing
document is known as editing of the text.
e Editing text can be done by three options: “Find”, “Replace”, “Select”
1. Find = To find a word in a document.
2. Replace = To replace existing word with a new word.
3. Select © To select a word or sentence.
Select Eiiiting
@ H (4 Docurment] - Word T B -|O x
HOME IMSERT DESIGM  PAGE LANOUT REFEREMCES  MAILINGS REVIEW  VIEW Sign iny
= g LG &
) gy |[iod) o0 | A AR [0 g T, asBbceDe| AsBbcepe AaBbC( | M
Paj'.l‘: ¢ B I U -ak X ¥ A-¥- ﬂ- T Py . :l 1 o« T Mormal |~ TMo Spac.. Heading 1 |= Ed'l_"g
Chpboard e Fant L] Faragraph [ Styles [ Lal
LI - - - s 0 & 5 & | 4 4 & B & " TN Y T i B . ' Edl'."'.]

PAGE1OF1 owoRrDs [|#

EMGLISH (LANITED STATES)

—————+ 0
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Select find

[ = ¢ - Document] - Word 7 @ L O X
HOME INSERT DESIGH PAGE LayouT REFEREMCES MAILINGS REVIEW VIEW Hgn in

e o - - 5

Calibri [Bady) -|11 <A A Ra- B S-SR | AaBbCcDr | haBbCobd AaBhil: A
Paste B I UVU-amx. x' A-F-pA- E=== =E- .E],_, T Marmal | T Mo Spac Heading 1 | = Edl:n.g
Clipbaard = Font 1F] Paragraph & Styles [F} L 3 ]
N B T B, -i------5-------£---«---[§Find-
a

= -ac Replace

: L; Salect =

d Editing

u

Enter the phrase to be searched
[« ] -0 ifh - Document! - Word T B - O X
HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW Sign iny
- ¥ e A - R Al Iy
Dllg, |(SoRiod ~j11_~JA A [Adx | @iz~ j= - e | @2 T | Jassbced] Assboeo: AaBbC
p,‘," v B I U -axx xX RA-W. A i EREEE= Ee v - T Normal | T No Spac Heading 1 Edvi.mg
Clipboajd 7= Font o Paragraph = Styles = -~
- R ' 1 CRORUR. vy <3 ) . 4. v+ 8 '
Nayigation M
. L - 2
HEADINGS PAGES RESULTS 3

Text, comments, pictures... Woed can find
just about anything in your document,

Use the search box for text or the magnifying
glass for everything else.

PAGE 1 OF 1

ENGLISH [

What is computer network?

h computer network is a set or connection of two or more computer systems to transfer the dat:
sharing resources to one another. Connected computers can share resources, like access to the |
printers, file servers, and others. A network is a multipurpose connection, which allows a single
computer to do more. Basically computer networks are built with a combination of hardware ane
software,

in other words we can say a computer network is a group of computer systems and other compu
hardware devices that are linked together through communication channels to facilitate commu
and resource-sharing among a wide range of users. Networks are commonly categorized based ¢
characteristics.

Q2 List different types of network?

Ans2 There are manv tvoes of networks. Includine:
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Select Replace
BEHS ORQAF VB3 s Doc1 - Microsoft Word ? H - O X
HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW GINGER ACROBF
== ¥ Calibri (Body) -l1o- 3= A-‘ # ©
Past BB T U aex x|l 51;) Editing] Gi
aste .. es inger
S A-W-A-ma- AR g .
Clipboard Font 7] Paragraph fa | Styles = Ginger Tools ~
._g- B I I I - - #Fing - 5 6 - .
v
B 3ac fgplace
. I3 Select -
Editing

PAGE1OF1 0 WORDS

E:

Replace (Ctrl+H)

Search for text you'd like to change,
and replace it with something else.

Replace one name to another name
BES O:- A - O X
HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW  VIEW GINGER ACROBAT Sig »
n, Y - Ji=-i=-%. | &= 5
; = T S e AsBbfcDd AaBbCcDd #h
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Paste L. Editing  Ginger
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Clipboard = Font [ Paragraph ] Styles Ginger Toaols ~
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Ram played cricket

Find Replace

Find what:
Options:

Ram

Search Down

Replace with:  MNaveen

More ==
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BEEHS O- Document1 - Microsoft Word ? ®m - 0O X
HOME INSERT  DESIGN PAGE LAYOUT  REFERENCES MAILINGS  REVIEW  VIEW  GINGER  ACROBAT  Sig|»
== X | Calibri (Body) “(11 - 3= b #H ©
Y - AaBbCcDd  AaBbCcDd ;
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Clipboard = Font [ Paragraph m Styles [ Ginger Tools ~
._..g‘.. .1 . | .2 S 3 .4 | .5 . f 6 - - - AT
Ram played cricket
- Find and Replace ?
. Find Replace GoTo
. Find what: Ram v ‘
_ Options: Search Down
: Replace with: |MNaveen w ‘
- More > ﬂepﬁce Replace All Eind Next Cancel
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[

Click to Replace

Ram is replaced by Naveen
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Pages | Table | Pictures Online Shapes ... | Appsfor | Online | Links | Comment . ext . 7 Symbaols
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Naveen played cricket
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Click to Select

B EHS 0@ M=~ - Doe1 - Microsoft Word 7 ® — 0O X
HOME INSERT DESIGN PAGE LAYOUT REFEREMNCES MAILINGS REVIEW VIEW GINGER ACROB) »
= X Calibri (Body) MU= SRR —F = As & ©
By B I U-skex, X H =E=Z=E E- ~ . _
Paste i N S| Styles Editing | Ginger
- ¥ A-F-A-pa- AA | D-H 8 . >
Clipboard = Font [ Paragraph | Styles & [inger Tools ~
l-Z'"""1'"""2"""'3"""HFind'"'5"""'6"'5'
a..Repkce
- Y
. [3 Sefett~
Editing
- Select
Select text or objects in your
document,
The personal computer has come a long way in a short period . bl £ acement is
. . - his is particularly helpful for
"~ due to the ongoing progress in operating systems. The evolt selecting text with certain made PCs
- easier to use and understand, more flexible and more relia formatting or objects that are 1e primary
_ operating system used on personal computers and network ¢"nd et ; the basic
- feature of each.
™~
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Text Selection

e Document is built up by typing one character at a time. While editing and
formatting, words, lines, paragraphs, or sometimes the whole document can be
selected.

e Once a part of text in a document is selected, changes can be made to that text.

e The selected text can be moved, copied and changed to italic, bold or underline.

e Font and color of the text can also be changed.

e Both mouse and keyboard can be used to select the text.

¢ Using mouse, text can be selected by either double-clicking or by clicking and
dragging.

e Using keyboard, text can be selected by pressing the shift key + arrow keys.

e To select the entire page, use shortcut, “Ctrl + A”.
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Selected text

n] H - O & = Document! - Wored 7 8B - 0 X
HOME  INSERT  DESIGN | PAGELAYOUT  REFERENCES  MAIUNGS  REVIEW  VIEW Sign iny

o X o - -~ .

{1 2 - ' b = Pe IR T e L = = [} L A
P |\ LR 0 il b 6500 = bt AaBbCeDc| AsBbCeoc AaBbC( | M

Paste | B I U -aex, x R-|¥-A-|0E E- H-0- 1 Normal | ¥ No Spac... Heading 1 Editing
Clipboard Font r Paragraph m Styles [ A
. [ R | 1 \ 2 ' 3 ' : 5 & PO ZERein -

What is computer ritwork?
A 4
A computer network is a set or connection of two or more computer systems to transfer the data by

sharing res¢ Calibri (Body) ~|11 « A" A" A',, ers can share resources, like access to the Internet,

printers, fil¢ ST bW EG R il JA0 Jurpose connection, which allows a single
computer t U 527 B = 7 =7 S g built with a combination of hardware and
software.

In other words we can say a computer network Is a group of computer systems and other computing
hardware devices that are linked together through communication channels to facilitate communication

and resource-sharing among a wide range of users, Networks are commonly categorized based on their
characteristics.

Q2 List different types of network?

Ans2 There are many types of networks, including:

PAGET1OF1 650F283WORDS [[2 ENGLUSH INDIY)

Cut, Copy and Paste

In this section, we shall learn how to use cut, copy and paste functions in Word.

Cut

e Deleting unnecessary data from a document is called cutting.

e In Microsoft Word, you can cut text from one area of a document and paste that
text anywhere in the document.

e After you cut the text, it gets stored in the clipboard.

e If you want to cut any text or word from a document, it is advisable to highlight
the word first.

e To cut, Right Click->Cut.

e The shortcut key is “Ctrl + X".
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Select the text
[~ T RSB ¢ 5’“( : Document! - Word 7?7 B - 0 X
HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW Sign in
e ¥ e — o
Fa, O0 : v vl A > P |BESiI=.N. &8 4 3 ~
[ o (Comri@oay -[1n -|A" & |Aa- % BEEI=-E- &4 A 9| aagncon] assbceox AaBbCc | M
Paste , B I ~ax x, X' Q- - = : : TNo S Heading1 1= Editing
. d . / R - 7 Calibri (Bedy) {11 - AT AT N A/. 2 Ipec 9 v
Clipboard Font ™ B I UW. A - B . 3= o Sivtes Styles f ~
" SR TRaAlers L 1 ) b 3 "= . . 3 AW -
R « Locel Area fatworks B
" A connection that’s used for groups of computers. This is common in small offices and internet

cafes. This is where everyone can share files basically, and is also known to be a good way to
connect between computers whenever they want to share an Internet connection, or whenever
’ they want to play games with each other.

* Wide Area Networks (WAN):
This is a common type of network nowadays that’s made possible by wireless technology.
Usually, a credential or service from a certain company is needed to enter a connection in this
type of network, but there are others that can be used for free. This is good for internet
connection, The internet is a well-known version of this one,

* Metropolitan Area Networks (MAN):

A more powerful version of the local area network where it can cover up the whole city in terms
of connection. A huge server is usually used for this type of connection.

Right click and select cut
B EH % O - Document1} Word T M - 0 X
HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW Sign in
X I 3w S e 1o o —
Y gy [{Celtd Body) (M AN A B SRS HE AT aaebceod] AsBbcede AaBbC -
p‘_‘" “. B I U-ax. x' [A-%Y- A-EEF== =4 O - TNotmal | TNo Spac., Heading 1 fdltmg
Clipboard & Font 1 Calibri (Body) '%" A AN AJ~ Styles G -
L SSR Y g o Accctccig poy e poBE 1. s ) 5 i 6 . AR
« Local Area Networks (1 AN):
: X Cut [} 47
“ A connection that's us o0, . This is common in small offices and internet

cafes. This is where ev Pty oo ally, and is also known to be a good way to
connect between com = | ¥te Options: to share an internet connection, or whenever
-

they want to play gam 4

< L

«  Wide Area NE(WOI"(S( Adyust List Indents,,,

This is a common type 5 made possible by wireless technology.
Usually, a credential o ; pany is needed to enter a connection in this
X type of network, butt A Eont used for free. This is good for internet
. connection. The interr '  Paragraph o this one.
e Metropolitan Areq et B Define
Synonyms ’
Amore powerful vers [0 Tranglate k where it can cover up the whole city in terms

of connection. A huge & Is type of connection.

Search with Bing

‘g’ Hyperdink.

s New Comment

GUISH ONDIA)
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e Copy option can be used when we need to retype the same text as it reduces time
and effort.

e By using copy option, you can copy the text from one location to another.

e Information stored on the clipboard stays there until new information is either cut
or copied.

e Each time you use cut or copy, you replace the old information on the clipboard
with the information you just cut or copied.

e To copy, Right Click > Copy.

e The shortcut key is “"Ctrl + C".

Select the text
m B - O & Document - Word 7 B - 0 X
HOME = INSERT  DESIGN | PAGELAYOUT  REFERENCES  MAILINGS  REVIEW  VIEW Sign in
¥ o\ e Ay |EBEES . — e | :
~ Calibri (Body) o LR W W R i — - ERR AR -2 48 I | AaBbCcD¢  AaBbCeDx AaBhCe b
1 ga aBbCe -
Paste o B I U -akx,x A--A- E - : TNoSpac.. Heading 1 Edting
. > 7 o - - Calibri (Body) -|11 - A" a" o As SR el .
Clipboard 1 Font ™ B I UW. A - . = _‘_ Styles fa ~
N N 1 ' 2 : T ' 8 ? -
« Local Area (LAN): [N

PAGE 1 OF 1

4 OF 288 WORDS

A connection that’s used for groups of computers. This is common in small offices and internet
cafes. This is where everyone can share files basically, and is also known to be a good way to
connect between computers whenever they want to share an Internet connection, or whenever
they want to play games with each other.

Wide Area Networks (WAN):

This is 3 common type of network nowadays that’s made possible by wireless technology.
Usually, a credential or service from a certain company is needed to enter a connection in this
type of network, but there are others that can be used for free. This is good for internet
connection, The internet is a well-known version of this one,

Metropolitan Area Networks (MAN):

A more powerful version of the local area network where it can cover up the whole city in terms
of connection. A huge server is usually used for this type of connection.

(2 ENGUSH gNDIA)
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Right click and select copy

B H ®- O - Dochment] - Ward ? H - Mm%
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— Calibri Body) ] - 111 - & ¥ Hg-
L Poeie ] . b 1. " ] ! il A FI_ E .. & 7
B F U -4 -i=-iz- sy
#  Local Area Networks (LANg:
X Cut

" Aconnection that's used = - i is common in small offices and internet
: cafes. This is where every £ Copy ¥ s and is also known to be a good way to

connect between compu! [T Paste Options: share an Internet connection, or whenever

they want to play games -

[~

- = ‘Wide Area Mebworks (Wi Reljyst List Indents

This is & commen type of iade possible by wireless technology.

Usually, a credential or s¢ ny ks needed to enter a connection in this

type of network, butther , . wd for free. This is good for internet

connection. The internet - _ his one.
. % FParagraph...

»  Metropolitan Area Netwe |81 Define
. Synonyms ¥
A maore powerful version
of connection. & huge sep “%
- :E-i Sgarch with Bing

rhere it can cover up the whole city in terms

Tranglate ype of connection.

B Hyperlink...

E Ld MNew Comment

PAGE1OF1 4 OF 288 WORDS ENGLISH {INDLA)

e Select your text and then copy it..

e Use mouse to move the cursor to desired position to paste the copied text.
e Click paste to insert the copied text in its new place.

e You can paste clipboard information as often as you like.

e To paste, Right Click-> Paste.

e The shortcut key is “"Ctrl + V”.

91

@ tutorialspoint

EIMPLYEAEBEYLEARMING



Computer Concepts

Select paste
|
m H ©- a.r‘ = Documaent] - Ward T E - O X
HOME INSERT DESIGN PAGE LAYOLUT REFEREMCES MAILINGS REVIEW VIEW Sign i
Calibi{Body) |11 ~|A & Aa- B iz -i=-Yiz- B OEL Y| wapncene] asmbcex AaBbC #
Pate .| B F U-au, w B-%-4A-E 15+ &- - || TNormal | THoSpac.. Hesding1 || Edtng
Clipboard & Fomt & Faragraph M Styles r} -
Paste {Chrl= V) [ ! [ F AT ' 3 N 4 i L] & 7
Pick a paste aphien, such 25 keeping
formiatting or pasting only content.
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-— 0%

Font and Size selection

To change size of font in the file or document, first select the text you want to
change.

If you want to select all the text from document, click “Ctrl + A"
From home menu, click font size option.

e You can also change style of the font using “"Font Style” feature.

&
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B H S OG-

FILE HOME NS

e
Calibri (Body)

Paf.e ¢ B I N

Chpboard =

PAGE1OFT OwORDs [P

Dooument] = Word
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Fi|Calibri (Body) =] 11
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Sign in
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& bow T

Alignment of Text

e You can align text to Left, Right, Center and Justify.

e By default, the content always appears to the left side of document.

¢ Alignment can be done by using mouse or keyboard shortcuts.

e For center alignment, click to “center align” icon or use shortcut key “Ctrl + E".

e For right alignment, click to “right align” icon or use shortcut key “Ctrl + R".

e For left alignment, click to “left align” icon or use shortcut key “Ctrl + L”

e If you click on “justify” it will align with respect to both left and right margins. The
shortcut key used here is “Ctrl + J".
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Center alignment

B HS O:- Document1 - Microsoft Word 7 B - O X

HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW GINGER ACROBAT »
== X ||Calibri (Body) '}11 - #

B - AaBbCcDd AaBbCcDd AaBbC( -

Paste A - e A - Az;- A'\A' 1Normal | TNoSpac.. Heading1 || Editing Ginger
Clipboard = Font o Paragraph & Styles o Ginger Tools A
LIS o ot vl e 220 k] Center (Ctr+E) R IS .

Center your content on the page.

Center alignment gives documents
a formal appearance and is often
used for cover pages, quotes, and
sometimes headings.

The personal computer has come a long way in a short period of time, and much of the advancement is
due to the ongoing progress in operating systems. The evolution of operating systems had made PCs
- easier to use and understand, more flexible and more reliable. This topic is a study of the primary
operating system used on personal computers and network servers today, and describing the basic
feature of each.

PAGE10OF1 710F71WORDS [4
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Right alighment
B EHS O:- Document1 - Microsoft Word 7?7 ® - 0O X
HOME | INSERT ~DESIGN  PAGELAYOUT  REFERENCES MAILUNGS REVIEW VIEW GINGER  ACROBAT |»
<= ¥ |Calibri (Body) -1 - #® @
B - AaBbCcDd  AaBbCcDd ;
LBy B I U-aex X A 2BbCcDA) AsBbccDd. AaBbCx -

Paste % 1 v Editing|  Ginger
N | A-W- A-Aa- A A T Normal | ¥ No Spac.. Heading 1 e
Clipboard = Font o Paragraph 5 Styles - Ginger Tools A
&
Lot .tAj o feeid i o 8 « 22 ey Align Righ‘ (Ctrl+R) PRERTE. ST SN TR . SR S b A

| Align your content with the right
margin.

Right alignment is used for small
sections of content, such as text in
your header or footer.

The personal computer has come a long way in a short period of time, and much of the advancement is

i due to the ongoing progress in operating systems. The evolution of operating systems had made PCs
- easier to use and understand, more flexible and more reliable. This topic is a study of the primary
) operating system used on personal computers and network servers today, and describing the basic
feature of each.
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Left alignment
H - 0 - Document1 - Microsoft Word ? B - O X
HOME INSERT DESIGN PRGE LAYOUT REFEREMCES MAILINGS REVIEW VIEW GINGER ACROBAT |»
. P N I e —
"X Calibri (Body) [11 g - & 3= # ©

— AaBbCcDd AaBbCeDd AaBhCo

pi"_':,Bfg'absxgxz Ly S|I= == =
A5 . T Normal = T No Spac... Heading 1
~ &,a_'?vé.ga. A A A&%v_v Al @ P q
Clipboard = Font n Paragraph ] Styles i

L7
Lissgy b b e - 20 plign Left (Ctrl+L) B
- . Align your content with the left

margin.

Left alignment is commonly used
for body text and makes the
document easier to read.

The personal computer has come a long way in a short period of time, and much of the advancement is
due to the ongoing progress in operating systems. The evolution of operating systems had made PCs
easier to use and understand, more flexible and more reliable. This topic is a study of the primary
operating system used on personal computers and network servers today, and describing the basic
feature of each.

PAGE1OF1 710F71 WORDS [J#

EIMPLYEAEBEYLEARMING

@ tutorialspoint

Editing Ginger

Ginger Tools

R

Eal

96




Computer Concepts

Justify alignment

B EH S O - Dpcument1 - Microsoft Word 7?7 @B - 0O X
HOME INSERT DESIGN PAGE LAYOQT REFERENCES MAILINGS REVIEW VIEW GINGER ACROBAT »

== X |Calibri (Body) 11 c||iZei= L ==
[l el ‘f’{} N AaBbCcDd AaBbCcDd AaBb (i #
S =) | B 2 @ = = = = =" s 5o
Paste s 2 - 2 Editin Ginger
i * A-W-A-ma- KX O-F-| 8L I Normal No Spac... Heading 1 & 9 9
Clipboard = Font o Paragraph H Styles [ Ginger Tools' A
N GEEEEEES SR 2 - s L Justify (Ctrl+)) 5 cr e 06 A
=5 Distribute your text evenly between
the margins.

Justified text gives your document
clean, crisp edges so it looks more
polished.

The personal computer has come a long way in a short period of time, and much of the advancement is
due to the ongoing progress in operating systems. The evolution of operating systems had made PCs
easier to use and understand, more flexible and more reliable. This topic is a study of the primary
operating system used on personal computers and network servers today, and describing the basic

feature of each.
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Formatting Text

® A font refers to set of characteristics that characters of Word support.

® The process of formatting a document includes controlling the appearance of text

and layout of text on page.

® Character formatting includes settings that control attributes of individual text

character such as Fonts, Font Size And Type Style.
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Text formatting icons

m H &- 4 E‘!] Docurment = Word T A = O X
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Paragraph Indenting

e Indentation improves the readability of document.
e Options for indentation includes Left, Right, Center And Justify.

Paragraph indentation

B H S O8> Document] - Word 27 ®m -0 X
HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS RE\IEW VIEW Sign in|

X T » i e T T e aar Teal o »n

Calibi(Body) ~[11 ~|A" A" Ad~ % i=-i=- - &8 2l 1 BbCcDe AaBbCeDe AaBhCy E

Pate o B I U-axx A-¥-A- B 5z O-2- 'No‘gd! NoSpac.. Heading 1 Ediog

Chpboard = Font 10 Paragraph e Styles -. ~
. [ O Y SRR \ 1 ' 2 ' 3 \ ‘ Nosmal | 5 ' 3 rE S S

+ Local Area Networks (LAN):

A connection that’s used for groups of computers. This is common in small
offices and internet cafes. This is where everyone can share files basically,
and is also known to be a good way to connect between computers whenever
they want to share an internet connection, or whenever they want to play
games with each other.

« Wide Area Networks (WAN):

This is a common type of network nowadays that’s made possible by
wireless technology. Usually, a credential or service from a certain company
is needed to enter a connection in this type of network, but there are others
that can be used for free. This is good for internet connection. The intemet is
a well-known version of this one.

« Metropolitan Area Networks (MAN):

PAGE 1 OF 2 ORDS  [[¥  ENGLSH (INDWA)
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Indentation icon on tool bar
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« Local Area Networks (LAN):

A connection that’s used for groups of computers. This is common in small
offices and internet cafes. This is where everyone can share files basically,
and is also known to be a good way to connect between computers whenever
they want to share an internet connection. or whenever they want to play
games with each other.

« Wide Area Networks (WAN):

This is a common type of network nowadays that’s made possible by
wireless technology. Usually, a credential or service from a certain company
is needed to enter a connection in this type of network, but there are others
that can be used for free. This is good for internet connection. The internet is
a well-known version of this one.

« Metropolitan Area Networks (MAN):

PAGE1OF2 239WORDS [[® ENGUSH INDIA)

Bullets and Numbering

e Bullets and numbering are used to list important points and messages.

e When a document is in the form of long paragraphs, reader may not be able to
quickly notice important points or message. Bullets and numbering emphasize lists
of things.

e To list points or topics in a document, bullets are used.

e Numbered list works well for directions or other points.

e While typing a document, details should be given step-by-step for easy
understanding. MS Word'’s feature “"Bullets and Numbering” fulfils this purpose.

e You can either use the word defaults for bullets and numbers or can define your

own list.
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Select bullets
m B - O 95 ¥ cument] - Woed 7 B - 0 X
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« Local Area Networks (LA} /< ® numberedist
Chck the arrow for more numbering
A connection that’s used fc fermst: is common in small
offices and internet cafes. This is where everyone can share files basically,
and is also known to be a good way to connect between computers whenever
they want to share an internet connection, or whenever they want to play
games with each other.

« Wide Area Networks (WAN):

This is a common type of network nowadays that’s made possible by
wireless technology. Usually. a credential or service from a certain company
is needed to enter a connection in this type of network, but there are others
that can be used for free. This is good for internet connection. The internet is
a well-known version of this one.

« Metropolitan Area Networks (MAN):

[ ENGLSH INDIA)

Choose from the list of bullet types
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Changing Case

Computer Concepts

We usually type content of documents in different forms such as Lower case, Upper case,

Sentence case, etc.
[ ]
Lower Case > Entire selected text will

Upper Case - Entire selected text will

Select change case
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Local Are ©hange the selected text to
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offices an 0 Tell me more

Sentence Case - First character of the sentence is capitalized.

change to small letters.

change to capital letters.

Title Case - First character of each word begins with a capital letter.

Toggle Case - It changes lowercase to uppercase and vice-versa.
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Word

MAILINGS REVIEW VIEW Sign ir

H
Editing

AaBbCeD  AaBbCcDe AaBbhC

T Normal | T No Spac.. Heading 1

Styles n

computers. This is common in small
e everyone can share files basically,

and is also known to be a good way to connect between computers whenever
they want to share an internet connection, or whenever they want to play

games with each other.

Wide Area Networks (WAN):
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[
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This is a common type of network nowadays that's made possible by
wireless technology. Usually, a credential or service from a certain company
is needed to enter a connection in this type of network, but there are others
that can be used for free. This is good for internet connection. The internet is
a well-known version of this one.

Metropolitan Area Networks (MAN):
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Choose the type of case
E H - O J" = Document] - Word T @M - O X
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Capitalize Each Word
« Local Are T
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A connection that's used for groups of computers. This is common in small
offices and internet cafes. This is where everyone can share files basically,
and is also known to be a good way to connect between computers whenever
they want to share an internet connection, or whenever they want to play
games with each other.

+« Wide Area Networks (WAN):

This is a comimon type of network nowadays that’s made possible by
wireless technology. Usually, a credential or service from a certain company
is needed to enter a connection in this type of network, but there are others
that can be used for free. This is good for internet connection. The internet is
a well-known version of this one.

« Metropolitan Area Networks (MAN):
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Table Manipulation

Manipulation of table includes drawing a table, changing cell width and height, alignment
of text in the cell, deletion/insertion of rows and columns, and borders and shading.

Draw Table

Tables can be easily inserted at any point of the document. A table is a simple way to
arrange lengthy lists. You can use tables to format all parts of your documents into rows
and columns. Rows and columns can be added or deleted either at the beginning, end or
in the middle of table. For inserting a table, simply click on “Tables” icon on Insert menu.
Tables can be formatted to any size, and number of rows and columns can be added as
per requirement. Table formatting toolbar contains numerous icons which can be used for
different functions related to tables. Spin arrows in the columns and rows help to select a
row or a column.
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Select table
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Changing cell width and height

¢ When we create a table, all columns may have equal width or may have different
widths depending upon the usage.

e If you want to change column widths, “Ruler” or table properties from the table
menu can be used.

e By using “"Ruler” you may change the row border and size.

Right click and select table properties
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Change the width and row by checking preferred width
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Alignment of Text in a cell

e Select one or more cells in table, and click table layout menu.
e Under Alignment, click Align, and then select corresponding option.
Select the cells
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Select alignment
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Delete/Insertion of Row and Column

For inserting rows and columns into an existing table, position cursor either before or after
the spot where you want to insert.

Right-click mouse button to >Insert/Delete.

Right click and select insert/delete
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Inserting a column to the right

After finishing the table, in case you need to insert a column on the right-hand side of a
particular column in the table, you may use the following steps:

1. Place cursor where you want to insert a column in the table.
2. Right-click on mouse button - Insert column to right.
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Right click and select insert columns to the right
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After finishing the table, in case you want to insert a row in the top of a particular row in
table you may use the following steps:

1. Place cursor where you want to insert a row in the table.
2. Right-click on the mouse button—-> Insert row above.

&
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Right click and select insert rows above
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Insert rows below

After finishing the table, in case you want to insert a row in the bottom of a particular row

in the table, you may use the following steps:

1.
2. Right-click mouse button > Insert row below.

&

Place cursor where you want to insert a row in the table.
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Right click and select insert rows below
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Delete Column
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If you want to delete particular columns in a table, use the following steps:

1. Select the column which you want to delete.
2. Right-click mouse button-> delete cells > delete column.
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Right click and select delete cells
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T —

If you want to delete particular rows in a table, use the following steps:

1. Select the row which you want to delete.
2. Right-click Mouse Button-> Delete Cells > Delete Row.
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Right click and select delete cells
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Select delete entire row
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Border and Shading

e Borders and shading is used to decorate a text.

e Select the text for which you need to apply borders or shading.

e Click home menu.

e Move to borders and shading icon.

¢ From the open window, select border style, width you want and click ok button.
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Select borders
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Select borders and shading
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Select the desired settings
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Summary

This topic provides us with a clear idea about components of word processing basics,

opening and closing the documents, text creation and manipulation, formatting the text,
table manipulation, etc.
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4. Computer Concepts — Spread Sheet

Microsoft Excel is a spreadsheet application which is used to create and manage lists of
information. Excel allows to enter, edit, manage and analyze large amount of data in a
worksheet and create colorful charts and graphs. It uses formulae to calculate and analyze
data. It helps to combine a series of commands using “Macros”, thus saving time. At
higher levels, you can use it as a complete development tool catering to many complex
requirements.

Elements of Electronic Spread Sheet

In this section, we shall learn the topics explaining the entire concepts related to spread
sheet in detail, i.e., Elements of an electronic spread sheet, manipulation of cells, functions
and charts.

Opening a Spread Sheet

To open a spreadsheet, we have to click on “Start” button and go to “All Programs” and
click on “Excel”.

_h__.ﬁ VLC media player

@} Word 2013
% Snipping Tool
E.] TeamViewer 13
>
- / Paint
Sticky Notes

E Kindie

' Mozilla Firefox

-~
~\ Windows Easy Transfer Reports

Q Inkscape

Click Start button
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Opening an existing worksheet

To open an existing document, go to file menu, File > Open > Recent workbooks.

Go to file
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== Desktop
Print m:=| Book3
+ Add a Place a: Desktop
Share
u‘g; Book2
Export == Desktop
m:= Book10
Ele u':' = Desktop
n‘;; Book19
Account =Z| Desktop
. m:= Book20
Opt =
ptions u-": Desktop
n‘f‘j Book23
== Desktop
u"'j; Book22
==| Desktop
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Renaming a work sheet

Every sheet is given a name by default as sheet 1, sheet 2, etc. It is necessary to customize
the name according to user reference. To change this name, right click on sheet tab that
is to be renamed. Name in the sheet tab gets highlighted and can be edited.

EEH S E Book3 - Microsoft Excel 7 @ — 0O X
HOME | INSERT  PAGE LAYOUT FORMULAS  DATA  REVIEW  VIEW  ACROBAT Sign in
.. = =, . al ars - - = - . Ay
| X Calibri m o I == =¥ General [E} conditional Formatting = | %= Insert E ;
- ===~ % -9% » [[#FormatasTable~ = Delete - (8]~ #b-

Paste - . My . o - .
a_se & B I U 3 & 2 3= $r- T A |‘,‘.(9IIS[yIPs' =3 Format = & -
Clipboard = Font = Alignment % Mumber & Styles Cells Editing Lo
Al - i fr w

A B C D E F G H J K L -
[ ]
2
3
4
5
[
7
8
9
10 Insert.
11 .
12 l:-){ Delete
13 Ee"-eme[}
14 Mowve or Copy...
15 T View Code
L £ protect Sheet

Protect Sheet.
17 Er Cl shee
18 Tab Color ]
13 Hide
20
21 -
5 All Sheets
She Select All Sheet T ,

o

+ 100%

Right Click and Select Rename
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E 5 Book3 - Microsoft Excel ? B - 0O X
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ACROBAT Sign in
o X n == i 31 Formatting I
n 90 Calibri 11 < A A — 2
) gy - === - | it
1
aje - B I U- - A - : mat &~
Clipboard & Font . Alignment Murmber . Styles Cells Editing a
a1 o fe | sino W
A B C D E F G H | J K =
1 |5.n0 |Name Educational qualifications
2 1|Ravi B.E
3 2|Banu M.A
4 3| Sunil MCA
5
6
T
8
9

Edit here

Organization of worksheet

Spreadsheet is made up of number of books. Each book contains number of columns and
rows. Rows and columns are made of many cells. The cell pointer in cell Al is as shown
the below:
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Cell Pointer

[ Y o : Book7 - Microsoft Excel T E - O X
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ACROBAT Sign in

il

Iﬁl
i
1
g [l

Calibri - A A

§ 0

General ~| [fConditional Formatting = &= Insert - | % - 47~
T d-

€ - 9% + [EPFormatasTable~ B Delete -

Paste

" K

B I U- - A O~ w0 [ Cell Styles - [®]Format= | & -

Clipboard = Font [} Alignment & Mumber & Styles Cells Editing al

Al 1| ¢ I w

0O =4 W B W -

L A I LT
S S| e o N w2 o

Sheet1 ()] .y ;
W @ M -——3F—+ 100%

Cell Address

Cell is a small unit in the worksheet which is used to store data. A cell is refered by its
column and row number.

Example

Cell B followed by row 6 is called as B6. Each cell in worksheet has a unique address. Using
arrow keys in the keyboard, we can move from one cell to another cell.
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H 9-2-F
HOME = [NSERT

BookT - Microsoft Excel

PAGE LAYOUT FORMULAS DATA REVIEW VIEW ACROBAT

General [} Conditional Formatting =

E- 3
0 20
00 +0

Calibri -n | A A

."_}.A-

= X
Et ~ 95 » | EPFormat as Table ~

4 Cell Styles -
Styles

Pase &
aste . B I p-

Clipboard Fant Alignment G| Mumber

B6 - | i S| BB

|

- BRI SET R TRy N

Il i i =)
(T R R T R T SR =]

Sheet1

® Ac

7 E - 0O X

Sign in
Ensert - X - iv-
G- -

=i Format = & -

3 Delete ~

Cells [Editing tal

+ 100%

Title bar

Title bar displays the name of excel worksheet. It appears at the top of all window

programs. By default, excel opens with the name Book 1.

&
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Tittle bar
c i 5 Book3 T Microsoft Excel T - O X
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ACROBAT Sign in
T Calibri T x| =M -’ General - | [ Conditional Formatting = | &= Insert =~ X - 47~
LBy - === [g- $-% * [EPFomatasTable - F<Delete = [4] -
Pa_ﬂe » BT U-HB- & -& &= 3= - vy (3 Cell Styles - %] Format = -
Clipboard & Font i Alignment n | Mumber Styles Cells Editing i
Al .| fr | s.no v
A I B C D E F G H 1 ) K|~
1 |S.no Name Educational qualifications
2 1|Ravi B.E
3 2|Banu M.A
4 3| Sunil MCA
5
B
7
B
9
10
11
12
13
14
15
16
17
18
19
20
21 .
Sheet1 (1-) R [

Menu bar

Menu bar is located directly below the title bar. It displays a list of menus that can be used
to give commands to excel. Clicking on a menu bar displays a drop down menu of icons.
You can move across the menu bar and scroll down menus with your mouse by highlighting
one of the menu items and using arrow keys on your keyboard.

e File - It has options such as: save, save as, open a new document, print, etc.

¢ Home - It has icons to change font size, style, alignment, borders, etc.

o Insert - It has icons to insert table, chart, pictures, screenshot, header, footer,
etc.

e Page Layout - It has icons to set margins, orientation, size, breaks, indent, etc.

¢ Formulas - It has insert function, auto sum, date and time, lookup and reference,
etc.

o Data - It has icons to import data from web, from access, refresh all, from other
sources, etc.

¢ Review - It has icons for spelling and grammar check, thesaurus, word count, etc.

e View - It has icons to zoom, print layout, switch windows, split, etc.
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VIEW

ACROBAT

B EH 5 = l Book3 - Microsoft Excel
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW

— .
Calibri B PTR Y EF ||General

» - =

B I U~ - "ﬁ‘._..,g..

Alignment =

$ - 9% » [EFormatasTable~

P,
aste o 2
- o0 =0

LZ# Cell Styles -

Clipboard Font = Nuember & Styles

Al | i > fe | sno

A B C D E F G
|S_ru:r Name Educational qualifications
1|Ravi B.E
2|Banu M.A
3| Sunil MCA

Sheet1 @ i (4

I, Conditional Formatting -

T E - O X
Sign in

- Ar- -

e

= Insert ~

¥* Delete ~

o €l M

- Format =

Cells Editing ~

Formula bar

Cell content can be edited directly in the cells or in formula bar. If cell contains a formula,
it will be displayed here. If there is no formula, then content of the cell is displayed.
Formula bar allows you to view, enter and delete data in a selected cell.
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H ©- :
HOME | INSERT

PAGE LA

= X
.

Paste

Calibri
B I U-
Clipboard

B4 M Je

[~ AR LT S TR N

R R e Y]
= O W0 N3 A W 2O

Sheet1 @

OUT  FORMULAS

[F1 Alignment

A 4
=SUM(B2:B3)

D E

BookT - Microsoft Excel TE - O X%
DATA

B

REVIEW VIEW ACROBAT Sign in
Eonsert v | X v AT~

B Delete - | [#] - i~

EI Format ~ y -

General - [;'E,Condi‘[ional Formatting =
$ - % » [EPFormatas Table -
€0 0 [ Cell Styles -

{00 30

MNumber & Styles Cells Editing ~

i M ——+ 100%

Mathematical formula appears in the formula bar when a cell that includes a formula is
selected in the worksheet. In the below example, formula to calculate average grades is
in cell E5. When E5 is selected, formula appears in the formula bar.

%)

tutorialspoint

EIMPLYEAEBEYLEARMING

125



Computer Concepts

Formula bar

g e - = Book - Excel T M - O %
“ HOME IMEERT PAGE LAYOUT FORMLLAS DATA REWIEW VIEW ADD-1NS TEAM Sign in

LT Calibr =111 = N = Genenal = ’_'::(|.||||!:'.||’$r‘|i||":||r||.|l1||'\-:]' .‘:.m‘ll'u.r:l = E . ‘:1‘-

5 B~ BT U- AN B~ % - % »  EFFomatas Table~ 5 Delete - [T~ M-

aste = - .

DA == P 3 3 TP Cell Styles = 5 Format - | & -
Clipboard 2 Fant f Alignimedt fol  Mumber Shylés Ciells Editing &
L 3
£5 | & Jr | =Averace(es,cs,Ds) e
A B (= D E F G H I J K L [=

1 Mamea Gradel Grade? Graded .ﬁ'ﬂ!‘fﬂgE‘

2 |aditi %0 96 59 BLGE66T

31 |Babita g a7 45 9366667

4 |Charlie 93 98 96 97.33333

5 |panisha 75 55 &9 72

§ | Gaurav ] T 97 88.33333

7

8

L

READY

Printing a Spread Sheet

Printing is creating a hard copy of any content. A spreadsheet can be printed by selecting
File & Print option. Shortcut to print is “Ctrl + P".
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an - = Backl - Excel T m - O X

HOME INSERT PAGE LANOUT FORMULAS DUATA, RENIEW WIEW ADD-IMNS TEAM Sign in
ey Calibn General - FL Conditsonal Formatting - E“' Insert - E = ":‘F =
. . E - B I = £ -9 » _‘-‘ Format as Tabde ~ L‘-" Delete - T = -
a_'ﬂ‘-r- -~ [ - My - A = & B - b L Cell Shyles = .;__I Fosrnat = &+ -
Chpkoard & Foet fa Alignement Ta HNumBer G Styles Colls Editing -
Al - i Jx || pays w
A B C ] E F G H | ] -

1 |Days Rohan's soore Sanjana's score

2 Sunday 20 20

3 Monday L 46

4 Tuesday a5 a5

5 Wednesday 48 34

& Thursday 30 44

7 Friday 29 a3

B Saturday 46 449

&

10

11

12

13

14

15

16

17

18

19 -

Computer Concepts

Eaok] - Excel

Info

Protect Waorkbook

» Control what types of changes
Frofect people can make to this workbook.
Warkbook -
Inspect Workbook
= Befoae publizhing this file, be saare
Chechk for that i conkains
Share Izzases - Dhoecummserit properties, printer
path, suthor's namse and
Expart absalute path
Conbent that people with
disabalties find difficult to resd
T, Versions
oy Theere are Fio previcus wersions
Manags of this Fike.
Vershons
1 Browser View Options
i
= Pick what sess can see when this
Broweser Wiew etk boak i wieeed an ihe Wek.
Oipticns

Properties -
Size

nle
Tags

Categores

Related Dates
Last Modified
Created

Last Fanted

Related People
SaAbaor

Last Mosdified By

Sherar Al Praperties

O =

Sign iny
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Saving Workbooks

After typing our content in excel worksheet, we must save the worksheet for future use.
Shortcut key to save is “Ctrl + S”. The process of saving consists of following steps:

1. Click File menu.
2. Click Save option from sub menu.
Go to file
|

al € - s Book? - Excel T E - 0O X%
HOME | INSERT  PAGELAYOUT  FORMULAS  DATA  REVIEW  VIEW  ADD-INS  TEAM Sign iny

'n.'.__ & Calibri R E— = :_':'5' General - 'f_;'| Conditbonal Formatting - E:‘:“ neert - E = _fT'

— By~ B F U~ A p E=E=EE-| 5% :__‘:F-:-rmatasTable- i Delete - [3]- -

= ¢ - e A - == - - ] [ Cell Styles - ] Format= & -

Clipboard Fart % Alignment | Mumber @ Styles Cells Editing -

Al w| . .fr Marks LY
A B C D E F G H I J K |

1 lMarl-cs _Scmu Shivani

2 |Science ] o8

3 |Hindi 57 ]

4 |English B9 98

5 |Sanskrit 76 67

& | Social Science 50 i

7 Mathematics T0 1]

8

g

10

1

12

13

14

15

16

17

18

19 -

Sheetl l:+} ] ¥
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Go to save

Boaks - Excel T - [ | k4
Sigr iy
Protect Workbook Properties -
.’ Contiol whst types of changes Care Mat sareed wnk

Profest people can make to this workbook Tith 3 & Gibe
Wiorkbook - e A e
Tags Add a tag

Categanes Add & categ

Inspect Workbook

Related Dates
: Before publishing this file, be swaee

Check for that it containg: Lasz Modified

Essises ~

thea’ s arme ard abialube Created Todey, 37 FM
path

Contert that people with

diabilities find diffecult to read

Las Printed

Related Peaple

. Author .
wWersions Wind...
want Q Y There see no previous versions
5] thas F
V,.:::?T_ el thits Fika: Last Modified By Mot saved yet
Diptions
Shove Al Propertses
ik Browser View Options
T Fick what users can seewhen this
Bramwrsir Wi workbook it viewed on the 'Web.
Dhprticns
Select the location
Bosok? - Excel 7l = 0O =
O Sagn iy
Save As
Mew =
(L1 Computer
Open ﬂ OneDrive b5 P
Recent Folders

Save
- [‘;' Computer Documents
Save A Desktop E} v
Primt + Add a Place CAUzersh adrmin' Resktop’

Share
Beonwse
Expaort

Close

Caurt

Ciptsonsz
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u_| Save As =
1 5
= T = * ThisPC * Locsl Dk (C:) w aarch Local Dick o tgn i
Organize v Mew folder - ﬂ
B, LocalDisk (€] »  Mame ' Diste modified - .
Drivers Dwivers i
Irited Irited 25-Sep-1TRITPM  File folder
MSOCache WSO Cachs
OrelriveTemp OnelriveTemp 2Z-Apr-18909 &M File folder
PerfLogs Perflogs 181 [T :
Program Files Apr-18 §FM File ficdder
Progeam Files
Program Files (228) Ane-10 &
Program Files | . I
ProgramDiats Apr 0 Pl File ficdder
Prageamlata —— w
Lo 4 *
File parne: | BookZ|
Save a4 type | Encel Workbook w
Authar:  Windows Uier Tegs: Addateg
E Seve Thumbnas
~ Hide Folders Tock = | Sawe N | Cancel
F 3
1 v
Select save

Manipulation of Cells

Manipulation of cells is entering and modifying the contents of the cells.

Entering Text, Numbers and Dates
In this topic, we are going to learn how to enter text.
1. Place cursor in the cell where you want to enter text.

2. Type the contents or texts in that cell.
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Place the cursor on the cell

B H %- - Book - Exel T E - 0O X
“ HOsAE INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ADD=INS TEAM '5'"'I"'l iy
<= K| Calibri - - =

2

T -

Bm-|B T U~ |& &

=

- - £ -0 o anlnlalanblr :::." Delete =
Paste

= \ 1= M« AL - = ¥ = b Py ] -__;l:'vrll Styles - ;:I:'_! Farmat =

* General * F__..._:Eundrllunal Formatting - E“lnserl - -
7 -
&

Cliphoasd T Forit [ Alegnamanit W Rumber T Skyles Cells Editing e

s JRRE T W

=TT - (™ I L TE R T

- e W= o |

oo

19

.o Sheetl ® 1 [a] =

Enter text
B d %- ) Book} - Excel T M - O %
“ HOME IMSERT PAGE L&Y OUT FORMULAS DATA REWIEW WVIEW ADD-INE TEAM Sagn iy
X, Calibei w1 = ’ . Hirg r > -
By=- B I U - oA — . - -
F' I & Foemat = | o =
Clipboard & Fort L] Alignment . Humber a Skyles Cells Editing ~
[= - 1 X W fr| Micosoft R
A B _F (#] E F G H I i K L |-
1
2
]
4 A S
5 I lMll:rclsclﬂ_
&
T
a
9
]
1
12
13
14
13
16
17
8
9 -
Sheot1 *) i [ 3
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Num Lock (to “on” or “off” Number keypad) can be used to make data entry easy. To enter
numeric values in the spreadsheet, follow the below steps:

Open a new worksheet.

A W N =

Enter numeric data
BHH % z Eoak3
HOBAE IMSERT

PAGE LANOUT FORMULAS

Sl M |Calibn -1 - . EF | |[General
By~ B I U~ A & H-|%-%
Pl o - hep- EE - | WH
Clipbpard Fanlk ] Algriment Husmber
Ad - Je || s2a
A ] C D E F

1 ¥ ame

) 264 ¥

3 396 @

4 5\24.!

5 S7T8 %

6 265 {

7 123 }

B

9

10

1

12

13

14

15

16
17

18
19
Showt]

Enter the number you would like to add.
Fill the complete numeric data in different cells.

Press Esc when you have completed entering your data.

- Excel T M - O X
[hATA REVIEW VIEW ADD-INS TEAM Sign inf
Fo Conditional Formatting = | E=lnget = | 2 = 57+
¥ _-' Foarnat as Table - "‘ Delete = | [T]- i~
o Cell Styles~ I_ Farmat = -
Stybes Cells Editing L
e
G H I J K L |~

Dates

BB @ M -——

1005%

Returns the sequential serial number that represents a particular date. Cell format remains
normal before function gets entered in the cell. Result is formatted as a date, once the

function gets executed.

Syntax

DATE (year, month, date)

Example

%)

tutorialspoint

EIMPLYEAEBEYLEARMING

132



Computer Concepts

=DATE (2018,4,18)

Output
18/4/2018
Select cell
oe p- . Bookd - Excel 7 B - 0O %
HOME INSERT PAGE Lay'OUT FORMUILAS DAl REVIEWY VIEWY AOD-1MS TEAM Sign iy
.n.:. ¥ Calibri o LI = = General - Ff.': Condrtional Formatting = i'" Insert = | % - gv-
P - B I U - noa .' @ $ = 9 7 ..-.‘. Fanmat as Table = I"’ Drelete = T - k-
aste - s
= ~ - e A - = ¥ e = o Cell Shyles ~ & Format =
Clipboard = Faril [F] Alignaenk = Number '. Shyles Cells Editing S
Al *| 3 Je W
A B c D E F ] H ] K L |=
il
2
3
4
5
&
]
g
12
13
14
15
16
17
18
19 =
Sheetl ) HEE ]

Creating Text, Number and Date Series

Here, we will look into creating text, number and data series:

Creating Text Series

e Select the cell that contains starting text.
e Then drag fill handle (+) over the cell where you want to fill text.
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I I s Bookd - Excel T B - O X
FILE #OME IMSERT PAGE LANTUT FORMULAS DaTA REVIEWW WIEW ADD-IMNS TEAM 5"9" iy

ey X Calibri ~[11 =

= = Date ~| | B Conditional Formatting = | B=nsent =~ | 2 = 27~
Ed- % - 9% »  [5¥Formates Table-

w2

W 27 Cell Styles -

Paste

)
. 4 = -"lp-.ﬂ'v

Cliphoard 1 Fornt

A B FU- &N ==
=

% Number [ Styles Cedls Editing L

Al - i A

0| e

b |k |k |
WN_.DlI:Im'HICﬂU‘th-l

| b |k | | |
(= - T T

1 . Sheet]

Drag the pointer

B 5 - 2 Book3 - Excel 7 B - O %
HOME | INSERT  PAGELAYOUT  FORMULAS  DATA  REVIEW  VIEW  ADD-INS  TEAM Sign in)
e ¥ || catibei -In -] =

Date - ECundﬂlonalFumming' E‘“ Insert ~ > - ?T u
T -l B Iruwu- A & = = | % -~ % » | [Frormatas Table~ i Detete - | [# - -
aste - =

. » H- O&-4A- == - -3 =3 U2 Cedl Styles -

=
i
=
=l

=3 Format ~ | & -
Clipboard 1] Font L] Alignment L] Humber LF) Styles Cells Editing ~

Al - 1 | > Jell A ~

W00 W (=S P LA R
i
%

Sheetl @ HET| "

rfilE drag
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B A $-
el

Paste

Chipboard [

Al -

I L N L

2|z (3 2[3 2 = [RIEEEEEEEEERE

HORE

INSERT

Calibri =11

I u- A
- - A -

Fant

PAGE LAYOUT

-

#.

EE &

r]

Je

Sheet1 )

READY

Aligrimerit

A

Creating Number Series

e Open a new excel sheet.
e Select the cell that contains starting number.
e Then drag fill handle (+) over the cell where you want to fill number.
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Date

A
L A

Humdber
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- = Eoakd - Excel 7 m
HOIME INSERT PAGE LAYOUT FORMULAS DATA REVIEW WIEW ADD-INS TEAM Segr in
Calibr =11 -

- B r u- N8 8 ==

General - || P Conditional Farmatting = | B=lnset = | & = 7=
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Aligriment = Humber ] Shyles Ceillis Editing -
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B
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SE R W NS

18

Drag the pointer

HUE INSERT PAGE LAYOILIT FORMULAS LIATA REVIEW VIEW ADD-INS TEAM Sgnin

g e %- ] Bookd - Excel 7T M - O X
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g H - :

FILE HOME INSERT

X Calibri -1

S - -_.1-&_.-

Clipboarg = Farit
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| | ™
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B s W e W RS =
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PAGE LAYOUT

Ufs- |8 1 u- & o
Paste =

Sheetl *

F]

Jx

a I

o

o

-

Aligament

Iy 9

FORMULAS

Bookd - Excel T H - O ¥
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Select cells

@i - = = Boakd - Excel T B - O x
HOME | BNSERT  PAGELAYOUT  FORMULAS  DATA  REVIEW  VIEW  ADD-INS  TEAM Sign in
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&
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Number series

o
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Creating Dates Series

&

Returns the sequential serial number that represents a particular date.
Select the cell that contains starting date.
Then drag fill handle (+) over the cell where you want to fill date.
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Select the cell
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Date series
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Editing Worksheet Data

Modifying or adding text or using cut, copy, paste operations to an existing document is
known as editing.

To edit data in a worksheet, first open the worksheet by clicking on File 2 Open.
Next, move cursor to the cell, which you want to edit.

Note that content of the cell is displayed in formula bar as well.

As you perform any operation, it is visible in the formula bar.

Deleting unnecessary data from the cell is called cutting.

In Microsoft Excel, you can cut text from one area of a worksheet and save or
paste that text anywhere.

When you cut the text, it is stored on clipboard.

If you want to cut any text or content from worksheet, first select the text or
content which you want to cut.

To cut, Right Click - Cut.

The shortcut key is “Ctrl + X".
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Select the cells
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Right click and select cut

g Jd - = Book] - Excel T B - 0O X
HOME INSERT PAGE LAYTUT FORMULAS ChaTa, REVIEW WVIEW ADD-IMS TEAN Sagn inf
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Copy

Instead of retyping the same text, Copy function is used which reduces time and effort.
By using copy option, you can copy the text from one location to another. Information
stored on clipboard stays there until new information is either cut or copied. When you
execute cut or copy, you replace old information on the clipboard with whatever you have
just cut or copied.

e To copy the content, Right Click > Copy.
e Shortcut key is “Ctrl + C".
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Select the cells
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e Select your text to highlight it.
e First copy the text.

Computer Concepts

e Use mouse to move the cursor to desired position to paste the copied text.

e Click paste to insert the copied text in its new place.
e You can paste clipboard information as often as you like.

e To paste, Right Click > Paste.
e Shortcut key is “Ctrl + V”.

Select the cells
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Right click and select copy
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Select paste
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Inserting and Deleting Rows, and Column

e To insert and delete rows and columns in an existing table, position the cursor

either before/after/above the spot where you want the insertion/deletion to
be.

e Right Click > Insert/Delete.
Insert column to the left

After finishing our table, in case we want to insert a column on the left hand side of a
particular column. We may use the following steps.

1. Place the cursor where you want to insert a column in the table.
2. Right click > Insert column to left.

Select a cell
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Right click and select insert
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Column inserted to the left
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|

Insert column to the right

After finishing our table, in case, we want to insert a
particular column, follow below steps:

1.
2.

Place the cursor where you want to insert a co
Right click > Insert column to right.

&
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Select a cell
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Select table column to the right option
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Rows above

e After finishing the table, in case we want to insert a row on top of a particular row,
follow below steps:
1. Place cursor where you want to insert a row into the table.
2. Right click > Insert row above.

Delete Rows
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If you want to delete particular rows in a table, use the following steps:

1. Select cells or rows you want to delete.
2. Right click > Delete > Table Rows.

Delete column
If you want to delete a particular column in a table, use the following steps:

1. Select column or cells you want to delete.
2. Right click > Delete > Table Columns.

Changing Cell Height and Width

When we create a table, all the columns may have equal column width or different widths.
If you want to change the row height, simply select the row and right click. Then select
the Row Height option.

153

tutorialspoint

EIMPLYEAEBEYLEARMING

&



Computer Concepts

Function and Charts

We shall learn how to use functions and charts in Microsoft Excel:

Using Formulas

You can use formulas to perform basic mathematical calculations, such as addition,
subtraction, multiplication, and division of numbers. The following examples demonstrate
how to use formulas to carry out mathematical calculations.

Addition

Addition helps to add two or more values. By using “"=SUM(cell1+cell2)” formula, we can
calculate the sum of values.

Examples

¢ Open a new worksheet.

e Move the cursor to cell Al.

e Write one value in cell A1 and another value in cell B1.

e Write "=SUM(A1+B1)” in cell C1 which will automatically get displayed in formula
bar.

e Press Enter.

¢ Note that cell Al has been added to cell B1 and the result is shown in cell C1.

Subtraction

Subtraction helps to subtract two or more values. By using "=SUM(cell1-cell2)” formula,
we can calculate the difference between the values of cell 1 and cell 2.

Example

e Open a new worksheet.

e Move the cursor to cell Al.

e Write one value in cell A1 and another value in cell B1.

e Write "=SUM(A1-B1)” in cell C1 which will automatically get displayed in the
formula bar.

e Press Enter.

e Note that cell B1 has been subtracted from cell A1 and the result is shown in cell
C1.
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Multiplication

Multiplication helps to multiply two or more values. By using *=SUM(cell1*cell2)” formula,
we can calculate multiplication.

Examples

e Open a new worksheet.

e Move the cursor to cell Al.

e Write one value in cell A1 and another value in cell B1.

e Write "=SUM(A1*B1)” in cell C1 which will automatically get displayed in the
formula bar.

e Press Enter.

e Note that cell A1 has been multiplied to cell B1 and the result is shown in cell C1.

Division
e Division helps to divide one value by another value.
e By using "=SUM(celll/cell2)”, formula we can perform division.

Examples

e Open a new worksheet.

e Move the cursor to cell Al.

e Write one value in A1 and another value in B1.

e Write "=SUM(A1/B1)” in cell C1 which will automatically get displayed in the
formula bar.

e Press Enter.

¢ Note that cell Al is divided by cell B1 and the result is shown in cell C1.

Function

e Microsoft Excel has a set of prewritten functions to perform a specific task.
¢ When using a function, remember the following steps:
1. Use an equal (=) sign to begin a function.
Specify the function name.
Enclose arguments within parenthesis.
Use a comma to separate arguments.
Here is an example of a function, =POWER(number,power) or
=POWER(cell1,cell2)

2.
3.
4.
5.
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Chart

A chart is a graphical representation of worksheet data. Charts can make data interesting,
attractive and easy to read and evaluate. They can also help you to analyze and compare
data.

Creating a Chart

The easiest way to create charts in excel is by using the chart wizard. Chart wizard icon
appears on the insert menu. Chart wizard is a program which consists of different types
of charts; it helps user through the process of creation of charts. Icons or symbols present
at the side of chart help to add or remove elements to the chart, change chart style and
add a filter to the chart. After completing a chart, you can still make changes to it or just
start from the beginning.

Getting Started with Chart Wizard

e The first stage in using chart wizard is to have a table of data.

¢ In excel, open a new worksheet, and enter data.

e Then you must select range of cells that you need in the chart.

e For example, with cursor in the top-left cell of the table (Al), select table by
clicking and dragging cursor to the bottom right-hand cell (B7).

e Click Insert menu and select chart option.

e From chart types, select the type of chart that you would like to use.

¢ Excel has different types of Charts such as line charts, pie chart, area chart, pivot
chart, etc.

e The selection of chart type is usually driven by the data, although there are no
strict rules for determining the chart type you should use.

e But you should use the one which displays your data and conveys your message
in the simplest way possible.
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Example Program

We shall discuss an example to understand this concept:

Aim

To prepare a bar chart.

Procedure

e C(Click Start > All programs > MS-Office > MS-Excel.

e Insert a table in the worksheet.

e Select Insert > Chart icon.

e Select column option from chart type.

e Inthetitle bar, Click on chart title box and type, population of metropolitan cities.

Result

The given database is created in excel worksheet using the bar chart.

Summary

This topic had given detailed description about the concepts of opening new and existing
worksheets, renaming the work sheet, organizing spread sheet, printing spread sheet,
saving workbooks, manipulation of cells, entering text, numbers and dates, creating text,
number and date series, editing worksheet data, inserting and deleting rows & columns,
changing cell height and width, using formulas, and creating a chart. This chapter also
focused on cell address, numbers and text, title bar, menu bar, formula bar, and functions
& charts.

157

tutorialspoint

EIMPLYEAEBEYLEARMING

&



5. Computer Concepts — Introduction to

Internet, WWW and Web Browsers

Internet is a global communication system that links together thousands of individual
networks. It allows exchange of information between two or more computers on a
network.. Thus internet helps in transfer of messages through mail, chat, video & audio
conference, etc. It has become mandatory for day-to-day activities: bills payment, online
shopping and surfing, tutoring, working, communicating with peers, etc.

In this topic, we are going to discuss in detail about concepts like basics of computer
networks, Local Area Network (LAN), Wide Area Network (WAN), concept of internet,
basics of internet architecture, services on internet, World Wide Web and websites,
communication on internet, internet services, preparing computer for internet access, ISPs
and examples (Broadband/Dialup/Wi-Fi), internet access techniques, web browsing
software, popular web browsing software, configuring web browser, search engines,
popular search engines/search for content, accessing web browser, using favorites folder,
downloading web pages and printing web pages.

Basics of Computer Networks

Computer network is an interconnection between two or more hosts/computers. The
connectivity can be physical by using cables or virtual using wireless network. Different
types of networks include LAN, WAN, MAN, etc., as shown below:

Types of Computer Network

LAN {Local Area Network)

MAN (Metropolitan Area Network)

WAN (Wide Area Network)

Local Area Network (LAN)

Local Area Network (LAN) provides data communication within shorter distance and
connects several devices such as computers and printers. This type of network contains
computers that are relatively closer and are physically connected with cables and wireless
media. Any network that exists within a single building, or even a group of adjacent
buildings, is considered as LAN. It is often used to connect separate LANs together so they
can communicate and exchange data.
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LAN

Wide Area Network (WAN)

Wide Area Network is connecting two or more LANs together, generally across a wide
geographical area.

Example

A company may have its corporate headquarters and manufacturing plant located in one
city and marketing office in another city. Each site needs resources, data and programs
locally, but it also needs to share data with other sites. To accomplish this, the company
can attach devices that connect over public utilities to create a WAN.

Network

LAN Servers

Gateway
Router "*w..

¢ Nétwork
LAN Users
Switch

8 A
ap !

Metropolitan Area Network (MIAN)

Metropolitan Area Network (MAN) is an extensive network that connects numerous
corporate LANs together. Usually MANs are not owned by sole organization. Their
communication devices and equipment are maintained by a group or single network
provider that sells its networking services to corporate customers. MANs often take the
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role of high-speed network that allows sharing of regional resources. MANs also can
provide a mutual connection to other networks using a WAN link.

MAN

LAN
(Local Area Network)

o

LAN
(Local Area Network)

LAN
[Local Area Netwaork)

Sle

Interet

Internet is called the network of networks. It is a global communication system that links
together thousands of individual networks. In other words, internet is a collection of
interlinked computer networks, connected by copper wires, fiber-optic cables, wireless
connections, etc. As a result, a computer can virtually connect to other computers in any
network. These connections allow users to interchange messages, to communicate in real
time (getting instant messages and responses), to share data and programs and to access
limitless information.

Basics of Intemet Architecture

Internet architecture is a meta-network, which refers to a congregation of thousands of
distinct networks interacting with a common protocol. In simple terms, it is referred as an
internetwork that is connected using protocols. Protocol used is TCP/IP. This protocol
connects any two networks that differ in hardware, software and design.
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Process

TCP/IP provides end to end transmission, i.e., each and every node on one network has
the ability to communicate with any other node on the network.

Layers of Internet Architecture

Internet architecture consists of three layers:

The three layers of internet

IP

In order to communicate, we need our data to be encapsulated as Internet Protocol (IP)
packets. These IP packets travel across number of hosts in a network through routing to
reach the destination. However IP does not support error detection and error recovery,
and is incapable of detecting loss of packets.

TCP

TCP stands for “Transmission Control Protocol”. It provides end to end transmission of
data, i.e., from source to destination. It is a very complex protocol as it supports recovery
of lost packets.

Application Protocol

Third layer in internet architecture is the application layer which has different protocols on
which the internet services are built. Some of the examples of internet services include
email (SMTP facilitates email feature), file transfer (FTP facilitates file transfer feature),
etc.

Services on Intemet

Internet acts as a carrier for numerous diverse services, each with its own distinctive
features and purposes.

World Wide Web and Websites

World Wide Web is being used on internet right now. WWW is the name given to all
resources of the internet, which you can access with a web browser. It was created as a
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method for incorporating footnotes, figures and cross-references into online documents in
the European Particle Physics Laboratory in Geneva, Switzerland in 1989. The web makers
wanted to make a simple method to access documents that are stored on a network,
without searching through indexes or directories of files, and without physically copying
documents from one computer to another before viewing them. To do this, they made a
way to “connect” documents that were stored in different locations on a single computer,
or different computers on a network.

Terminologies related to WWW

Web documents can be linked together, and are called “Hypertext”. Hypertext systems
offer an easy approach to manage huge collections of data, which includes text files,
pictures, sounds, movies and more. In a hypertext system, when you view a document or
your computer screen, you can also access all the data that is linked to it. To support
hypertext documents, web uses a protocol called “Hypertext Transfer Protocol” (HTTP). A
hypertext document is a specially encoded file that uses “Hypertext Markup Language”
(HTML). HTTP and Links are foundation for WWW. Web page is displayed in the web
browser. It is a kind of word processing document which contains pictures, sounds and
even movies along with text.

Websites

A collection of associated web pages is called "Website”. Websites are housed on the web
servers. Copying a page onto a server is called “publishing” the page, which is also called
“posting or uploading”.

Communication on Intemet

We shall discuss how communication happens through the use of Internet in this section:

Email

Electronic mail or email is one of the key parts of e-revolution which is specially designed
for communication purpose. Once you have an email account, you can start sending
electronic messages to anyone if you have the recipient’s email address. The format of an
email address is “username, @ symbol, domain name (yahoo.com, gmail.com,
etc.)”. For example: name@yahoo.com.

Internet Relay Chat (IRC)

IRC is a form of real-time internet chat or synchronous conferencing. It is mainly used for
group communication in discussion forums called channels, also allows one-to-one
communication via private message, and both chats and data transfers via Direct Client-
to-Client protocol.

IRC client software is available for every operating system.
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Video Conference

A video conference is a telecommunication technology, which permits two or more people
in different locations to interact via mutual video or audio transmission simultaneously. It
is also called visual collaboration and is a type of groupware. Video conferencing uses
telecommunication technology to bring people at different sites together for a
meeting/conversation. This can be as simple as a conversation between two people in
private offices, or involves several sites with more than two people. It can also be used to
share documents, computer displayed information, whiteboards, etc.

Voice Over Telephony (VOIP)

VOIP stands for voice over IP, where IP refers to the Internet Protocol which is a base for
all internet communications. This phenomenon began as an optional mutual voice
extension to some of the instant messaging systems that took off around the year 2000.
In recent years, VOIP systems are easy to use and as convenient as a traditional
telephone. Voice quality can still differ from call to call but is often equal to and can even
beat the traditional calls.

P -

/" Phone

Computer
." ~

,/' lnternet e
[‘ "a A’“ -
N i !

Computer

Instant Messaging

Instant Messaging (IM) is a process of transferring real-time messages between users. It
facilitates private chat room atmosphere. IM alerts users when some of their peers are
online, so the users can start chatting with them.
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Online conversations in which you are immediately able to send messages back and forth
to one another is called “chat”.
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Remote access

Internet permits computer users to connect to other computers across the world and to
store information effortlessly. This can be done with or without any security, authentication
and encryption technologies depending on the requirements which encourages work from
home culture.
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Remote Access

Collaboration

Low cost and rapid sharing of ideas, knowledge and skills has made collaborative work
easy. It is a convenient way to stay in touch with colleagues through group chat or private
messaging. Email is also an easy way to communicate. Collaboration helps voice and video
chat between team members and to work with shared set of documents.

File Sharing

e A file or document can be e-mailed to anyone as an attachment.
e It can be uploaded to a website or FTP server, for users to download content easily.
e It can be put into a shared location or onto a cloud for instant use by colleagues.

’ A{E

Many existing radio and television presenters provide internet “feeds” of their live audio
and video streams. An internet-connected device, such as a computer or something more
specific, can be used to access on-line media in much the same way, as television or radio
receiver.

Streaming media
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File Transfer Protocol

File Transfer Protocol is a network protocol which is used to transfer data from one
computer to another over any TCP/IP based network. It helps to manipulate files on
another computer regardless of the operating system involved.

FTP Commands

| —————

FTP Replies

\ - i Data E
( Connection
—~
FTP Client FTP Server

on Client PC

Telnet

TELNET means TELecommunication NETwork. It is a network protocol used on the internet
or LAN connections. It helps to provide text oriented mutual communication using virtual
terminal connection.

Telnet
Client

Telnet
Server

Output from server T
to client display B

; Input from client ;
keyboard to server

Newsgroups

A forum on the Usenet service for the discussion of a particular topic. Newsreader software
is used to read newsgroups.

NEWSGROUPS
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Preparing Computer for Intermet Access

There are many ways to obtain access to the internet. The method varies according to the
type of devices (computer, laptop, mobile) being used and type of connections offered.

ISPs and Examples (Broadband/Dialup/Wi-Fi)

Internet Service Provider (ISP) is the gateway to access internet. It is an organization that
gives access to the internet. ISPs provide services for home, large industries, government
sectors, etc. There are two types of connections:

v' Instant: Starts when user dials-up for connection and ends after the session
is over.
v" Full-time: The connection prevails 24/7 even if the session ends.

Broadband

Broadband connections are considered as high speed connections, as they use modes that
can handle several signals at once, such as fiber optics, twisted pair cables, coaxial cables
and other technologies.

Dial-up

In dial-up connection, the computer uses its modem to dial a telephone number given to
user by an Internet Service Provider. This launches a connection between personal
computer and ISP server. The dial-up connections are temporary, as the connection ends
once the session gets completed.

Wi-Fi

Wireless LAN has become popular for use these days which is based on the technology
called Wi-Fi (Wireless Fidelity). This uses radio waves to transmit signals and provides
access to the internet within a short distance.

Below is the list of Internet Service Providers:

S. No | ISP Narrowband Broadband

1 Airtel 52,064,601 38,473,189
2 Vodafone 39,726,68 27,760,081
3 Idea Cellular 21,110,847 22,924,981
4 Reliance 23,449,233 15,567,769
5 BSNL 13,740,051 20,351,570
6 Aircel 14,906,282 7,541,005

7 Tata 11,812,117 9,229,125

Teleservices
8 Telenor India 13,671,479 0
9 MTNL 456,096 1,511,496
I&j !:uip:m:iglspginiz
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10 Videocon 1,213,631 0

Internet Access Techniques

Internet can be accessed using following methods:

Dial-up Connections

In dial-up connection, computer uses its modem to dial a telephone number given to the
user by an Internet Service Provider. This launches a connection between personal
computer and ISP server. The process begins when the ISP server answers, and ceases
when your computer or the server “hangs up”. This is similar to a traditional telephone
call. Most ISP servers disconnect automatically after a certain period of inactivity. Once a
connection is configured on the user's computer, he/she can use the connection. It is
secure and de-allocates unused memory automatically.

Dial-up
Internet

i

-

Broadband Connection

Broadband connections are considered as high speed connections, as they use modes that
can handle several signals at once, such as fiber optics, twisted pair cables, coaxial cable
and other technologies. Even with hundreds of users on the network, these connections
allow large files and complex web pages to download quickly. To be considered as a
broadband, the connection must be able to transmit data at a rate faster than is possible
with the fastest dial-up connection. Downloading and uploading content will be fast.

Telephone operator
Internet Service Provider

-
_ = WE|0 ooz OV 5 ’
/
= Cable Intermnet ﬁ
,."'r custormer |
/= -~
— = ; ADSL customer

{Triple play)
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Integrated Services Digital Network (ISDN) Service

Integrated Services Digital Network (ISDN) is a digital service that simultaneously
transmits voice & data, and controls signals over a single telephone line. ISDN service
operates on a standard telephone line, but requires a special modem and phone service,
which adds to the cost. An ISDN data connection can transfer data up to 128,000 bits per
second (128 Kbps). It helps to connect a PC, telephone and fax to a single ISDN line and
use them simultaneously.

Digital Subscriber Line (DSL)

Digital Subscriber Line is similar to that of ISDN in using telephone network, but it uses
more advanced digital signal processing and algorithms to squeeze maximum number of
signals through telephone lines. DSL also requires changes in components of telephone
network before it can be offered in any area. Like ISDN, DSL provides simultaneous data,
voice and fax transmission on the same line. Several versions of DSL services are available
for home and business use; each version provides 24/7 full-time connection at different
levels of service, speed, bandwidth and distance.

DSL modem

a tedephone

phane jack

eshermse corg

or

‘:‘—E':

R
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DSL Maximum Maximum Maximum | Lines Phone Support
Type Sending Receiving Distance Required
speed speed

ADSL 800 Kbps 8 Mbps 5,500 m 1 Yes

HDSL 1.54 Kbps 1.54 Mbps 3,650 m 2 No

IDSL 144 Kbps 144 Mbps 10,700 m 1 No

MSDSL | 2 Mbps 2 Mbps 8,800 m 1 No

RADSL | 1 Mbps 7 Mbps 5,500 m 1 Yes

SDSL 2.3 Mbps 2.3 Mbps 6,700 m 1 No

VDSL 16 Mbps 52 Mbps 1,200 m 1 Yes

Cable Modem Service

Now-a-days many cable television companies use some percentage of their network’s
bandwidth to provide internet access through prevailing cable television connections. Since
this connection uses a special cable modem, it is called “"Cable Modem Service”. Cable
television systems transmit data via coaxial cable, which can transmit data as much as
100 times faster than common telephone lines. Coaxial cable allows transmission via
several channels simultaneously, i.e., the internet data can be transmitted on one channel,
while audio, video and control signals are transmitted separately. The user can access
internet and watch television concurrently, with two non-interfering data streams.

Television PC

Ethernet RJ45

Cable
Modem

o O

€ G

I

Cable
Network

Wireless LAN (WLAN) Connections

Wireless LAN connections are very common these days, which are based on the technology
that is often cited as Wi-Fi (Wireless Fidelity). The distance covered by WLAN is usually
measured in meters rather than miles. Therefore, this is not a technology that connects

&
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directly to an ISP but can be used to connect to another LAN or device through which

internet access is achieved.

=—— [l

Process

e To connect to internet, the wireless access point is connected to a wired LAN like
any other devices, and then computers with wireless NICs can access the wired
LAN.

o “Wireless access point” is a device that acts as a hub or switch.

o “NIC” refers to a Network Interface Card which helps to identify a computer on a
network.

Wireless WAN (WWAN) Connections

A WWAN is a digital network that spans over a large geographical area. A WWAN accepts
and transmits data using radio signals via cellular sites and satellites. At the switching
center, the WWAN divides off into segments and then connects to either isolated or public
network through telephone or other high speed communication links. The data is then
linked to an organization’s existing LAN/WAN infrastructure. The coverage area for WWAN
is normally measured in miles (kilometers) with a data transmission rate of 100 Mbps.

T

«~
L

A~
?

Satellite Services

Satellite services provide a mutual (two-way) communication between user and the
internet. This provides a full-time connection which is used in armed forces, business, etc.
It includes two parts:

Transceiver - A satellite dish that is placed outdoors in direct line of sight to one of the
several satellites in geostationary orbit.

Modem-like device - It is connected to a dish, placed indoors and connected to a LAN
or computer.

&
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Web Browsing Software

“World Wide Web” or simple "Web” is the name given to all the resources of internet. The
special software or application program with which you can access web is called “"Web
Browser”.

Launching a Web Browser

Web browser is an application that is located on a computer’s disk. Once you have an
internet connection, you can launch a web browser using the following methods:

Method 1
Step 1: Go to “Start Menu”.

Recently added
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£ Type here to search

Go to Start menu

Step 2: From the menu opened, click on the web browser (Mozilla, Google Chrome,
Internet Explorer).
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Select Google Chrome

Method 2: Alternate way is to click the shortcut icon on the taskbar or desktop.

~~~~~~

H O Type here to search

Select the shortcut icon on the task bar

Popular Web Browsing Software

The most popular web browsing software includes:

Google Chrome

Google Chrome is a web browsing software developed in the year 2008 by Google Inc.
First, it was designed for windows platform, and later adopted to Linux, Macintosh, and
even Android. It is written using C++, Assembly, Python, and JavaScript.
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Mozilla Firefox

Mozilla Firefox is a web browsing software developed in the year 2002 by the Mozilla
Foundation. It is designed to work on all operating systems like Windows, Macintosh,
Linux, and Android. It is written using C++, JavaScript, Rust, C, CSS, XUL, and XBL.

Opera

Opera is a web browsing software developed in the year 1995 by Opera Software. It is
designed to work on all operating systems like Windows, Macintosh, and Linux and is
written using C++ language.

Internet Explorer

Internet Explorer is a web browsing software developed in the year 1995 by Microsoft. It
is designed to work on all operating systems like Windows, Macintosh, Linux and Android
and is written using C++ language.

Configuring Web Browser

Configuring a web browser is organizing or changing the settings of the browser in a format
presentable to the user.

Configuring Microsoft Edge

Configuring Microsoft Edge includes the following steps:

Step 1: Open Microsoft Edge via shortcut icon in the task bar or "Start Menu”.
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Step 2: Select Microsoft Edge.
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Select the shortcut key on the task bar

Step 3: Click “Settings” from the “Settings and more” menu.
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Select Settings and more
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Select Settings option

Step 3: From window opened, make changes to the settings.
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My Feod

fe=l @1 Ao wad

s wiBpe v st of aed &
ur i g

=t |

12 mdnths for the price of 10. 0365 yearly subs.
Buy Now

Settings o

Open M

osoft Edge with

Start page

Open new

Top sites

Import

tabs with

and suggested content

favorites and other info

Import from another browses

Favorites bar

Show the favorites bar

© o

Clear browsing data

Choose what 10 clear

Account

Change the Account settings here
B a R X 4~ = 8. X
O @ ¥ £
Settings o
n Favorites far
Show the favclites bar
@D o
My Foed
Clear brogsing data
Chooulhﬂ‘mdu
Account &
=
| : fe=l @ devwe wal .
" - v, wifige fvdee feeh Rt oed @ v o te s ) e une;
12 mdnths for the price of 10. O B
Buy Now =it | D tiniss
Advanced settings
View vanced settings
About this app

*ia
o] [

H Type here 10 search

&

tutorialspoint

EIMPLYEAEBEYLEARMING

Microsoft Edge 41162593710

Microso# £dg

TML 16,36,

177



B a @ a2 %X |

My Food

2).

12 méhths for the pricé of 1C O36A5 yearly sub;:

Buy Now

Configuring Google Chrome

Computer Concepts
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wy HFin el 3 » Microsch account of work affount

| owiog |

About this app

Microsoft Edge 41162993710
Microscét EdgeHIML 16.16299

Step 1: Open Google Chrome via icon in the task bar or “Start Menu”.

Recently added

_—_— I
B lcecream Screen Recorder

-

B lcecream Screen Recorder on the...

B Website

Expand v

Acrobat.com

Adobe Reader 9

Alarms & Clock

New

Android Studio

Bloodshed Dev-C++

Bubble Witch 3 Saga

Go to Start menu

&
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Create

See all your mail in one place

©Lh =

Jot notes

OneNote B

Explore

S

Microsoft Edge

S
=]

Microsoft Store

<]
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Select Google Chrome

Step 2: Click three vertical dots icon ( { ) present at upper right corner of the window and
go to “Settings” option from the menu displayed.

Select Customize and control Google Chrome option
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Select Settings
(2] - o X
G Google x
& C @ Secure | hitpsy//www.google.com w
New tab
New window

New ncogmto window

History ’
Downloads

8cokmarks 4
Zoom - |00 - e

Print..
Cast—
Find..

More tools ’

Edit Cut Copy Paste

Google Search I'm Fesling Lucky

Step 3: From the window opened, change settings of people, appearance, search engine,
default browser, startup and advanced tabs.

Make changes in this tab
a - o E
5 Google X /B8 Seitings x
| @ fhrome | chrome://settings b+

Settings

; Person 1 L] SIGN IN TO CHROME

Sign im 1o get your bookmarks, history, passwonds, and other settings on all your devices. You'll also
automatically be signed in 1o your Google services. Leam maode

Manage other people ¥

|I‘|'||}i'bf'| baokrmarks and SeMings 3
Appearance

Themes

Open Chrome Web Store

Show homea buthon -
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Search Engines

Search Engine is an application that allows you to search for content on the web. It displays
multiple web pages based on the content or a word you have typed.

The most popular search engines are listed below.

Google

Google is the most popular and robust search engine launched in the year 1997 by Google
Inc. It was developed by Larry Page and Sergey Brin. It is written using C, C++ and
Python. Beyond searching content, it also provides weather forecasts, sports score,
temperatures, area codes, language translation, synonyms, etc. Now-a-days the
advancement is still more, that it displays maps in a touch. It is used by 4+ million users
across the world.

G Google X e o X
& C | @ Secure | httpsy//www.google.com | :
Gmail Images §if m

(=

Google Search I'm Feeling Lucky

Google offered in: &=l AT Sewp WS sp Awudl INE ELIge YFE

Advertising  Business  About Privacy ~ Terms  Seftings

» s o T21AM
H O Type here to search Back=dnich NGB D) g -

Bing
Bing is also a popular search engine launched by Microsoft in the year 2009. It is written
using ASP .Net language. It is used to search web content, video, images, maps, etc.
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[ sing X e = X

<« C | @ Secure | https//www.bing.com *

All Images Videos M

> Bing B
L

Languages; fEdt amem Sewh

Info

PM offers internships Revelations on Gambhir Wears Indian designers Mystery nearly solved? CSK star injured Back in Indian Idol

x", a :
N, N Jﬁllgqgl I“Enhhu*ggi(f? =
0 i taonah ™ R

o Type here to search h ;| ﬁ v 9

Yahoo

Yahoo is a common search engine launched by Yahoo in the year 1995. It is a multilingual
search engine and written using PHP language.

Yahoo X e o a X
& C | & Secure | https://in.yahoo.com Y
A& Home Mail News Cricket Celebrity Movies Lifestyle Flickr Mobile More v L]

YAHOQ! | = v
.
= Mail Cricket News Finance Lifestyle Movies Celebrity Travel More...

Close ad | X

\f“ Where in the world
would you pause time?

#SayYesToTheWorld
Lufthansa

Nonstop you

Make YAHO(Q)! your homepage

Trending now

1. UPSC results 6. Radhika Apte
2. Vijay Mallya 7. Diana Hayden

| NSURANCE

3. Sino-Indian summit 8. Quantico season 3

4. PR Sreejesh 9. Chetan Bhagat

H O Type here to search 0
Ask

Ask is the most popular search engine and application for e-business which was launched
by IAO in the year 1996. It was developed by Garrett Gruener, David Warthen, and
Douglas Leeds.
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Secure | https://www.ask.com w i

H O Type here to search

AOL

America Online is a popular search engine launched in the year 1993 by AOL Inc. At first,
it was called as control Video Corporation. The founders of AOL are Marc Seriff, Steve
Case, and Jim Kimsey.

B A0L Search X (2] - X

&« C' | @ Secure | https://search.aol.com Y|

Aol.

» i 724 AM
H QO Type here to search Eren A~ GDD g

Search for the content

Search Engine helps to search for content on web using the following steps.

Step 1: Launch your web browser.

&
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Select the shortcut icon on the task bar

Step 2: In “Address bar/Location”, type the search engine you want to use and press
enter.

Enter the name of search engine here

l (3] o X
Qle.com o

Step 3: Type the content you want to search in the “search text box” and press enter.
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Enter the content to be searched here

O Type bere 1o sesrch i

Step 4: It displays a list of web pages from which you can select corresponding content/web

page you want.

Web pages related to the search will be displayed

esgrameTang

= ] R R
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Accessing Web Browser

There are several ways to access a web page like using URLs, hyperlinks, using navigating
tools, search engine, etc.

Using URLs

URL refers to “Uniform Resource Locator”. Each and every website can be recognized using
a unique address called “Uniform Resource Locator” or simply a URL. Once you provide

URL of a specific page in address bar, web browser will find the corresponding page and
displays result to the user.

URL
e - 0 X
G programming in C- Goo X
¢ C | 8 Secure | https://www.google.com/search?s : Rlei=iyPoWrX Svg YBAS: Jrammi... W
@Y%  programmingin C $ Q
All Books Videos Images News Settings

C Programming Language Fundamentals | Pluraisight - pluralsight.com
(Ad) www.pluralsight com/ v
r & Advanced Classes. Free 10-Day Trial Start Now!

Live Mentoring - Skills Assessments - Over 5 000+ Courses - Offline Access

Learn C (Introduction and Tutorials to C Programming) - Programiz
hitps:/Avww.programiz.com/c-programming v

Cisapc ful general-purpose progrs ing |
If you are o start your programming journey. Thisis a
comprehensive guide on how to get started in C programming language, why you should leamn it and
how you can leamn it

C Programming Examples - C Operators C Programming for Loop - C Input/Output

nguage. Itis fast, portable and available in all platforms

w to programming, C is a good

C Programming Basics - Learn C Programming & C programs
https:/Mresh2refresh.com/c-programming/c-basic-program/ v v

Using Hyperlinks

“Hyperlink” is a part of web page that is linked to URL. Hyperlink can be text, image,
button, arrow, etc. By clicking on a hyperlink you can move to different URL specified in

the link from the current URL. Hyperlinked text is an underlined blue color text which is
represented using hand symbol.
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Hyperlink

<« C o«
.-
T

2 B
-l

WiKIPE ma € (programming language)

A 4
c o in e THE IppOrang s prog . c
cansy T C Programming Language P 3 hat
) COMEUer PIcOramIming Bock THE
PROGRAMMING g reangioment 1t )
LANGUAGH Wen ¢ " . PROGRAMMING
% LANGUAGE
o o s coh 8
Parad
a y
[ a by
‘ L]
¥ Al 1 -
£ s ‘
Contests Firse appesred 1972 48 years a0

Using Browsers Navigation Tools

Web browsers offer a variety of tools to help you move around the web. These tools help
you to quickly go back and forth through web pages.

Back Button - Helps to move back to the previous page from current page.

Back button
(3] =}
€ ( -
o
Fa r Read E View Mesior Q
%
.9
- .
wikieeniA  C (programming language)
c X > A B
),v, e v teen Losed I
PROGRAMMING
LANGUAGE
Yas
" [ 7 .
£CJTC ‘
Conteats v First appeared 1972 48 yean apo
Su 2 Decorne -

= [ "

Forward Button - Helps to move to the next page from current page.
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Forward button

€3C & AN GOO0NACON

C (programming language) - Wikipedia
iy . ITHE

PROGR \\l\ll\(.)h! I |

LANGUAGH gm

ANGUD ntroduction - GeeksiorGeeks
Typisg disciping: Static weeh. manilest
t5 aboet Maoos  Variables and Keywards in C - C Basics Stabile rebeane: C11 / Decnrtier 2011 6 poars g
Designed by: Denna Richie

Flenarme extenskons

Develeper: D e

[}

PPl O 1yoe bere 1o search

Refresh Button - Helps to refresh a current page.

Refresh button

< ,:-:l»'-: ey X e o A

€3C www.googhe zoe

g ® TS ¢ propramming language $ £ m

amming lax c rHE
¥ Cc L
PROGRAMMING)R! T . ig
LANGUAGH . b6 (ciagos.
" R
C Language Introduction - GeeksioeGeeks
at

Close Button - Helps to close a web page.

188

AEBEYLEARMNINDG

@J . tutorialspoint



Computer Concepts

Close button
5 cpm [a) [ ]
€« 2 ( B
wy ? C programmeng language U 4 m
s ! FHE
C: X
PROGRAMMING)R! T .. {L.’

LANGUAGH w

Using Bookmark

Web browsers allow you to bookmark pages that you visit most frequently. This helps you
to go to web page directly by selecting from a list of bookmarks instead of typing the URL
multiple times. This is displayed as an icon with star symbol in the top right corner of the

page.

Bookmark
o ¢ o

€& 9 ( . o
S

vy ¥ ¢ proprameming language y =

TJ." THE
CC ¢
PROGR \\l\ll\(.)h! I {G

LANGUAGH X w
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When you type any URL in address bar, the browser saves that URL automatically, thus
creating a history list for current session. You can choose the URL you want from the

history list instead of typing it again.

All Books Videos Images News More

About 4 62,00.000 results (0.67 seconds)

C Programming Language Fundamentals | Plur:
www. pluralsight.comv/ ~

Beginner & Advanced Classes. Free 10-Day Trial. Stant Now!

Live Mentoring - Skills Assessments - Over 5000+ Courses - Offlir

Learn C (Introduction and Tutorials to C Prograr
hitps:/iwww.programiz.com/c-programming v

C is a powerful general-purpose programming language. It is fast,
If you are new to programming. C is a good choice to start your p
comprehensive guide on how 10 get started in C programming lang
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Using Search Engine

Search engine is an application that allows you to search for content on web. It displays
multiple web pages based on the content or a word you have typed. The most popular
search engines include Google, Yahoo, Ask, etc. Below are the steps to use a search

engine.

Step 1: Launch your web browser.

- o Type here to search

Select the shortcut icon on the task bar

Step 2: In “Address bar/Location”, type the search engine you want to use and press
enter.

Enter the name of search engine here

G Google x l (i) - o x

« C 8 Secom | tmps /www.googhecom
Grmal images 331

75@,_

)
| Blll])

(-

Googhe Sesrch I'm Feuling Lucky

Coogle ofersd i H% mmy It woll by Fyudl v camoge Swd

dvatiaing  Deniness Aot

:
[« [oR— Bocmacmle o lo.zno|
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Step 3: Type the content you want to search in the “search text box” and press enter.

Enter the content to be searched here

EJO e .

Step 4: It displays a list of web pages from which you can select the content/web page
you want.

Web pages related to the search will be displayed

G propremmeng =

= -] A o e L0

- peograenenng i L a e |

w
Learn & [Introduction and Tutgrials io & Programming) - Frogramiz
S P ! e rHE
& E—— &
PROGEAMRMING m 'I-

& Pregramming Basics - Learn C Programming & C programs LANGUAGE e _w

pragEam primt] and scasi - Oniling Compies
Frogramm '~|:~ InC o g laras
C Programming Tutorial | Leam C programming | © language - YouTube Digreed by: D Ritchés

o ks . AT Filanams sxtsnsions: © |

Dwwatoper: Dasnis Fitchis I Bed Lak

Oo-— %

Using Favorites Folder

Web browsers allow you to bookmark the pages that you visit most frequently. The
Favorites folder is called Bookmarks. This helps you to go to the web page directly by
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selecting from the list of bookmarks instead of typing the URL again and again. Adding
and removing the pages to the favorite’s folder include the following steps.

Step 1: Click star icon present at the top right corner of the page.
Select Bookmark
AR o nh
« 2 .- o o4
" programmng language L FH m
Cip v:r‘ ng lang ';‘r‘r :'. . w.‘-. o U
/ Cc e
- - PROGR \\l\ll\(.)h! I i?
LANGUAGE X mm
C »
C Language Introduction - G
Typing disciphine: St ~
=
——— 3
= R ;
» o - (2] o
c3c s oo 5
"" programming language L o
[ oo |
rHE

programming languag

LANGUAGH

PROGR \\|\||\(.)h![ ( p

C Language

w tutorialspoint

193



Computer Concepts

."’ . C PIOQIBMIMING |aNJUAge )

& ,f.v-‘tn"n.r".r". ng Jj‘vi’. jage) - Widpedia [HE
PROGRAMMING)R! T .. 5:@
LANGUAGH v i S

Step 2: In order to add the web page, type the page you want to add as favorite and click
“Done” button or you can click the three vertical dots ( ¢ ) icon on top right corner of the
screen and select "Bookmark this page” option from the displayed menu to bookmark the
current page.

Select Customize and control Google Chrome option

€« c o

™ P (1 005)  anas M Ore Ml o o ASd Cuek L @ 'Weome 1o Googe
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Select Bookmarks
® - X
/ New Tab X\
C|a % i
e 5. n N b Cirl+T
it Apps G cprogramming lanc ew f+T
New window CtrieN
New incognito window  Clrl« Jhift«N
History »
Downloads Ctrie
Bookmarks b v »
Zoom - 100% - v
Print.... rief
Cast...
Find... |«F
More toois »
Edit Cut Copy Paste
Search Google or type URL Settings
Help »
Exit C hift+0Q
G Google M Inbox (39) - annie.a. . M Gmail
-
® - o x
New Tab x
Cla ¥ | 53
t Apps G < programming laes New ub CuteT
New window
New incognto window
History »
Deownlcads
Bookmarks »
Zoom 100% g
Prit
Cast..
import bookmarks and settings... =5
G ¢ programming language - Google Search Mote 100k >
Edit Cut Copy  Paste
Search Google or typs UR| Settngs
Help »
Exit

Step 3: In order to remove the web page, select a page and press "Remove” button or
you can click the three vertical dots icon( # ) on top right corner of the screen and select
the web page you want to delete and “Right click” and click “Delete” option.
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Select Customize and control Google Chrome option
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Select the web page to be un-bookmarked

o - o X
G programming in ¢ - Go x
“ C e 1 hittps.//www.google.coin i T ] ( ® 2
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L ‘
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- ‘ o Oownicads
> ' Bookmark this page Bockmarks »
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€ D C  # Seture  MIDL WawQoOgH COM * i
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Gt proguammng anguege - Soogle Sewc | I VSN »
PROGRAMMING)] i Bias
LANGUAGE
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Right click on the selected web page and select delete
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Alternately, we can use the below screenshots:

Select the Bookmark icon

G ¢ programmeng wvgens ¥
€ D30 85 103 WWW.Q0QM COM
,*' | C PrOQIBMMINg language $& Q
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People also search for X
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Downloading Web Pages

Downloading is saving a file or document or web page on your hard disk. It consists of
following steps.
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Step 1: Open a web browser and navigate to the webpage which you want to download.

W C (programming languac % e - x
<« C | @ Secure | https://en.wikipedia.org/wiki/C_(programming_language) 4
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Attidle  Talk Read Edit View history |Search Wikipedia Q
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Help system "l It has since become one of the most widely used programming languages of all time #1191 with C compilers from various PROGRAMMING
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Community portal National Standards Institute (ANSI) since 1989 (see ANSI C) and subsequently by the International Organization for Standardization The C Programming Language!"! (often
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What links here Despite its low-level capabilities, the language was designed to encourage cross-platform programming. A standards-compliant and )
Related changes Developer Dennis Ritchie & Bell Labs

9 portably written C program can be compiled for a very wide variety of computer platiorms and operating systems with few changes to its (creators): ANSI X3J11 (ANSI
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Step 2: Right-click on the file and choose Save as.

Right click and select Save as...

e

W C (programming langus: X
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C | # Secure | https en.wikipedia.org/wiki/C_(programming_language
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rogramming language, supporting structured programming, lexical
Current events prog 9Nty PROLIng prog 9 Save as... L} A Ctrl+S
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R ST variable scope and recursion, while a static type system prevents Print.
Donate o Wikipedia many unintended cperations, By design, C provides constructs that Cant
Wikipedia store map efficiently to typical machine instructions, and therefore it has . .
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found lasting use in applications that had formerly been coded in i
Interaction
: assembly language. including operating systems, as well as various View page source

S application software for computers ranging from supercomputers to Inspect
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Communéty portal embedded Systems The C Programmung Language'" (often

Recent changes referred to as "K&R”"), the seminal book on C

Contact page

C was originally ceveloped by Dennis Ritchie between 1969 and

1973 at Bell Labs [%! and used to re-implement the Unix operating
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oroaramming lanauaages of all time. 1% with C comoilers from vanous
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structured
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& Save As x a 1
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OneNote Notebooks 57172018 1:40 P File falder

& Downloads o+
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Step 3: Choose where you want to save the file, then click Save.

Select the destination of the file
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Click on Save
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Step 4: When the file is downloaded, you'll see it at the bottom of your Chrome window.
Click the file name to open it.
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C (programming language)
From Wikipedia, the free encyclopedia

View history [Search Wikipedia

“C Programming Language"* redirects here, For the book, see The C Programming Language

C (/si/, as in the letter ¢) is a general-purpose, imperative computer
programming language, supporting structured programming, lexical
variable scope and recursion, while a static type system prevents
many unintended operations. By design, C provides constructs that
map efficiently to typical machine instructions, and therefore it has
found lasting use in applications that had formerly been coded in
assembly language. including operating systems, as well as various
apphication software for computers ranging from supercomputers to
embedded systems.

C was originally developed by Dennis Ritchie between 1969 and
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Pause, Resume or Cancel

At the bottom of the screen, you can see the downloading file. Click the arrow next to the
file name at the bottom of your screen. Click Pause, Resume or Cancel, whatever

action you want to perform.

-
L

LB+ g Read View Mstir Q
Vi \\) ;
n

wikieepia  C (programming language)

He

PFROGRAMMING
LANGUAGE

. programmang L stml
oz « Ly

Printing Web Pages

Printing is creating hard copy of a document which can be a web page or any other content.
It includes the following steps:

Step 1: After launching web browser, open the page, image, or file you want to print.

Step 2: Click on three vertical dots icon ( ¢ ) on the top right corner of the screen or use
a keyboard shortcut: Ctrl + P.
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Select Customize and control Google Chrome option

€ ] o
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Select Print...
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4
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( Parsdign
3 D
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st | X

Y Clprogramming L bl A
[ [o] 3

Step 3: In the window that appears, select destination and change any print settings you
want; when ready, click Print.
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Select correct destination and click on Print

W C {programming languac X

& C | & Secure | hitpsyJenwikipedia.org/wiki/C_(programming_language
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v
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1
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proaramming lanauages of all time. 1% with C comoiiers from various | Designed by  Dennis Ritchie v

This topic summarized the concepts of internet like LAN, WAN, internet architecture,
internet services, WWW, communications on the internet, internet service providers,
internet access techniques, web browsers, search engines, favourites folder, configuration
of web browsers, and downloading & printing web pages.
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6. Computer Concepts — Communication and

Collaboration

Communication refers to exchange of information between persons through internet.
Internet provides a basis for communication and collaboration which can be done using
mail, chat, skype, etc. When dealing with official matters, electronic mail helps in the
exchange of messages text documents, web pages, audio, video, etc.

In this topic, we are going to discuss in detail about basics of email, email addressing,
configuring email client, using emails, opening email client, mailbox, creating and sending
a new email, replying to an email message, forwarding an email message, sorting and
searching emails, advance email features, sending documents by email, activating spell
check, using address book, sending softcopy as attachment, handling spam, instant
messaging and collaboration, using emoticons and some of the internet etiquettes.

Basics of E-maiil

Electronic mail is an application that supports interchange of information between two or
more persons. Usually text messages are transmitted through email. Audio and video
transfer through email depends on the browser in use. This provides a faster way of
communication in an affordable cost.

Advantages of E-mail

Functionalities like attachment of documents, data files, program files, etc., can be
enabled. This is a faster way of communication at an affordable cost.

Disadvantages of E-mail

If the connection to the ISP is lost, then you can’t access email. Once you send an mail to
a recipient, you have to wait until she/he reads and replies to your mail.

Email Addressing

Email address is a unique address given to the user that helps to identify the user while
sending and receiving messages or mails.

Username - Name that identifies any user’s mailbox

Domain name - Represents the Internet Service Provider (ISP).
@ Symbol - Helps to concatenate username and domain name.
For example: user_name@domain_name

Username - user, Domain name - gmail.com

Configuring Email Client

Configuring email client is setting up a client which includes the following steps:

205

@ tutorialspoint

EIMPLYEAEBEYLEARMING



Computer Concepts

Step 1: Open Outlook Express using “Start Menu” or using search option under the start
menu. Once the outlook window is open, press “"Next” button at the bottom of the outlook
express window.
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Welcome to QOutlook 2013

Outiook is your personal assistant, helping you manage your life with
powerful tools for email, calendar, contacts, and tasks.

Let's get started. In the next few steps, we'll add your email account.

Step 2: Then “Add an email account” window pops up showing “Do you want to set up
outlook to connect to an email account?”

Check mark the ‘Yes’ radio button and hit NEXT.

Use Outionk 13 conmert 1O WmM ACCIUNts, DICh 36 1O SIGAREIN 1 MOTTOSR Lxthange Sarver or an Tathacgr
Ovibre accovant o vt of Mrceot OMce 365 CuBack akia works with 0P, AR, and Lichange Advein
Sctount

O rou want 1o 161 19 Outiook 83 conmect 16 80 omid sctsunt!

o
O

HH 0 Type tere 10 search

Step 3: Then “Auto account set up” window opens showing the details of the mail
account to be configured. After providing corresponding details, press "Next” button.
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Vo Naeme Lo gemw
Eaampte: hen Adems

Laad 2aisy  aerer s S gmad com

P4 the patiwerd your intesnet 1envice Si3vider Rt gven y7u

o Type here 10 search
Enter your details and click Next

Step 4: The server will verify your email and then an email client will get configured once
you press the finish button.

teveet Ermad - arwweacn
1 ? Erdet pour waar rame 4 patvwaed for the folowng 1emre

Senw e
Unee NaSE | urrie 3crs

(] Sewe s patiwerd in yoor patrwerd Rt

i O Type here 10 search

Using E-mails

The main purpose of using email is to exchange information between persons. The process
starts with opening of client email and ends with sending and verifying mail to recipients.

Opening Email Client

In order to interchange messages between people, the first step is to open or create an
email account. Follow steps below to create an email account.
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Step 1: Go to Gmail homepage and select "More options - Create account” option.

Open www.gmail.com

Google
One account. All of Google.
|
[ =]
] -] II- & F
n O m o g "]
a8 o
<« C « & o

Google
@) count. All of Googl
G L C @ ¢

Select Create account

Step 2: In the window displayed, fill mandatory details and press "Next”.
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Google

Create your Google Account

we 1o ¢

e =

)

Enter your details and select Next

Step 3: Then mobile verification code will be sent to the mobile number you have entered,
upon verification, your email account will be created.

O Creste pour Google b ® L) o

€« C « SOCOUNS QOaghe.cor o 1

Google

Verify your phone number

make sute It really y

Enter the phone number and select Next
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Gougle

Verify your phone number

= o2 e

B} O e e o e o

Enter the verification code and select Verify

Step 4: Enter details to setup the account.

5 Creme your Google Acc. % o

Goaogle

ABC, welcome to Google
6 12105805Fgmad com

[ [o) e 5

Enter your details and select Next

Mailbox: Inbox and Outbox

Inbox - Inbox is an area where you can see all the received mails.
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Inbox

M pbox (2] - sameacef

Q Prmary et

Google Security slert
oactoutinemotlens@incec IRCTC Alr Packages Ex Bhopel

Anushi. Susmmnary of your Jegeoo ride - M 71

Jugnoo
Jwgroo (7) Arushi. Sermmary of your Jegeoo ride - |
Googhe

Chack your Google Accoust security status  Acooli Ag
Emal verified Successhully

Your arvall i Vertication actvation OTP code - T

& Uslock Maximum Student Admissions (&

Expand your Cussormes Base Cost Efectively

& Usbock Maxkmam Student Adminaions 8 1.t
Arushi, Sarmmary of your Jegeoo ride

Arshi, Sarrenary of your Jegeoo ride o 1

Uzlock Mazimam Studeat Admiscons

Fig 6.13

Outbox - Outbox is an area where the outgoing messages or messages which are in
process of sending or which are failed to send are stored.

Sent mail - Sent mail is an area to view all the sent or successfully delivered mails.

Sent mail

To anushiageraal 1707 (11)

O Type here 10 search
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Creating and sending a new E-mail

In order to send a new text message to the user, first create or compose the message
which includes the following steps.

Step 1: Open your mail account by providing correct User name and Password.

5 Gve » o o

H O Type hre 10 search i

Enter your account credentials and select Negg

Step 2: Compose or create your message by selecting “compose” option shown in the
window.

Orcscurisemoliensd@incn IRCTC Alr Pachages Ex Bhopa!

Jegno Arushi Semmary of your Jegeoo ride
Arushi. Semmary of your Jegeoo ride

Googhe Chack your Googhe Account secsrity status

Schetadmingircic codn Emat verified Successhdly

Schatacrin@icic co Vour ecnll i Vietication sctvetion OTP code

Guibrl earmer & Uslock Maxkmem Student Admissions @

Expend your Customer Base Cost ESectively
27 Usboch Madimm Student Adimissions @
Arushi Surrmary of your Ssgeoo ride
Arsishl, Sarmmary of your Jegeoo tide

Uisiock Maehmem Student Admissions

Step 3: In the window displayed, enter recipient’s address in “"To” textbox and add
“Subject” of message, then add a “"Body” of the message and press “"Send” button.
Remember, the subject of the mail should be explicit and short.
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= | a Tgri e g e E & B g

Tipe here 1o seafch

Enter the email id, subject and body of the email. Select Send

Replying to an E-mail message
Replying is giving response to the received mail which includes the following steps.

Step 1: Open an email to which you want to reply and press the "Reply” button or press
“Shift+R"” on the keyboard.

Google

Gersail -

Contact Us:
Indien Ralmay Catering snd Tourium Corporstion List

ndcos OMice

ot Nl

Online Booking © www.ircistournsm com

Orars (1)

Were X8 You harw receved S mal bacaune pou cpted for geting specil afers and commencisl promctions by emall This rad has been sent 4om an umonisced mall accoont and hance
e o not regly 95 Bis sl F you S0 fot with 13 receive yech mals. reply s o umaebicrte

< Foah
4
.01 GO %) of 15 GA ase Jpmmy - Breae
Macase LM St Savly § mndes a9

Click on Reply
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Motsde No. 00530000913

Oniine Booking | Www rcctournsm oom

You have received this sl becaune pou opted for getiing specisl ol and commencial promctions by emall Thes mal has been sert fom sn unmonicred mal sccoent and bence
Please 4 not regly 5 Bun el ¥ you 20 not wish 12 receive soch mals seply us o oastncrbe

RO .

0.01 GB %) of 15 GBS usedt Ipy - Brvas
Maaee LM BECaunt Achvty § ied dge
Cxlesy

Bl O type rete 1o search I+

Enter your message here

Step 2: In the window displayed, enter “"Body” of the mail and click “"Send” button. The
mail will be sent automatically to the corresponding person without having to re-type the
“To” address.

Google

Gerail -

COMPOSE

Contact Us:
nbox {41) Incion Naiwary Cotrring and Tourtaen Corparetion Lis.
Uhopal OfMce ndore OMce
IRCTC Regonsl Ofice & Fioor Bock Mo 04 RCTC Toamst Facitation Cantoe. patiorm ro. |
YOxe Radwiy .

Ph e OTI0-2

> » #913
Online BOoking | WWWrSCtourism com

Vou hirve received Bhis maal becaune pou opted for geting specil ofers and Comemercil promotions by emell This mall has been sent from an uamoniizred mall accout dnd hence
Phoarse 38 N0t regly %0 BN mal I pou S0 10t wish 13 receive soch mals seply s o ueebacre

e %o @ :

Last sccount actvly 7 mimdne g0
Ceety

Select Send

Forwarding an E-mail message

Forwarding is a process of resending an email message that you received from another
email id. This option saves time as the user doesn’t have to re-type the same message
again. It includes the following steps.
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Step 1: Open the email which you want to forward and click on “Forward” option or press
“Shift + F” on the keyboard.

Select Forward

Google

Gemail -

Inbox {41) rdun Retteay Catensag aed Touiwm Corporsos Lo

ndore OMice

3 o4 RCTC Tounst Facitaton Contre platorm ro |
e A e

e act

.
Ph e

» -
vy (1) " -
. Onkme Booking | www FCICtounsm com
Ve v/ .

You hirve recevid INs mal Bocacte pou cpted for Seting soechil oflers and commrciel gromotions by ermall This mal has been sent From an urmonlored mall sccount and bance
ploase 3o Not reply 10 Duis #lil ¥ pou S0 1Of wish 12 rective soch mads teply U8 o eaulacre

it Nk

A 4
,_\

001 GB W% o 18 G5 ueed Terns - Brvec
Macsce Lant accownt schvly | mesites 300
Crtey

i 0 Type bere 10 search v

Step 2: In the window displayed, enter the recipient address in "To"” textbox and press
“Send” button. The mail will be forwarded to the corresponding person.

Enter the receiver’s email id here

Google

Gersail -

Comtact Us:
Idien Raidwary Catening and Tooriam Corperton Lio

g Mo WO
Oniine Booking | WWww rcactoursm com

You harve iffosved thes mal bucause pou opted for getEng special sfers and Commenci prometions by el This mad has been sert om an uvmontsced mad sccount and hince
ploase do fot ragly 10 NS mal ¥ pou 20 100 wish 13 receive sech mals teply us o uaulncrine

- - - xyz@gmel com

Tow Package Cab  Accommodation  Toerkst Trakes ™
e “am ¢

- O B e o _
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Gemail -

@ | W rCICtOUrEm com

Ve hurva recenved B mal because you cpted for geting specisl olfers and Commmrcial proomotions by ermall This mal has baen sert hom an urmoniored mall account and bince
Plodse o NOL reply 50 s mal ¥ you 0 108 wish 10 receive soch mads reply us M aubacie

Bl O Type here 10 search

Select Send

Sorting and Searching emails
Here, we will discuss about how to sort and search the existing emails:
Sorting Emails

Sorting helps you to arrange mails or messages in an orderly fashion. It includes the
following steps.

Step 1: Click arrow adjacent to “Sort by date”, a default sort option visible at the top of
the window.

Click on Sort option for sorting

| nbox i : * Arughl Agraveal Fas o Urlock Macsmem Student Adeipticas & ]
® Arushi Agraveal Fred: BOCTE Air Buckagen Ex Ehopal [ H
= Areashi Agravsl Fretl: Braushi Suramanry of yowr Jugnes fide [1]
=]
G
-
| ]
L7
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Step 2: Click on any of the options from dropdown list displayed.

e Date: Sort in chronological order as per the date of received mail.

¢ Unread messages: Sort mails based on unopened messages.

¢ Attachments: Sort mails based on the size of attachments.

e Starred: Sort mails based on bookmarked or important messages.

e Sender: Sort mails in alphabetical order based on the sender’s name.
e Subject: Sort mails based on the subject.

Various options available for sorting

| Inbax ¥ & kel hgeawsl Fresk cop Unbock Macimemm Studant Admisiens [ P —— '""-e"_] -
# Arushi Agraws! Froci: ETE Rie Buchages Ex Ehopal 1 DI o0 1D I
& Anihi Mgrowsl Frd: Btisini_ Sursmary of i Jugnisd i ] -
E
n
i
L I
Gers
E 0 Type here 10 seanch

Searching Emails
Searching email is a process of finding the desired email without going through all the
emails.

Step 1: Type the name, email id or key-term in the search box displayed on top of the
window.
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Step 2: From the list of displayed mails, select desired mail or message.
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Select the desired email from the list
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Advance Email Features

Email provides many advanced features which includes sending attachments like
documents, videos, images, audio, etc. Apart from this, you can proofread your mail via
feature of spell check, address book, etc.

Sending document by E-mail

We can communicate with a person by sending and receiving emails. To send an email
with the document as an attachment, follow the steps below:

Step 1: Compose a mail providing "To” address, “Subject” and "Body” of the message,
then click on attachment(#) button and select “Attach files from computer” option in
order to add documents to the mail.
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© O Type here 10 search

Select Attach files icon

Step 2: In the window opened, browse document you wish to send and click "Open”
button.

E ¢ Tha PO ¢ Dusuveeis o v & + B & | §
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# Cpck scoem
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0 Type Bere 1o seard

Select a file
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Click on Open

Step 3: Document gets uploaded and will be an attachment to that mail. Finally click
“Send” button to send mail to the recipient.

« C a ™. QrOghe LOM * % i

The file is attached to the email

Activating Spell Check

Activating spell check helps to avoid spelling mistakes while inserting the body of the mail.
It includes the following steps:

Step 1: Start composing or creating a message by providing "To” address, “Subject”,
“Body” of the message.
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M Inbox (42) - annie.acro@ X e = X
& C | @ Secure | https://mail.google.com/mail/u/0/#inbox?compose=16314e37e1ba6d92 @ o

Test Mail

xyz@gmail.com

Test Mail

Hello!

SansSerif - | 4T~ B 7

Al D & B oo

Quick Launch

Step 2: The second step is to “Right click” on mouse and select “"Spell check” and from
the list displayed, select “"Check the spelling of text fields”, then the spell check feature
gets activated.

“ CcC & ) (M googhe COom

5

Right click and select Spellcheck
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i O Type here 10 search

Select Check the spelling of the text fields option

Using Address Book

Address book helps to add an address of recipient for future reference. Instead of typing
the address again and again this helps to include a recipient address from the address
book. The process includes following steps.

Step 1: Go to "Settings” at the top right corner of your web page and from dropdown
list, select “"Settings”.

Select Settings

€« C o« . gacgle cor
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Select Settings
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Step 2: Click "Writing email” tab and mark the check box that shows “Automatically
add new recipients to contacts”, now new addresses get added to the contacts or
address book.
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Scroll down and check mark this

Sending Softcopy as attachment

Softcopy is a digital document or a file that is stored in a computer unlike a written or
printed document like papers or notebooks. Attaching softcopy is similar to that of
attaching documents to the mail. The steps involved are given below.
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Step 1: Compose mail providing "To” address, “"Subject”, "Body” of the message, then
click on attachment (@) button and select "Attach files from computer” option in order
to add softcopy of a document to the mail.

Pl O type rere 10 senecn

Select Attach files icon

Step 2: In the window opened, select document or file you need to send and click "Open”
button.

) Type bere 10 sear:

Select a file
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Proture ’ B° Tusk bar

Fil e | Tunk bar

D) Trpe bere 10 search

Click on Open

Step 3: Once the document or file gets attached to mail, click "Send” button to send mail
to the recipient.

L] O Type here 10 search

The file is attached to the email

Handling SPAM

Spam is a folder where unwanted or suspected mails get stored.
Mark emails as spam

We can mark email as spam using the following steps.

Step 1: Select the email that you want to move to spam folder and click "Move to” option.
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Step 2: From the displayed menu, click any one of the following options.

v Report Spam - Unwelcomed/uninvited/unsought emails.

v" Report a Hacked Account - Emails from the contacts that are not usual or
normal.

v Report a Phishing Account - Emails from authorized concern, but are actually
meant to scam personal information.

v Not my mail - Email addressed to some other person.

Step 3: Now, when you check the spam folder, you can see the mail that you marked as
spam is added to the spam folder.

Mails in Spam folder

* Ancushl Agrawal Faed MCTC A Packages [ Bropal

® Anushi Agrawal Fue Arushl Surmmary of your Jugnoo ride

e
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Mark emails as not spam
We can mark emails as not spam using the following steps.

Step 1: Go to spam folder and mark the mail that you don't want to be displayed in the
spam folder.

Select the email to remove from the Spam folder
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Step 2: Click "Not spam” option at the top of the page.

Click on Not spam

L~ I ekl da S cadll -
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m
.' 5
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@
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Step 3: Now go to "Inbox”, you can see the email that you removed from the spam folder
is shifted to the “"Inbox” folder.
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The email is moved to Inbox
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Instant Messaging and Collaboration

Instant messaging is real time mutual communication between persons via internet. This
is a private chat. Once the recipient is online, you can start sending messages to him/her.
Unlike emails, where you have wait for the reply from the recipient, collaboration uses
instant messaging technique. This also supports the usage of add-on features like smiley
or emoticons with the text message. Examples of instant messaging applications include
Facebook, We Chat, Twitter, LinkedIn, etc.

Using Smiley

Smileys are otherwise called as emoticons. Emoticons are graphical representation of
emotions. There are 300+ emoticons in instant messaging. Emoticons are pictorial
representation of facial expressions that showcase emotions like happiness, sorrow,
crying, exclamation, etc.

Adding Smileys or Emoticons
To add an emoticon to the message, follow the below steps.

Step 1: Go to instant messenger and open your chat window.
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Step 2: At the bottom of chat window, you can see emoticon symbol, on clicking that, a
list or group of emoticons is displayed. You can choose the desired emoticon by selecting

it.
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Here are various types of emoticons

Internet etiquettes

o Internet etiquettes are also called as “Netiquette”.

e Netiquettes are basic rules or techniques which are accepted worldwide. For
effective communication through the internet, these are to be mandatorily followed.

e Some of the internet etiquettes are as follows:

Short messages

e Messages you send through internet should be short and to the point.

Spell check
e Activate spell check feature in your document to avoid spelling mistakes while

typing.

Mixed-case

e Instead of using a single case (either lower/upper) throughout the entire message,
try to use mixed-case. This increases readability.
e For example, start with uppercase letters at the beginning of a line and paragraph,
write the headings in uppercase letters and body with mixed-case letters.
Subject
¢ Always have a hint related to your content as a subject. The subject ought to be a
phrase rather than a complete sentence, providing the crux of email.

Carbon copy
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e The mail addresses of the important people who are intended to read the content
of email should only be added in CC (carbon copy).

Blind carbon copy

e You can go with ‘blind carbon copy’ option when you are broadcasting the mail,
especially among recipients who are unfamiliar.
e This avoids recipients from knowing other’s email addresses.

Name at the bottom

e Include your name at the bottom of every mail or message you sent.
e This helps to identify the sender, especially when you multicast or broadcast the
message.

Attachments to be small

o Keep the attachments small with respect to memory size, as it clogs (block) the
recipient’s mailbox.
e Try to avoid sending files larger than 2 megabytes.

Do not forward unwanted messages

¢ Avoid forwarding unwanted messages as well as the messages that do not belong
to you.

Abbreviations

e Use abbreviations wisely.

Send button

e As you cannot change anything mail once it is sent, think twice before you hit the
send button.

e Check whether you have conveyed everything in a formal language before hitting
the send button.

Summary

This chapter has given a clear idea about the electronic mail and its features. Thus, we
gained a deep understanding about the basics of email, email addressing, configuring
email client, using emails, opening email client, mailbox, creating and sending a new email,
replying to an email message, forwarding an email message, sorting and searching emails,
advance email features like sending document by email, activating spell check, using
address book, sending softcopy as an attachment, handling SPAM, Instant Messaging and
Collaboration, using smiley/emoticons and some internet etiquettes.
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7. Computer Concepts — Application of

Presentations

Microsoft PowerPoint is one of the powerful tools of MS-Office, which helps in creating and
designing presentations. PowerPoint Presentation is an array of slides that convey
information to people in an attractive manner.

In this chapter, we are going to discuss in detail about the applications of presentation
using Microsoft PowerPoint, opening and saving a presentation, creating presentation
using templates and a blank presentation, entering and editing text, inserting and deleting
slides in a presentation, preparing slides, inserting word table or an excel worksheet and
other objects, adding clip arts, resizing and scaling of objects, providing aesthetics by
enhancing text presentation, working with colors and line style, adding movie and sound,
header and footer, viewing a presentation, choosing a set up for presentation, printing
slides and handouts, Slide Show, running a Slide Show, transition and slide timings,
automating a Slide Show.

Using Powerpoint

You can create a new presentation by choosing File > New > Presentation.

Go to FlLE
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HOME WNSERT DESIGH TRAMSITRNS ARIMATIONS LLIDE SHOWW REVIEW VIEW |+
il . . " .
n | B = - i B i
| T B F U 5 aws - = -
Paste . P ) . § Drawing Editing
- F SEde~ 8 | A A A = -
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The image is inserted on the slide

Opening an existing PowerPoint presentation

To open an existing PowerPoint, select File > Open 2> Recent Presentations > and
select the presentation you want to open.

Go to FILE
ﬂ' ll—i - ® = Presentation] - PowerPoint T E - O X
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Saving a presentation

e To save a presentation, click on “File” menu and choose “Save” option.

e Every presentation will be saved by default as presentationl, presentation2,
presentation3 and so on.

e To change the default save location, select Save As > Computer > Browse.

e C(Click on the browse option to see a window where you can select desired location
to save the file.

e To rename the presentation, simply add desired name in the ‘File Name’ tag. Click
on ‘Save’.
e MS PowerPoint saves files with the extension (.ppt).
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Creation of Presentation

A presentation is made up of number of slides that are displayed in a sequence. Each slide
has sub-topics and different content related to the given topic.

Creating a presentation using a template

A template is a presentation that has a pre-defined theme and format. Templates are
readily available design structures. There are two types of templates: design and content
templates. A design template automatically gives final look of your presentation. The
content template is used to include text and graphics.

To create a presentation using template, select File — New — and select desired
template.
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New presentation with selected theme created

Creating a Blank Presentation

A blank presentation has no pre-formatted designs or colors. Every required
element in the presentation has to be created or inserted specifically by the user.
To create a blank presentation, select File — New — Blank presentation.
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Select Blank Presentation
Presentatsan « PowerPoint ?T = 0O X
Sagn i
Search for cnline mplates and themes o
Suggested cearches: | Preweniations  Business  Education  Industry  Themes  Pesonsl  Mabure
' C
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@ H = ) B s Presertationd - PowerPoint T® - 0 X
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Clipbosrd 1 Shdes font Paragraph Drawing v Editing -

Click to add title

Click to add subtitle

SUDELOF1 [I2 ENGUSH(UNITED STAIES) & NOTES W COMMENTS B s

Blank presentation created

Entering and editing text

e To enter text in a slide, insert a new slide.

e A slide has two sections:
1. Click to add the title.
2. Click to add the subtitle.
e In 'Click to add title’ box, delete the text and include desired heading.
e In'Click to add subtitle’ box, delete the text and add sub heading.
e Editing text refers to the changing of text size, style, color, indentation, etc.
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‘ ’ POWERPOINT
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Inserting and deleting slides in a presentation
To create a new slide, follow the below steps:

o Go to Home > New Slide or
o Insert > New Slide or

o Right Click over the slide > select New Slide.
Shortcut key to create a new slide is Ctrl + M.
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Customizing a Presentation

e Customizing a presentation can be done using Custom Slide Show options.

e PowerPoint allows you to start Slide Show from the current slide and also provides
option to hide some slides.

e To customize a Slide Show, Choose Slide Show - Custom Slide Show 2> New.

e Under existing slides, select slides you want to add to your Slide Show.

e Hold down shift to select a range of slides, or Ctrl to select non continuous slides.

e Here you can change the order of the slides in your Custom Slide Show by dragging
and dropping the slides under selected slides.

e Click ok button.

In SLIDE SHOW menu, go to Custom Slide Show option
|
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FILE HOME INSERT DESIGN TRANSITIONS ANIMATICNS SLIDE SHOW REVIEW ViEw STORYBOARDING Sign in
Y B k=4 = o - - 1 A V! Play N =

ic ’l B s . A e £ oy Neerations = Monitor: | Automatic
& &= &= -~ = 7! Use Tamings
From from Present Customn Side  SetUp  Hide  Rehearse Record Slide 3 U Dresanter View
Beqi . . 5 < > v Show Media Controls S
Beginning Current Slide  Online Show ~ K Slide Show Side  Timings  Show
Start Slide Show Set Up Morutort ~

Custom Slide Show

POWERPOINT
| PRESENTATION

SUDE1OF1 [ ENGUSH [UNITED SIRTES) = NOTES I COMMENTS | &2

250

@ tutorialspoint

EIMPLYEAEBEYLEARMING



BEHS O Fs Presentation? - PowerPint
_ HOME INSERT DESIEH TRANSITIING ANIMATIONS SLIDE SHOW REVIEW
= > P 1] Play Mairatsans
D T B & B o
From Fram Present Uide Setlp  Hide Rehearse Record Slide

Beginning Current Slide  Online ~ - Slide Show Shde
St Slide Show | fi= Cumtom Shows...

BEH® O 5 -

Timirgs  Show -

1 Shew Medsa Controls.
S#Up

POWERPOINT
PRESENTATION

WELDORE TO POERPOINT

VIEW STORYEOARDING
[ﬂ"nm«-. Autormatic

| s Presenier View

Mhanilad

HOME INSERT DESIGN TRAMNSITIONS AMNIBMATIONS SLIDE SHOW) REVIEW
T= - } 4 Hide 5li (] Manhtions
> 'IE 3 o Hide Slide Play
& r EE[ [T Rehearse Timings [+ Use Tim
Fram Fram Present Custom Shde Set Up J ) o )
Beginning Current Siide ' Online~  Show= | Slide Show &2 Fecord Slide Show = [ Show Controls
Start Slide Show St Up
i
Custom Shows ¥ =
, o
] Eda..
(]
Bemave
Copy
Show Clase

SLIDE 1 OF 2 EMGLISH [LANITED: SEATES

WELCOME TO POWERPOINT

W COMMENTS

Computer Concepts

o x
Sign in

¥

= - 5
VIEW  STORVEQARDING »
il

Manitars

o
[~]
+
¥F

. tutorialspoint

EIMPLYEAEBEYLEARMINIEG

251



Computer Concepts

Check mark the slide
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The slide is added in custom show. Select OK
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Preparation of slides

The below topics explain the preparation of slides:

Inserting a word table or an excel worksheet

e We can insert a word table in PowerPoint using “Insert” menu.

e To insert the table, first create a new slide.

e Then click on “Insert” menu and select the “Table” icon. Select the number of rows
and columns.

e Press Enter.
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In INSERT menu, select table
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Enter data in the table
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Inserting an excel worksheet

We can insert an excel worksheet in PowerPoint using “Insert” menu.

First, create a new slide.

To insert a new excel file inside the presentation, click on insert menu and select
Object icon — Create New — Choose the object type as Microsoft Excel
sheet — click Ok.

To insert an existing excel file, select Create from file — Browse.

Finally, select the excel document you wish to insert and press enter.
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In INSERT menu, go to Object
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Click OK
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Adding clip art pictures

e Clip art is a cartoon-like icon or representation.

o Select Insert — Online pictures.

e In the dialog box, enter category and select the picture you want to insert.
e Click on Insert button.
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In INSERT menu, select Online Pictures
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Select the object from the search results
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The image is inserted in the slide

Computer Concepts
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Inserting other objects
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e You can insert existing objects in a presentation by clicking Object icon in the
insert menu.
e Select Create from file option and then select Browse button.
o Select the file you want to insert and click Ok button.
o If you want to link the file, select the link check box.
e To display the file as an icon, checkmark ‘Display as icon’ check box and click Ok
button
In INSERT menu, go to Objects
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Select Create from file
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Inserts the contents of the file as an object into your
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. -
The file will be inserted

B E % OF:s Presentation’ - PowerPol 7 3B - 0 X
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Resizing and scaling an object

ENGLISH [UNITED STATLES)

= NOTES I COMMENTS

First we will learn how to resize an object below:

resize handle around the outline.

usually present at top of the object.

In INSERT menu, select Shapes
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Presentation5 - PowerPaint
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Comments

Texk

W COMMENTS
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To resize an object in presentation mode, select the object, then click and drag on

You can rotate the selected object by clicking and moving rotate handle which is

T M - 0 %
Sign in|
o
] €9 o
Video dudic Screen
Begording
Meda -

-— % 4%
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mas-arpa Presentations - PowerPort T ® -0 X
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Rotating handle
@ H - G F s Presentations - PowerPoint DeEN.. 7T M = A X
HOME INSERT DESGH TRANSITIONS ARIMATIONS SLIDE SHOW REVIEW VIEW STORYBOARDING FORMAT Sign iny
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kIR S - 5 | () Shape ENscts = 7| e | GhSelectionPuns ke | w277

Indert Shapses Shape Shybes ] WAt Styles i Arrange Sire oA
1

L] 5

Resizing handle

Next, we shall leran how to scale an object:

e To scale an object in the presentation mode, select the object.
e You can change the height and width of the selected object by right clicking on the
Size and Position option, and change values accordingly.
B H S O 13- Presentation3 - PowerPoint 7T M - 0O X
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Clipboad 5 Stides Fort " Paragraph L _):_). lz 9 % Editing -
1 - Style  Fill  Outhne
Cu
'7.’;‘ Copy
T Paste Options:
-~ -~
0l
E] EdtTen
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2
Save as Picture. T
Set as Default Shape '
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Set the scaling factor here
BHEHS O F Frsertabion! - Fowerfoet DHAARNG TO0H5 T m - 8] x
_ MOME  BEERT  DEBGM TRANGITHNG  AMIBATIONS.  SUDESHOW  REVIDW  WR SI0EVROARDNG FORLAT fonn
E T I, i Shape - -| Lxupel - A TeaFa- ; B | e
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1 Format Shape L]
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< U OE
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gt s
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T ke Yeauh 0

Lack gepes maii

Fsmnon
XY BOX
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Providing Aesthetics

This feature helps our Powerpoint presentation to look more attractive and interesting.

Enhancing text presentation
Enhancing text can be done by altering font style, font color, font size, and using font case

options.

Font Color
e Enhancing text can be done using “font color” from “Home"” menu.

e The text will be displayed in the color you have selected.
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Font Style

e Enhancing text can be done using “Font Style” from "Home"” menu.

e You can change font styles of the text by selecting from the list of options in the
drop down menu.
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Font Size

e To increase or decrease the font size, use “font size” option from “*Home” menu.
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Highlight Text
e To enhance the text style, you may select either bold or italic.
e You can also highlight your text using the underline option or text shadow.
e Shortcut key for underline is “Ctrl + U".
e Shortcut key for bold is “Ctrl + B”.
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Shortcut key for italic is “Ctrl + I".
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Font Case
You can highlight the text by changing it to upper, lower or mixed case.
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Working with color and line-style

Draw shapes and fill color, follow the below steps:

e To draw a shape, right click and select Fill option.

e Fill with the desired color.
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Background color

Giving background color to PowerPoint image makes the presentation more appealing and
beautiful. To apply background, go to Design menu and select Color option.

In DESIGN menu, select More drop down arrow.
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Line Style

e Aline is termed as a connector between two points.

e In order to insert a line in your presentation, go to Home > Shapes and select
the desired line style.

e Now you can draw line on the slide pane.
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Adding movie and sound

e To insert a movie or audio in a slide, go to Insert video or audio options and select
audio or video file you want.

o The inserted audio or video file will be displayed in your slide.

In INSERT menu, go to Video
n H % = Frovesissent Possarifosnt T m g
n HOWE 3 L T AMIBRATHINS, SLADH FEVEW I SHHYROARDRG Sgnn
o - = ™ ] l e Aq a| B d *: -
s sk | whra Wreswbo Phota | Shapes Smathn Chat | gmae oy e it B B pact  epastias weo Audc  res
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SE3E Dbiet magel WA TaL ddara d presrh Pt [y [T &
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@ Insert Video

4 | | « admin » Desktop » minor project

Organize « Mew folder

L
B This PC

P 3D Objects e

B Desktop it f
E—ﬂ Documents E
4 Downloads minor final
J! Music

[=] Pictures

@ Videos

‘s Local Disk (C:)

am Local Disk (E)

- Local Disk (F2)

¥ Network v

w O Search

=
rinor project 2

=~ [ 0

File name: | ARcade

<« » mu 4 ™

e To play a video or audio file in the presentation, follow the steps below.

1. Open the slide that contains the video or audio file.
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2. Click play from playback menu.

FE ©- C 7 = Presentation3 - PowesPoint T m - 0 X

[+ “:INSER'I DESIGN TRANSITIONS ANIMATIONS SLIDE SHOW REVIEW VIEW STORYBOARDING FORMAT PLAYBACK |+

s i ¥ [ -
’ E" 2% [:::' Fade Duration L ‘\\ E‘» Start: |On Click (7] Loop until Stopped
o A = [ Fadeln: 0000 o || Play Full Screen
oy emove nm groem— ume N | Rewin i
Bookmark Bockmark | Video B FadeOut: (0000 2| . Hide While Not Playing ) i
Preview Bookmarks Editing Video Options
<k AL o L n =

Preview Media

Preview the audio or video clip with
2ll of the formatting changes you
made,

]
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Sresentation) - Powerfont VL0 V0L Tm -8 X
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e You can also use playback menu to explore options such as: Play Full Screen, Hide
While Not Playing, Loop, etc., as well as adjust volume or mute playback of the

file.
BHEHS 0OF-: Presentation3 - PowerPoint 2 mo- OX
IRl [nserr  oesion  TRANSITIONS  ANMATIONS  SUDESHOW  REVEW  VIEW | STORYBOARDING  FORMAT | PLAYBACK |+
-y ¢ Start: |On Cli -
lI [2_.. * - Fade Duration 4\ B start |On Click Loop until Stopped
2 oy 6 o= [@radein 0000 G| M ) play Full Screen
ause lemave m  prapmcommy | ume ) . 1 Rewind aft
Bookmark Bookmark | Video B FadeOut: (0000 11/ . Hide While Not Playing S i Piyiog
Preview Bookmarks Editing Video Options ~
. A R
Loop until Stopped &=
Repeat the audio or video clip until
it is stopped.

e Current playback position in the file is indicated on horizontal slider.
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e Use the vertical slider to adjust the playback volume.
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No¥  Face Ounten 1‘\ *) St On Cher * 1 Conpott$
= L8 Pade i 0000 Py 1l Screen
Tom - Vedume
Ve ElfedeOwe 000 - . e Wiske Pt Py Fuibel e Payng
Latng Vo Optsom -

e Video files provide zoom-in feature which can be selected from “View” menu.
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In the VIEW menu, select zoom option and the percentage of zoom required.

@S 6F. e

2 ENGUSH UNITED SWER

Click on OK

Zoom to the entered percentage is applied

t (2 ewauss Mo swes

o PowerPoint enables to see the preview of audio or video files.
e To preview the file, go to Animations > Preview.

281

@ tutorialspoint

EIMPLYEAEBEYLEARMING



Computer Concepts

3E 5 0%, Freventation’ - Pomert et VIOL0 0ot TM -8 %
MOME  NGIRT  OFBGN  TRANGTIONS  ANMATIONS  SUDESIOW  BOWW  VEW  SIODROADNG FORMAT  PLAYBACK Sgnn
* ' .I . » * i’ * W * T Aremitrnn Pare b San OxChah Reosder 2evrrateon
: s Trgges + ‘Ouaton Ao . & Mow luber
Tay Faan Yoy 2ppem facke o ey Aad - c

Aeiomaton + B Armstion Paster (¥ Dty 008 I ¥ Meels
Pevem At % sounies dneatcn Ty ~

Program Example

We will look at the following example:

Aim:

To create a simple presentation with at least 5 slides to introduce a friend and include
audio in slides.

Procedure:
e Boot the system under Microsoft Windows 2013.
e Click Start > Program > MS-Office > MS-PowerPoint.
e Once you open PowerPoint, choose the type of presentation you want.
e Select the desired presentation style in creating a new presentation window and

click ok button.

Enter information about your friend.

e Right click on the empty space on the slide, select background color and click
“Apply”.

e Select Slide > Transition.

e Select an effect and click Ok button.

e C(Click Insert - Audio, select a file to insert and press ‘ok’.

e Click the first slide and drag the mouse to select all the slides.

e Run your presentation by clicking on the Slide Show or by hitting F5 key.

Result:

e Thus, a simple presentation to introduce your friend is created.
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Adding headers and footers

e You can add headers and footers to the presentation.
e To insert headers and footers to the presentation, go to Insert menu > select

Header and Footer icon.
e You can include or exclude the time and date, slide number and footer information

in the slide.
e Make changes and click the option “Apply to all” to save the changes.

Select Header & Footer option in INSERT menu
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Select the desired options and click on Apply to All

Hamder nd Fooker

ROot1ors (B peGUss unanmD SR

Presentation of Slides

We shall learn various features present in

Viewing a presentation

e Viewing pane is very similar to other application windows.

e It has a menu bar at top of the window which displays toolbar with shortcut icons
for the most frequently used options.

e Status bar at bottom of the screen displays the status information, such as number
of slides, current slide, word count, etc.

e Middle pane displays slides in the presentation, as you can see this section contains
three panes.

e The panel on the left displays a thumbnail image of the slide and allows you to
rename, delete or rearrange them.

e The panel in the center allows you to view the slide presentation.

e The panel on the right displays formatting options for the selected object.
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Choosing a set up for presentation

e In order to select set up for presentation, go to Slide Show and select set up Slide

Show option.
o In the window displayed, make the changes accordingly and save the changes by

clicking “ok” button.
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Make the desired changes and click on OK

Set Up Show ? *
Show type Show slides
@ Presented by a speaker [full screen)! @ All
() Browsed by an individual [window] ) From: 1 10 |20 E

O Browsed at a kiosk [full screen) Custom shaow:

Show options

|:| Loop continuously until "Esc’ Advance slides
|:| Show without narration

O Manually
[] show without animation -

@ Using timings, if presqnt
|:| Disable hardware graphics acceleration

Pen color Q - Multiple monitars
| - I & slide show monitor:
aser pointer color: -
2 Automatic e
Resolution:

Use Current Resolution

Use Presenter View

L J

Cancel

Printing slides and handouts

e To print the slide, click File & Print.
e Print preview option helps to preview the page before you print it.

Select Print
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Print

Printer

Mucrosoft Print to PDF

% Ready

Printer Properties

Arcade

Settings
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Creating and Printing Handouts

o Handouts are the printed form of presentation.
e If you want to provide handouts, go to File - Print.

e Handouts contain both individual slides and space for notes. These are very helpful
presentation aids.

e Click handout master in view menu to preview the handout.

e Choose a layout to specify how many slides are to be printed on a single sheet of
paper.

In VIEW menu, select Handout Master
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Eglamour - PowerPoint ?7 - 0 X
Sign in

Print
=

Copies: |1 > -

Print

i

Printer
Mecrosoft Print to PDF

@ Ready

Printer Properties

Settings
s Print Al Shdes
= Print entwe presentation
Shdes:
1 Full Page Shdes
Account ¥
Print 1 shde per page A
PATTNE omcom,  Collated
Options r:_}[_-] ; pe 2 - X
123 123 123 v (1 o0 6% - —4 ‘ +

Slide Show

o Slide Show view of the presentation is used to display content of presentation to
the audience.
e Editing is not possible in the Slide Show view.

POWER POINT
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Running a Slide Show

e To start the Slide Show from the first slide, click on “From Beginning” icon from
Slide Show menu.

e To start the Slide Show from the current slide, click on “From Current Slide” icon
from Slide Show menu.

In the SLIDE SHOW menu, select From Beginning option

Q H ©- O & s Presentation5 - PowerPoint 7 B - 0O X
HOME INSERT DESIGN TRANSITIONS ANIMATIONS SUDE SHOW REVIEW VIEW STORYBOARDING Sign iny
! T = [ 3 1 6 > y -

i () " y J':::» ?T S:‘ i | "?'I, o) ¥l Play Namations =" Monitor: |Automatic

oy k e = e e R - ' ! Use Timings

From From Present Custom Shde SetUp Hide Rehearse Recoed Slide 7 Use Presenter View

- yo . ¥ Show Media Controls
Beginning Current Slide  Online Show Stide Show Slide  Timings  Show
Start Shde Show SetUp Monstors ~

Start From Beginning (F5)

Start the show from the first shide

POWER POINT

SUDETOF2 [ ENGLISH (UNITED STATES) = NOTES W COMMENTS B

Transition and slide timings

First, we will learn the Transition feature:

e Click on “Transition” menu and select “"Transition style” from the listed options.

e You can click on the arrow key to expand the gallery and check all the options

available.

To apply transition on the slide, double click on desired option.

Press “shift + F5” from keyboard to switch to full-screen mode.

To exit full-screen, press Esc key.

You can edit selected transitions by using “Effect Option” from “Transition” menu

and select option from the list.

e You can preview all the changes by clicking on preview icon in the top left side of
screen.
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In the TRANSITIONS menu, select the desired transition
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Automating a Slide Show

Automation of Slide Show can be done in two ways.
Using transition settings

e Select each slide and go to transition menu and select transition type for each slide
and run the presentation by pressing “F5” key.
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In the TRANSITIONS menu, select the desired transition
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POWER POINT IS A

VERY POWERFUL TOOL

Using Rehearse Timing

e Open the presentation in which the timing has to be set.

e Go to Slide Show menu > Rehearse Timing.

e Press F5 to run the slide. When the Slide Show starts, you can find the rehearsal
toolbar at the top left corner of window.

e Move to the next slide manually to record timing and press ‘yes’ button to record
the time.

e Now, if you run your Slide Show, you can notice that it runs automatically with the
time intervals you have saved.
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In the SLIDE SHOW menu, go to Rehearse Timings
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Rehearse Timings

Practice makes perfect. Start the
full-screen slide show to figure out
the perfect timing for each shide

As you rehesrse your presentation,
PowerPomnt will record how much
time you spend on each slide. Once
you get the timings nght, you can
use them to run the show
automatically

OIN

ENGLISH (UNITED STATES) NOTES W COMMENTS E

POWER POINT

Changing Slide Order

e To change order of the slides, click on “Slide Sorter” in the “View” menu.

e In this mode, all slides in the presentation are displayed as thumbnails.

o Click on the slide you want to move and drag it with the mouse to the desired
position.
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In VIEW menu, select Slide Sorter option
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Example Program

We will look at the below example to understand the concept clearly:
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Aim

e To create a simple presentation with at least 5 slides on the essay, “An astrologer’s
day” by R. K. Narayan.

Procedure

Boot the system under Microsoft Windows 2013.

Click start > program -> MS-Office > MS-PowerPoint.

Once you open PowerPoint, choose the type of presentation you want and click Ok.
Select Insert > Text box.

Draw the text box in the slide and enter information about the essay, “An
astrologer’s day”.

Right click on the text box and select custom animation in it.

Select an effect and click ok.

Right click in the empty space of the slide.

Select background color and click apply button.

Click Transition — select an effect and press ok.

Click the first slide and drag the mouse to select all the slides.

Run your presentation by clicking on “From Beginning” option from Slide Show or
by pressing F5 key.

Result

e Thus, a simple presentation for the essay “An astrologer’s day” by R.K.Narayan is

created.
BHS O3+ Presentation? - PowerPoint 7 E - x
HOME | INSERT ~ DESIGN  TRANSITIONS  ANIMATIONS ~ SLIDESHOW  REVIEW  VIEW  STORYBOARDING Sign in
= ¥ Cut g [ElLayout - - A ER RS |{} Text Direction B~ OoO DD £» Shape Fill i Find
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Summary

In this chapter, we have clearly learnt various concepts in PowerPoint presentation such
as opening and saving a presentation, creating presentation using templates and a blank
presentation, entering and editing text, inserting and deleting slides in a presentation,
preparing slides, etc.

297

EIMPLYEAEBEYLEARMING

@J . tutorialspoint



8. Computer Concepts — Application of Digital

Financial Services

In today’s world, everything is digitized, which means we can access or get every service
in digital format through mobile phones, computers, tablets, etc. The invention of
computers and smartphones has created a huge impact on financial services. Today using
computers and mobile phones, a person can access his/her bank account, verify account
details, transfer funds, deposit cash, renew deposit, pay bills, book tickets, etc. Also, the
invention of ATMs reduced the time taken to withdraw money from banks. Digital services
help to save time by providing services in a single touch. The introduction of digital wallets
has also made a big positive impact on financial services.

In this topic, we are going to discuss in detail the importance of savings, importance of
bank, banking products like accounts, deposits, loans, procedure for opening an account,
banking services through a bank branch, ATM, internet banking, mobile banking, mobile
wallets, insurance and various schemes introduced by the Prime Minister of India.

Why are savings needed?

Savings is the percentage of income which is not spent on present expenditures, instead
conserved for future use. Being totally unaware of the future happenings, one should be
ready to face any kind of unpredictable events. In such tough situations, our savings will
be very helpful and beneficial to us.

Emergencies

Emergencies may come at anytime and we should always have a backup to handle such
situations. Some examples of emergencies from our day to day life are:

e Personal and family health issues.

e Loss due to sudden natural calamities like flood, earthquake or cyclone, etc.
e Loss due to theft or any other unanticipated events.

e Sudden financial help for friends or relatives.

e Unplanned trips or any other plans.

Future Needs

Few future needs are listed below:

Retirement

The main purpose to save money is for your retirement. The earlier you start saving for
retirement, the less you have to save in future. Saving for retirement makes you self-
dependent and financially secure.

Own a property

Everyone dreams of owning a house. Though it is not an easy task, saving from early
stages can help in fulfilling this dream.

Own your own vehicle
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In today’s scenario, transportation has become difficult in metropolitan cities. To explore
places with ease and comfort, a person needs a car.

Education

Cost of education has become a burden these days, especially for higher studies. In order
to attain higher degrees, one should save money.

To rescue debts and large expenses
We should start saving to deal with large expenses like:

e Buying property: house or land

e Buying vehicles

e Buying gold or expensive jewelry

¢ Handling emergency needs like health-related issues
e Going on a family tour

e Facing complex situations during natural calamities

Drawbacks of keeping cash at home

Here, we list certain drawbacks of maintaining cash at home:

Unsafe

It is unsafe to keep cash at home as there is a chance of theft or robbery.
Loss of Growth Opportunity

Keeping cash at home causes huge loss to the country’s economy as it does not participate
in national growth.

e Recurring Deposit - It is referred to as a monthly deposit for particular period of
time for which the interest will be provided by banks to their customers.

¢ Fixed Deposit - It is bulk amount deposited by the customer for a fixed period of
time, i.e., an year or two.

e In any of the schemes provided by banks, there will be profit.

¢ We can even earn interest or dividend by depositing our money in saving bank
account.

No Credit Eligibility

e A person should have minimum balance in savings account to apply for credit cards
or loans.

e If we save money at home instead of banks, we can’t avail the credit facility
provided by the financial institutions during tough times.

Why is bank needed?

Bank is an official financial institution that accepts money from public and lends money to
public.

Secure Money, Earn Interest, Get Loan

Bank functions in various ways. Few of them are listed below:

Secure Money
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e Bank helps to save our money very securely.
e Loading all your cash at home isn't safe.
e You can loose your money in situations like fire, flood or earthquake

e In order to avoid the scenarios given above, we need a bank.

Earn interest

Banks provide us with interest if we save money through RD and FD. In any of the schemes

provided by the bank there will be an opportunity of growth in our money.
Get Loan

Bank will provide several kinds of loans if we satisfy the criteria issued by a bank and

submit all necessary documents. Types of loans provided by bank are:

¢ Home Loan - Home loan is the money lent by banks to buy properties at a certain
rate of interest to be paid every month as EMI.

¢ Personal Loan - Banks provide you with personal loans for marriage, emergency
periods, etc.

¢ Jewel Loan - Banks provide you with jewel loans where you pledge your jewelry

to get loan.

Remittances using Cheque and Demand Draft

Remittance is defined as the transfer of money or funds from one bank to another, either
the same bank or different. Remittance can be done using Demand draft by Cheque, Pay
slip, Mail Transfer, etc. A demand draft or "DD" is a popular mode of money transfer,
where most of the banks in India use this for the effective transfer of money. Demand
draft is usually issued on request of the client, for bill payments, and for transfer of
property of deceased to legal heirs, etc. DD form requires the following details to be filled
by the customer:

e Type of instrument needed.

e Receiver's Name.

e Transmitter's Name.

e Total amount to be transferred.

e The bank or location where the transferred money is to be funded.

e The way money is to be paid, i.e. in “Cash” or through a “Bank Account” in which
you will pay money, i.e. in cash or by debit to your account.

e You should submit form along with cheque or cash.
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Avoid risk of Chit Funds and Sahukars

Using banks to save money, we can avoid the below stated risks:
Chit Fund

Chit funds are local bodies which help to save money. It is run by one or more people of
that area. Chit fund is purely based on trust. It is easy to join the chit fund because no
proper background is needed except some paperwork. If you deposit money in chit fund
you can take out that money whenever you need. Instead, in banks you must wait until
the time period get completed.

Risk in saving money in chit funds or Sahukars

e Chit funds are not authorized parties to deposit money.

e People who are running chit funds can wind up their chit fund if they wish to do so.
e There are chances of loss or theft of money.

e There is no security or assurance for the money you deposit in chit funds.

e There is a chance that the fund manager disappears with mass amount.

e A member could disappear after winning the first bid.

Banking Products

We shall learn various banking products:

Accounts

An agreement with a bank, where an account holder can deposit and withdraw money or
savings as needed.

Types of Accounts

There are three types of accounts avaliable, namely:
Personal account

Account that represents an individual or an organization is termed as “Personal account”.
Examples: Mr. Rama’s account --> Individual persons account; Samsung’s account =-->
Organization’s account.

Real account

The account that represent tangible assets, that is, which can be physically sensed, is
termed as “Real account”. Examples include: cash, goods, stock accounts, etc.

Nominal account

Account that represents expenses and incomes is termed as "Nominal account”. Examples
include: salary, loss of asset accounts, etc.

Deposit

Accumulation of money in the bank is termed as deposits. There are two types of deposits:
Time deposit and Demand deposit. Time deposit is defined as money deposited for a
particular period of time which cannot be withdrawn before the time gets lapsed.
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¢ Fixed deposit- A bulk amount is deposited for a fixed period like a year or two
years etc.

¢ Re-investment deposit- Interest is accumulated quarterly and paid on maturity.

¢ Recurring deposit- Fixed amount is deposited at regular intervals like a month or

quarterly etc.
Demand deposit is the scheme where the customer can withdraw money on demand

without earlier notice to the bank. Demand deposit may or may not provide interest to the
customer. Examples of demand deposits include current account and a savings account.

Types of Loan and Overdrafts

Loan is termed as the fund lent to a person on having a promise that he/she will return
the money within a certain period with interest. Loan falls under the following categories.

Secure Loan is a loan where the borrower pledges any of his/her assets like house, land,
jewel or any of the belongings as security. The financial institution has a right to sell these
if repayment is not done on time.

Unsecure Loan is where the borrower does not submit any of the belongings as security
to the bank. The example includes peer-peer lending, personal loans, credit debts, etc.

Demand Loan is a loan where a person borrows money on demand. It doesn't fix return
time.

Educational Loan is money borrowed to support one’s education. He/she doesn’t have
to repay the money while studying.

Personal Loan is a loan that is borrowed based on personal interest for marriage, world
tour, other expenses, etc.

Commercial Loan is lent to an organization for improvement purposes.

Overdraft

An overdraft is a condition that occurs when a person attempts to withdraw money from
zero balance account. The types of overdraft include:

e Secured Overdraft- Secure overdraft is where the customer pledges any of
his/her assets to bank as security.

¢ Unsecure Overdraft- Unsecure overdraft is the one where the customer does not
submit any of the belongings as security to the bank.

Filling up of Cheque, Demand Drafts

We will separately learn how to fill cheques and demand drafts below:
Filling up of Cheque
You must provide the following details while filling a cheque.

1. Write date at the top right corner of your cheque.

2. Write name of the receiver to whom the cheque is to be encashed.
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3. Write the amount both in numbers as well as words.

4. Put your signature at bottom left corner of the cheque.

Sample Canadian Cheque
Enter name of person or business to Cheque Number
whom payment is being made >
Your name g !
and address —_— -
I~ 123 CEDAR ST,
TORONTO, ON MSK 384 OATE Date
0O 0O M N Y ¥ Y VY
$ Numeric
IO J 5 dollar
i A‘azmnma o amount
Scotiabank THE BANK OF NOVA SCOTIA e e
branch ——— SCOTARAZA Written
2, 5 TREET VAT BAY — ;
address w:«unom}) N 1Y - dollar
= = e amount
Payment ~F
description ¥020* 1300000=002:F 00000000000 B Your
L—..J; l—f—| ! ‘—1’ ‘— signature
Cheque Scotiabank Scotiabank Your Scotiabank

Number Transit Number Institution Code Account Number

Filling up of Demand Drafts

You must provide the following details while filling a demand draft.

e Type of instrument needed.

e Receiver's Name.

e Transmitter's Name.

e Total amount to be transferred.

e The bank or location where the transferred money is to be funded.

e Mode of transaction, i.e. in “Cash” or through a “Bank Account” in which you will

pay money, i.e. in cash or by debit to your account.
You should submit the form along with cheque or cash.

wite vz #w
p— mo Bank of India g Key: TABKIS j(‘ “‘ r(',E” 5 To u“ 1‘3"
wsuing Beanch MADHAVADHARA BRANCH st v B, Mo 304§ D T T
1 ICODE No 12630 DEMAND DRAFT -~ il
1.0851.2

2 8 |
i o SRR CHIEF MINISTER OF DELH) **eesresesensesesrsssssrssssresses] 201, o ST ST =
f et ‘ ¢ OR ORDER —
| TR RUBEES™ ™ TR T )
i = T g 4|
. . 7 |
- POI 000232505203 Key. TABKIS Sr.No: 384108 ANOUNT BELOW 385(03) b Gl lVN.LE.R!:CEN'tD | 3‘
i s 2 |

wrdra w2 i —

STATE BANK OF INDIA A R

aenor » VRN DRAWEL BRANCHNEW DELH N BRANCW

e mlnmx :::m“:o::o:: Y ¥ AO00E No: 0069t iy il

* "\
L~

| *59E 203 -|oa3o: 20001 GO0 3 2
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Documents for Opening Accounts

You need the below documents to open account in banks:

Know your Customer (KYC)

Know your Customer is a process in which banks acquire details about the identity and
address of the customers. It is practice accomplished by banks when you open an account
with that bank. Banks in regular intervals will update their customer details. The KYC
process helps to make sure that the bank services are not misused.

Photo ID Proof, Address Proof

RBI issues a certain norm to be followed while opening an account. One of that is KYC
during account opening. We should be providing ID proof and Address proof during the
KYC process.

e ID Proof - KYC process accepts Voter ID card, Aadhaar Card, Driving license,
PAN card, Passport, etc., as ID proof.
¢ Address Proof - Ration card, rental agreement, gas book, telephone bill, voter

ID, Aadhar card, etc., are accepted as address proof.

Indian Currency

Indian currency is issued by “Reserve Bank of India”. Indian rupee is the official currency
of India. The word “Rupee” is the derivative of the Sanskrit word “Rupya” (meaning silver
coin). It is denoted by the code “INR”. We have 10, 20, 50, 100, 200, 500, 2000-rupee
notes and 1, 2, 5, 10-rupee coins.

Banking Service Delivery Channels -1

We shall learn different banking service delivery channels in this section:

Bank Branch and ATM

Bank branch is one of the easiest and simplest ways of providing banking services. Every
area has one or more bank branches depending on the space coverage of the area through
which we can access bank services. We can go to the branch physically and avail services
like money deposit or withdrawal, salary update, pension withdrawal, etc.

Automatic Teller Machine has reduced lot of human workload. This is one of the cheapest
sources of bank delivering 24/7 service. This facilitates us with the service of money
withdrawal. We also have cash deposit machines, passbook update machines, etc.

Bank Mitra with Micro ATM

Bank Mitra is also called as “Customer Service Point”. Mitra provides services like account
opening, cash deposit, cash withdrawal, fund transfer, etc., and is a representative of mini
bank which provides services to rural areas. It especially provides services to villages
where no bank branches are available.

Point of Sales
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Point of Sales (POS) support for real-time transactions. Suppose if you are purchasing
anything in shops and decided to use your debit card, the consumer will be having a POS
machine in which your debit/credit card is swiped to deduct the amount for your purchase.
This provides cashless transaction facility.

Banking Service Delivery Channels - I

This section deals with online delivery channels:

Internet Banking

Internet banking helps to save your time by providing digital services like:

Transfer funds from your account to another account.
Verify your bank account particulars and statements.
Make payment of utility and credit card bills.

Open and renewal of fixed deposit account.

A W

Recharge and payments of daily needs like prepaid mobile/DTH, train bookings

or bus tickets, etc.

National Electronic Fund Transfer (NEFT)

National Electronic Fund Transfer is a nationwide fund transfer system formulated and
maintained by RBI. It helps to transfer funds between customers of the bank across the
country. It was started in the year 2005. NEFT follows batch wise fund transfer process
that it works from 8.00 AM to 6.30 PM on Monday to Saturday excluding 29, 4t Saturday
and government holidays.

Real Time Gross Settlement (RTGS)

Real Time Gross Settlement (RTGS) is a real-time electronic fund transfer system between
banks. Unlike NEFT which follows a batch process, RTGS helps to transfer funds in real-
time and gross basis. Real-time settlement refers to that there is no waiting time for the
money to get transferred. Gross refers to one-to-one transaction. The minimum amount
to be transferred through RTGS is 2,00,000 rupees. Apart from money this helps to
transfer securities (tradable financial asset).

Immediate Payment Services (IMPS)

Immediate Payment Services (IMPS) was launched in the year 2010. IMPS is available
24/7 and even on holidays. IMPS is managed by National Payments Corporation of India.
It offers interbank electronic fund transfers and it is accepted by almost all banks and
financial institutions.

Insurance

Insurance is an agreement to deliver a compensation amount by the financial institution
for certain loss, destruction, ailment, or demise in return for payment of a specified
premium.
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Necessity of Insurance

Insurance is protection for financial loss and provides medical support in case of severe
ailments. It provides safety and security to human life as well as business. It generates
financial resources, encourages savings by investing regular premium and promotes
economic growth by mobilizing domestic savings. Insurance. Insurance accelerates
economic growth by collecting and investing funds in industrial development. Insurance
helps to get loans. Insurance helps in medical emergencies.

Life Insurance and Non-Life Insurance

In the subsequent section, we shall discuss various about various Life Insurance schemes
and various other schemes:

Life Insurance

An agreement to deliver compensation amount by the financial institution on demise of an
insured person in return for payment of a specified premium.

Necessity for Life Insurance

e To give heirs a financial support after a person’s demise.
e To protect your family and loved ones.
e To pay off debts taken by you.

e To support uncertainties in life.

Non-life Insurance

General or non-life insurance saves individual against uncertainties, loss, destruction and
damage caused by natural events.

Necessity for Non-Life Insurance

e It provides peace of mind to the insured person or business man.

e It replaces lost income, destroyed property or damaged objects.

Pradhan Mantri Jan-Dhan Yojana (PMJDY)

Pradhan Mantri Jan-Dhan Yojana (PMJDY) is launched by Prime Minister of India, Narendra
Modi on 28 August 2014. PMIDY is a National Mission for Financial Inclusion to ensure
access to financial services, namely, Banking/Savings & Deposit Accounts, Remittance,
Credit, Insurance and Pension in an affordable manner. Account can be opened in any
bank branch or Business Correspondent outlet. PMIDY accounts are being opened with
zero balance. However, if the account-holder wishes to get cheque book, he/she will have
to fulfill minimum balance criteria.

Benefits of PMJDY

e Interest on deposit
e Accidental insurance cover of Rs. 1.00 lakh

¢ No minimum balance required

&
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e Life insurance cover of Rs.30,000/-

e Easy transfer of money across India

e Beneficiaries of Government Schemes will get a direct benefit transfer in these
accounts.

e After satisfactory operation of the account for 6 months, an overdraft facility will
be permitted.

e Access to pension, insurance products

e Accident insurance cover, repay debit card must be used at least once in 45 days.

e Overdraft facility up to Rs.5000/- is available in only one account per household,

preferably lady of the household.

Social Security Schemes

There are lots of social security schemes launched by the Prime Minister "Narendra Modi”.
Some of the important schemes are described in detail below.

Pradhan Mantri Suraksha Bima Yojana (PMSBY)

The scheme offers to provide you or your family a cover of up to Rs. 2 lakhs in case of any
accidents, resulting in death or disability of the insured. In case of death or full disability,
you or your family will get Rs. 2 lakhs and in case of partial disability, you will get Rs.1
lakh. Full disability means loss of both eyes, both legs, both hands, whereas partial
disability means loss of one eye or leg or hand.

Age of the Insured - Savings bank account holders aged between 18 years and 70 years
are eligible to apply for this scheme. People aged more than 70 years will not be able to
get the benefits of this scheme.

Premium Amount - It costs you just Rs. 12 in annual premiums for having an accidental
death or disability cover of Rs. 2 lakhs under this scheme. It works out to be just Re.
1/month, which is extraordinarily low. Again, your age has nothing to do with the premium
payable for your insurance cover under this scheme as the premium is fixed at Rs. 12 for
a cover of Rs. 2 lakhs.

Period of Insurance - You will remain insured for a period of one year from June 1, 2015
to May 31, 2016. Next year onwards, the risk cover period will remain to be June 1 to May
31.

Administrators for PMSBY - The scheme would be offered/administered by many
general insurance companies, both in the public sector as well as in the private sector.
Participating banks will be free to engage any such general insurance company for
implementing the scheme for their subscribers. National Insurance Company Limited,
Oriental Insurance Company Limited and ICICI Lombard are some of the companies which
would be offering this scheme.

Auto Debit Facility - You will be required to provide your consent for auto debit of Rs.
12 as the annual premium from any one of your bank accounts at the time of enrolling for
this scheme. This premium of Rs. 12 will get deducted from your savings bank account
through auto debit facility every year between May 25 and June 1.
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Pradhan Mantri Jeevan Jyoti Bima Yojana (PMJJBY)

Pradhan Mantri Jeevan Jyoti Bima Yojana (PMJ]JBY) is a “Life insurance” coverage by
“Government of India”. The following are the features of this life insurance scheme:

Age of the Insured - Bank account holders aged between 18 and 50 years are eligible
to apply in this scheme. So, if you are aged more than 50 years, you are not eligible to
enroll yourself in this scheme. But, once enrolled, you can continue with this scheme till
you attain the age of 55 years.

Premium Amount - Less than Re. 1 a day or an annual premium of Rs. 330 is what you
need to pay to get a life cover of Rs. 2 lakhs. No matter what your age is, the premium is
fixed at Rs. 330 for a life cover of Rs. 2 lakhs. This annual premium of Rs. 330 has been
fixed for the first three years from June 1, 2015 to May 31, 2018, after which it will be
reviewed again based on the insurers’ annual claims experience.

Period of Insurance - June 1%, 2015 to May 31%t, 2016 is the period for which this
scheme will cover all kinds of risks to your life in the first year of operation. Next year
also, the risk cover period will be from June 1 to May 31.

Auto Debit Facility - Annual premium of Rs. 330 will get deducted from your savings
bank account through auto debit facility. You will have to give your consent for auto debit
of premium from any one of your bank accounts at the time of enrolling for this scheme.

Atal Pension Yojana (APY)

The Government of India is concerned about the old age income security of the working
poor and is focused on encouraging and enabling them to save for their retirement. To
address the longevity risks among the workers in the unorganized sector and to encourage
the workers in the unorganized sector to voluntarily save for their retirement, the
Government of India has announced a new scheme called Atal Pension Yojana (APY) in
2015-16 budget. The APY focuses on all citizens in the unorganized sector. The scheme is
administered by the Pension Fund Regulatory and Development Authority (PFRDA) through
NPS architecture.

Eligibility for APY - Atal Pension Yojana (APY) is open to all bank account holders who
are not members of any statutory social security scheme.

Age of joining and contribution period: The minimum age of joining APY is 18 years
and the maximum age is 40 years. One needs to contribute till he/she attains 60 years of
age.

Enrollment agencies - All Points of Presence (Service Providers) and Aggregators under
Swavalamban Scheme would enroll subscribers through the setup of the National Pension
System.

If a person joined Atal Pension Yojna at 35 years, he will contribute till the age of 60 years
i.e. for 25 years. If he wants monthly pension of Rs. 1000 he would contribute Rs. 181 a
month. On his death his wife will receive Rs. 1000 per month and after her death the
nominees will get 1.7 lakh. If he wants monthly pension of Rs.3000 he would contribute
Rs. 543 a month. On his death, his wife would get Rs. 3000 per month and after a death
the nominees will get 5.1 lakh.
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Pradhan Mantri Mudra Yojana (PMMY)

Prime Minister Narendra Modi launched Micro Units Development and Refinance Agency
Ltd (MUDRA) Bank on 8 April, 2015 with a corpus of Rs. 20,000 crore and a credit
guarantee corpus of Rs. 3,000 crore. The launch was the fulfilment of an announcement
made earlier by the Finance Minister Mr. Arun Jaitley in his FY 15-16 Budget speech.

Objectives of PMMY

e Regulate the lender and the borrower of microfinance and bring stability to the
microfinance system through regulation and inclusive participation.

e Extend finance and credit support to Microfinance Institutions (MFI) and agencies that
lend money to small businesses, retailers, self-help groups and individuals.

e Register all MFIs and introduce a system of performance rating and accreditation for
the first time. This will help last-mile borrowers of finance to evaluate and approach
the MFI that meets their requirements better and whose past record is most
satisfactory. This will also introduce an element of competitiveness among the MFIs.
The ultimate beneficiary will be the borrower.

e Provide structured guidelines for the borrowers to follow to avoid failure of business or
take corrective steps in time. MUDRA will help in laying down guidelines or acceptable
procedures to be followed by the lenders to recover money in cases of default.

e Develop standardized covenants that will form backbone of the last-mile business in
future.

e Offer a Credit Guarantee scheme to provide guarantee to the loans which are being
offered to micro businesses.

e Introduce appropriate technologies to assist in the process of efficient lending,
borrowing and monitoring of distributed capital.

e Build a suitable framework under the Pradhan Mantri MUDRA Yojana for developing an

efficient last-mile credit delivery system to small and micro businesses.

National Pension Scheme

National Pension Scheme is a voluntary defined contribution pension system. NPS is
administered and regulated by the Pension Fund Regulatory and Development Authority
(PFRDA). NPS is the most economical pension scheme for Indian citizens between 18-60
age group. The more the invested money, the more the accumulated pension. A citizen of
India, whether resident or non-resident can avail NPS facility. The NPS is applicable to
central government employees, state government employees, corporate, individual,
unorganized sector workers - Swavalamban Yojana. NPS helps to protect your future and
get tax benefits.

Components of National Pension System
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Point of Presence (POP): The authorized branches of a POP, called Point of Presence
Service Providers (POP-SPs) act as collection points and extend a number of customer
services to NPS subscribers.

Central Recordkeeping Agency (CRA): This provides recordkeeping, administration
and customer service functions for all subscribers of the NPS.

Pension Funds (PFs)/Pension Fund Managers (PFMs): The six Pension Funds (PFs)
appointed by PFRDA would manage your retirement savings under the NPS.

Trustee Bank: The Trustee Bank appointed under NPS shall facilitate fund transfers
across various entities of the NPS system.

Annuity Service Providers (ASPs): ASPs would be responsible for delivering a regular
monthly pension after you exit from the NPS.

NPS Trust: A Trust, appointed under the Indian Trusts Act, 1882 is responsible for taking
care of the funds under NPS in the best interests of subscribers.

Pension Fund Regulatory and Development Authority (PFRDA): An autonomous
body set up by the Government of India to develop and regulate the pension market in
India.

Public Provident Fund (PPF) Scheme

Public Provident Fund (PPF) is a 15-year investment scheme launched by government of
India to enjoy a tax exempted investment. It was introduced by the National Savings
Institute of the Ministry of Finance in 1968. A minimum yearly deposit of Rs. 500 is
required to open and maintain a PPF account. It provides 7.9% interest. Loan facility is
available in PPF account.

Bank on your mobile

Mobile plays a major role in day-to-day activities. We can access services provided by
bank through mobile.

Mobile Banking

Mobile banking is a facility provided by all banks to make customers’ work easy. Using
mobile app, we can do the following activities.

e Transfer funds from your account to another account.
e Verify your bank account particulars.

¢ Make payment of utility and credit card bills.

e Open and renewal of fixed deposit account.

e Recharge prepaid mobile/DTH.

Mobile Wallets

Mobile wallet is a virtual wallet, which stores your credit or debit card information. Instead
of physically carrying card, we can use mobile device. Mobile wallet also helps to store
driver’s license, social security number, health information cards, loyalty cards, hotel key
cards and bus or train tickets.

310

tutorialspoint

EIMPLYEAEBYLEARMING

&



Computer Concepts

Summary

From this topic, we gained a detailed knowledge on the importance of savings; importance
of bank, banking products like accounts, deposits, loans; procedure to open an account,
banking services, ATM, internet banking, mobile banking, mobile wallet, insurance, and
various schemes introduced by the Prime Minister of India.
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